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Foreword
Thank you for purchasing the DAQLOGGER or the DAQLOGGER Client Package.
This User’s Manual contains useful information about the operation of the DAQLOGGER
and the DAQLOGGER Client Package.  To ensure correct use, please read this manual
thoroughly before operation, and keep it in a safe place for quick reference in the event a
question arises.

Notes
• The contents of this manual are subject to change without prior notice as a result of

continuing improvements to the software’s performance and functions.
• The DAQLOGGER information covered in this manual describes DAQLOGGER

Revision 6.01.
• Every effort has been made in the preparation of this manual to ensure the accuracy

of its contents.  However, should you have any questions or find any errors, please
contact your nearest YOKOGAWA dealer as listed on the back cover of this manual.

• Copying or reproducing all or any part of the contents of this manual without
YOKOGAWA’s permission is strictly prohibited.

• Use of this product (software and this manual) by more than one computers at the
same time is prohibited.  Use by more than one user is also prohibited.

• Transfer or lending of this product to any third party is prohibited.
• Yokogawa Electric Corporation provides no guarantees other than for physical

deficiencies found on the original floppy disk or this manual upon opening the product
package.

• Yokogawa Electric Corporation shall not be held responsible by any party for any
losses or damage, direct or indirect, caused by the use or any unpredictable defect of
the product.

• The serial number will not be reissued.

Trademarks
• Microsoft, Windows, and Windows NT are either registered trademarks or trademarks

of Microsoft Corporation in the United States and/or other countries.
• Lotus 1-2-3 is a registered trademark of Lotus-Development Corporation.
• Adobe and Adobe Acrobat are either trademarks or registered trademarks of Adobe

Systems incorporated.
• Other company and product names are trademarks or registered trademarks of their

respective holders.

Revisions
1st Edition: August 2000
2nd Edition: March 2001
3rd Edition: June 2002
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Checking the Contents of the Package

When you open the package, check the following before use.  If the product you received
is not the one you ordered, any items are missing, or if it appears to be damaged, please
contact the dealer from which you purchased the product.

Model
DAQLOGGER

Model Suffix code Description

VA510 DAQLOGGER

-01 400-channel model
-02 1000-channel model
-03 1600-channel model

-2 English version

DAQLOGGER Client Package

Model Suffix code Description

VA520 DAQLOGGER Client Package

-01 1600 channels

-2 English version

Package Contents
User's manual (this manual): 1 CD-ROM: 1piece

(with a storage case)
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Handling Precautions of the CD-ROM

Make sure to comply with the following precautions.

                                                            WARNING
• Do not use or store the CD-ROM in a place filled with dirt or dust.
• Do not touch the side without any printings.

Stain, sweat, etc. from the fingertips sticking to the surface can cause
malfunction.  In addition, do not write on this side of the CD-ROM.

• Lead from pencils and residue from erasures sticking to the surface can
also cause malfunction.

• Do not bend or scratch the CD-ROM.
Such acts will make the CD-ROM unreadable.

• Do not place objects on the CD-ROM.
Placing heavy objects can deform the CD-ROM and make it unusable.

• Do not drop from high places.
Dropping the CD-ROM can make it unusable due to breakage or deformation.

• Keep away from direct sunlight and any heating equipment.
• Do not use solvents

Never use solvents such as alcohol, thinner, and Freon.
• Insert the CD-ROM into the CD-ROM drive with care.
• Do not eject the CD-ROM, turn OFF or reset the PC while the CD-ROM is

being accessed.
• Store the CD-ROM in the storage case.

Do not leave the CD-ROM in the CD-ROM drive after use.  Leaving the CD-
ROM out of the storage case can cause deformation and dust to stick to the
surface.
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How to Use This Manual

Structure of the Manual
This User’s Manual consists of the following nine chapters and an index.

Chapter Title Description

1 Before Operation Gives an overview of the DAQLOGGER and the
DAQLOGGER Client Package.  Also describes the
PC requirements needed to run the application, the
installation procedures, and other information.

2 Configuring the System Describes the system environment that is required to
run DAQLOGGER and how to setup the system such
as tags.

3 Monitoring the Data Describes how to display the data being scanned and
how to change the display settings.

4 Displaying the Waveform Describes how to display the waveform or numerical
on the Viewer values of the recorded data and how to change the

display settings.  Also describes how to display the
statistics that are computed over a specified area and
how to convert the data format.

5 File Utility Describes how to merge or divide the file containing
scanned and recorded data.  Also describes how to
convert the scanned and recorded data or report data
to Excel, ASCII, or Lotus format.

6 Event Processor Describes how to transfer the target file to an FTP
server, transmit the file through e-mail messages, or
convert the files when the specified conditions of
alarm, time, and system status are met.

7 Configuring the Recorder Describes how to configure the recorder.

8 Using the DAQLOGGER Describes the operating procedure of the
Client Package DAQLOGGER Client Package.

9 Error Messages and Describes the error messages and their corrective
Corrective Actions actions.

Index Gives a list of important terms used in this manual.

Scope of the Manual
This manual does not explain the basic operations of Windows 98, Windows 2000,
Windows XP, and Windows NT 4.0.  For information regarding the basic operations of
Windows, see the user’s guide that came with Windows.
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Conventions Used in This Manual

Unit
K Denotes 1024. Example: 100 KB
M Denotes 1024K. Example: 10 MB

Display characters
Display characters of menus, commands, dialog boxes, and buttons are enclosed in
double quotation marks.

Symbols used in operational explanation
In the pages explaining operation (chapter 1 to 8), the following symbols are used to
distinguish the descriptions.

 Procedure : Follow the steps indicated with numbers.  The procedure are

given with the premise that the user is carrying out steps for the

first time.  Not all the steps are necessary depending on the

situation.

Note : Provides information useful for operation.
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Chapter 1 Before Operation

1.1 Overview of the DAQLOGGER/DAQLOGGER
Client Package

DAQLOGGER
DAQLOGGER is a software application used to scan and record measured/computed
data from multiple recorders connected to a PC.  There are three models.  They differ in
the maximum number of channels that can be managed: 1600 channels, 1000 channels,
and 400 channels.

Devices That Can Be Accessed
You can access other PCs running DAQ32Plus, DAQEXPLORER, or DAQLOGGER via
Ethernet.  The software can process measured data acquired on these PCs as if they
were recorders.  The following software versions support this communication function.

DAQ32Plus R9.01 or later
DAQEXPLORER R1.01 or later
DAQLOGGER R3.01 or later

VIEW  RECORDER  VR200

DAQLOGGER DAQLOGGER client

RS-232/RS-422A converter

Any combination of 32 of the _R, VR, DX, CX, 
MV, DARWIN, DAQEXPLORER, DAQ32Plus, 
and DAQLOGGER recorders/PC-based 
recording applications.  

RS-232

RS-232

RS-422A

Ethernet 

Data
transmission

Data acquisition

Data acquisition
Data acquisition

DAQLOGGER DAQ32Plus

VIEW  RECORDER  VR200

DAQEXPLORER1 PC.

The main functions of DAQLOGGER are as follows:
• Connects up to 32 units of µR recorders (µR1000/µR1800), VR recorders (VR100/

VR200), DAQSTATION (DX100/DX200/DX200C/CX1000/CX2000), MobileCorder
(MV100/MV200) and DARWIN (DA100/DC100/DR130/DR200) to one PC (different
models can coexist).

• Scans and records up to the maximum number of channels (1600, 1000, or 400) of
measured/computed data at a minimum interval of 1 second (the interval may be
longer depending on the number of connected units and the number of channels).

• Monitors and displays the measured/computed data being scanned in five forms:
trend, numerical, meter, alarm, and color graph.

• Displays the measured/computed data that have been stored, searches for data,
alarms, and marks, computes statistics over an area that is specified by the cursors,
converts the data format to “ASCII,” “Lotus,” and “Excel” formats, extracts a section of
a file to be stored to another file, and prints various data and information.
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• Manages data using tag name (up to 16 characters) that was assigned to each
channel on the PC.

• Manages tags by separating them into a maximum of 50 groups (up to 32 tags/group).
• Saves DAQLOGGER settings (this is called a “project”) according to the user or the

purpose.  Allows switching between projects.
• Protection from erroneous operation provided through operation levels of users and

password protection.
• Generates various reports such as hourly, daily, weekly and monthly reports on a PC.
• Configures the recorder from the PC.
• Incorporates a DDE server function.
• Transfers the scanned and recorded data to another PC via the network (the PC

receiving the data requires the DAQLOGGER Client Package).
• With the e-mail function, the fact that an alarm occurred can be notified through e-mail.
• With the FTP function, files can be transferred to an FTP server when data files or

report files are created.

Software Construction of DAQLOGGER
DAQLOGGER consists of the following 14 software applications.
• Software Manager

This program is started first and manages the startup of other DAQLOGGER software
applications.
It also manages multiple projects.
• A project refers to the set of DAQLOGGER settings that corresponds to each user

or purpose.  It contains the settings of all software applications that are described
below.  Using Software Manager, you can create multiple projects and store them.
By switching projects, you can easily switch between different sets of settings that
have been stored previously.

• You can limit the range of operation by assigning one of three levels, “Supervisor,”
“Operator,” or “User,” to a project.

• You can assign a password for each project and limit the operation (password
protection).

• You can hide the taskbar and icons of Windows so that other programs cannot be
started (desktop protection).

Software Manager is in charge of the user interface provided on the Logging Software
that carries out data scanning and recording and the Report Software that creates
reports.  For details, see the description of the respective software application.
For the operation procedure of Software Manager, see sections 2.3, 2.4, and 2.5.

• Logging Software
The Logging Software collects the measured/computed data from the recorder at
specified intervals.  This action is called “scan.”  It also stores the scanned data to the
hard disk at specified intervals.  This action is called “record.”
The Logging Software never appears on the screen.  The following operations are
carried out through Software Manager:
• Start/Stop scanning.
• Start/Stop recording.
• Set scanning conditions (scan interval, start timing, and operations of the

computation channels at the start of the scanning operation) and recording
conditions (record interval, data storage directory, file name, and division of stored
files).

1.1  Overview of the DAQLOGGER/DAQLOGGER Client Package
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1• Set the function that automatically reconnects the recorder.
Display the information (scan interval, record interval, start time of recording,
estimated stop time of recording, file name of recording, and number of recorded data
points) on the data being scanned and recorded.
For the operation procedure of the Logging Software, see section 2.9.

• Data Monitor
Data Monitor is started from Software Manager.
This application can display the data that have been scanned by the Logging
Software and the alarm conditions on the following five types of monitor screens.
Each monitor displays tags that have been assigned to the recorder’s channels using
Tag Editor by groups that have been assigned using Group Editor.
In addition, the display setting dialog box of Data Monitor can be used to change the
tag assignments, ON/OFF setting for each tag, specify the meters to be used on the
meter monitor, set the tag display color, and set other display conditions.
The display is updated at the scan interval.
• Trend monitor

Displays the waveform of the scanned data for each group.  You can change the
display conditions such as zooming in or out of the time axis and specifying the Y-
axis zone to be displayed.

• Numeric monitor
Displays the numerical values of the scanned data for each group.

• Meter monitor
Displays the meters of the scanned data for each group.  You can select the type
of meter from bar meter, analog meter, and thermometer.

• Alarm monitor
Lists the representative alarm status for each group on a single screen (alarm
overview display).  If an alarm is occurring on any one of the tags in a group, the
representative alarm status is shown as “Alarm ON.”
It also displays a log of alarm occurrences/releases for each tag including the
alarm type, date and time of occurrence/release, and tag name (alarm log display).

• Color graph monitor
Displays the scanned data on a color graph for each group.  The scanned data are
colored in the following order: blue (minimum value), light blue, green, yellow, and
red (maximum value).

For the operation procedure of Data Monitor, see chapter 3.

• Historical Viewer
Viewer is started from Software Manager or the Windows Start menu.
Viewer is used to manage the data that have been recorded and stored by the
Logging Software to the hard disk or a storage medium.  For data that are currently
being recorded, Viewer can manage the section that have been stored to the hard
disk.
• Displays the waveforms and numerical values of data of up to 32 tags per group for

up to 50 groups.
• You can change the original data-to-tag assignments, turn ON/OFF the tags, and

change other display conditions.  You can also save the modified display
conditions.

• Calculates the maximum, minimum, P-P, average, and rms values over the area
that is specified by the cursor.

• You can set conditions and search for the measured/computed data, alarms, and
marks.

• You can extract a section of the file to be stored to another file.

1.1  Overview of the DAQLOGGER/DAQLOGGER Client Package
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• Reads and displays report files.
• Converts the data format to “ASCII,” “Lotus,” or “Excel” formats.
• Prints the displayed data (a printer is required).
For the operation procedure of Historical Viewer, see chapter 4.

• Software Configurator
Software Configurator is started from Software Manager.
Software Configurator is used to assign recorder numbers of DAQLOGGER to the
recorders that are connected.  It is also used to set the configurations of the recorders
and communication parameters.  DAQLOGGER scans and records the data based on
the information specified here.
The settings are as follows:
• Type of communication (RS-232, RS-422A, and Ethernet).
• Port, address, baud rate, parity, and stop bit if RS-422A is used.
• Port, baud rate, parity, and stop bit if RS-232 is used.
• Address, login, and password if Ethernet is used.
• Type of recorder that is connected, number of measurement channels, and number

of computation channels.
• Standalone model/expandable model, style number, options, and subunit/module

configuration if DARWIN is used.
Software Configurator includes a function that automatically determines and registers
the model of the recorder that is connected to the specified communication port
(Parameters can be set one by one as some models are not determined
automatically).
For the operation procedure of Software Configurator, see section 2.6.

• Tag Editor
Tag Editor is started from Software Manager.
Tag Editor is used to assign the tags used by DAQLOGGER to the recorder’s
channels.  A single channel can have multiple tags.
In addition, you can set names (character string) to the tags.  The name is called a
“tag name.”  Tag names can be read from the recorder via communications.
You can search tags by specifying the tag name, tag number, or recorder number.
For the operation procedure of Tag Editor, see section 2.7.

• Group Editor
Group Editor is started from Software Manager.
The tags that were set by Tag Editor can be assigned to groups, and the groups can
be assigned names.  Up to 32 tags can be assigned to a single group.
Up to 50 groups can be assigned.
Data Monitor displays the data by groups that are specified here.
For the operation procedure of Group Editor, see section 2.8.

• Hardware Configurator
Hardware Configurator is started from Software Manager.
Edits the settings in the SET mode (Setting Mode) and SETUP mode (Basic Setting
Mode) of the recorder that is connected to the PC.
When Hardware Configurator is started for the first time, the initial setup screen for
the SET mode or SETUP mode is displayed based on the model, number of
measurement/computation channels, presence or absence of options (for DARWIN),
and module configuration (for DARWIN) that are specified by Software Configurator.

1.1  Overview of the DAQLOGGER/DAQLOGGER Client Package
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1• The original SET mode and SETUP mode information can be
• Loaded from the recorder via communications (receive via communications).
• Loaded from a file that is stored on a storage medium such as a floppy disk (this

is called “file importing”).
• Created from scratch.

• The settings after they are edited can be
• Written to the recorder via communications (transmit via communications).
• Stored on a storage medium and written to the recorder from the storage

medium (this is called “file exporting”).
However, the following restrictions exist depending on the recorder:
• For µR recorders, the SET Mode settings can be transmitted or received via

communications.
Settings in the SETUP Mode cannot be modified.  Set them directly on the µR
recorder.  In addition, since no storage media drives are provided, setting using
the storage medium is not possible.

• For VR recorders, the SET Mode settings can be transmitted or received via
communications or imported or exported through files.  The settings in the
SETUP Mode can be modified through file importing and exporting.
Communications cannot be used.

• For DX/CX DAQSTATION and MV MoblieCorder, the setting mode and basic
setting mode settings can be transmitted or received via communications or
imported or exported through files.  However, network settings (such as the IP
address) cannot be changed via communications.  Set them directly on the DX
or use file exporting.

• For DARWIN, the SET Mode and SETUP Mode settings can be transmitted or
received via communications or imported or exported through files.

• In addition, Hardware Configurator can be used to create settings by changing the
system configuration such as the presence or absence of options or by changing
the subunit/module configuration (for DARWIN).  Use this function in situations
such as when preparing the configuration change of the connected recorder
beforehand.

• The following control commands can be transmitted to the recorders.
• Set the date and time of the recorder to the date and time of the PC (µR, VR,

DX, MV, CX, DA, DR, and DC).
• Start/Stop the recording (µR, DX, MV, CX, DR, and DC).
• Start/Stop computation (µR, VR, DX, MV, CX, DA, DR, and DC).
• Initialize the data memory (VR, DX, MV, CX, DC).
• Show the specified display (µR, VR, DX, MV, CX, DR, and DC).
• Execute reconfiguration (DA, DR200 (Expandable), and DC).

For the operation procedure of Hardware Configurator, see chapter 7.

• Report Generator
Determines the instantaneous value, maximum, minimum, average, sum, and total
from the data that are scanned or recorded over an hour, a day, a week, or a month
and output them to a file or print them at a specified time.  Report Generator never
appears on the screen.  The start and stop operation and settings of the report are
done on Software Manager.
The following items can be specified.
• Type of report (hourly, daily, weekly, or monthly), the tags to be reported, and the

type of data to be created.
• Data to be used to make the report (scan data or record data).
• Output destination of the report (file or print) and the output file format (binary or

text).

1.1  Overview of the DAQLOGGER/DAQLOGGER Client Package
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• The date or day and time of report generation.
In addition, report files (binary) can be displayed on Viewer.
For the operation procedure of Report Generator, see section 2.10.

• DDE* Server
The DDE Server is started from Software Manager.
The server provides DDE services.  Data and time that are scanned by the Logger
can be displayed on a Windows application that supports DDE such as EXCEL.  Up to
1600 tags can be transmitted via DDE communications.
For the operation procedure of the DDE Server, see section 2.11.

* Dynamic Data Exchange

     A technique or procedure used to exchange commands and data between Windows

applications via communications.  The database providing the data is called a server.  The

application that uses the data is called a client.

• Monitor Server
The Monitor Server is started from Software Manager.
Transfers the scanned data to a PC (Remote Monitor*) that is connected via the
Ethernet network.  Up to 16 remote monitors can be connected.
Remote Monitor can be used to display and monitor the received data.
For the operation procedure of the Monitor Server, see section 2.12.

* Remote monitor

The DAQLOGGER Client Package is required on Remote Monitor side.  For an overview of

the functions of the DAQLOGGER Client Package, see the next section, “DAQLOGGER

Client Package.”

• File Utility
The File Utility performs four functions, Merge, Divide, Convert, and Restructure, on
the data file or report file that the DAQLOGGER creates.
Merge: Merges the files that are continuous in time to a single file.
Divide: Divides or cuts the data files according to various conditions.
Convert: Converts data files or report files to Excel, ASCII, or Lotus format and

outputs them.
Restruct.: Performs data file merging and dividing at once.
For the operating procedure of the File Utility, see chapter 5.

• Event Processor
The Event Processor is a software program that can process up to 8 events
simultaneously.  The settings of a single event consists of event condition, target file,
and process parameters.  In event process, the file specified by target file is
processed using the command specified by process when the conditions specified by
event conditions are met.  For the operating procedure of the Event Processor, see
chapter 6.

• Control Server
The Control Server is started from the Manager software.  Using a PC connected via
Ethernet (remote controller*), you can start a scan, start/stop recording, and start/stop
the event processor.  For the operating procedure of the Control Server, see section
2.13.
* Remote Controller

The DAQLOGGER client package is required for the remote controller.  For an overview of
the package’s functions, see “DAQLOGGER Client Package” below.

1.1  Overview of the DAQLOGGER/DAQLOGGER Client Package
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1Note the following when performing communications with a PC on which DAQ32Plus,
DAQEXPLORER, or DAQLOGGER is installed.
• Only Ethernet may be used for communications.
• When connecting to the DAQ32Plus, DAQEXPLORER, or DAQLOGGER, the

hardware configurator cannot be used to enter settings (see chapter 7).
• The data’s measurement time is determined by the PC controlled by the master

DAQLOGGER.  This time may differ from any slave DAQ32Plus, DAQEXPLORER, or
DAQLOGGER that are connected.

• You must use the software configurator to change the port number or enter a system
number (DAQEXPLORER only) for making a connection to a specific system (see
section 2.6).

DAQLOGGER Client Package
The DAQLOGGER Client Package is used to receive data from a PC (Monitor Server)
that is connected via the network and display the measured/computed data on the
monitor screen.
The main functions are as follows:
• Connects up to 16 Monitor Servers.
• Receives data consisting of up to 1600 tags from a single server at a minimum

interval of 1 s and updates the display (the interval may be longer depending on the
number of connected servers and the number of tags).

• Displays the data from the server on one of six types of monitors: trend, digital, meter,
alarm, color graph, and circular.

• Displays tags by dividing them into groups (up to 50 groups, up to 32 tags per group).
• Loads and displays the file containing data that have been recorded by the Logging

Software of DAQLOGGER and carries out various operations such as computation
over an area specified by the cursors, data conversion, display of file information, and
printing (same as Viewer of DAQLOGGER).

Software Construction of DAQLOGGER Client Package
• Remote Monitor

Remote Monitor is started from Windows Start menu.
Sets the conditions for connecting to the server (host name, port number, frequency
of data retrieval) and connects/disconnects from the server.  The conditions for
connection can be stored.
Displays the data from the monitor server on the following six types of monitors.  On
each monitor, you can change the display-related settings such as change the tag
assignment or turn ON/OFF the tag display.  The display conditions can also be
stored.
The data display is updated according to the interval (frequency of data retrieval) that
is specified by the conditions for connection.
• Trend monitor

Displays the waveform of the retrieved data for each group.  You can change the
display conditions such as zooming in or out of the time axis and specifying the Y-
axis zone to be displayed.

• Numeric monitor
Displays the numerical values of the retrieved data for each group.

• Meter monitor
Displays the meters of the retrieved data for each group.  You can select the type
of meter from bar meter, analog meter, and thermometer.

1.1  Overview of the DAQLOGGER/DAQLOGGER Client Package
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• Alarm monitor
Lists the representative alarm status for each group on a single screen (alarm
overview display).  If an alarm is occurring on any one of the tags in a group, the
representative alarm status is shown as “Alarm ON.”
It also displays a log of alarm occurrences/releases for each tag including the
alarm type, date and time of occurrence/release, and tag name (alarm log display).

• Color graph monitor
Displays the retrieved data on a color graph for each group.  The data are colored
in the following order: blue (minimum value), light blue, green, yellow, and red
(maximum value).

• Circular monitor
Displays the retrieved data on a circular graph for each group.
For the operation procedure of Remote Monitor, see sections 8.1 and 8.2.

• Historical Viewer
Viewer is started from Windows Start menu.
Viewer is used to manage the data that have been recorded and stored by the
Logging Software to the hard disk or a storage medium.  The functions are the same
as those for DAQLOGGER Historical Viewer.  See the description on DAQLOGGER
Historical Viewer.  However, data that DAQLOGGER is recording cannot be
accessed.
For the operation procedure of Historical Viewer, see section 8.3.

• File Utility
The File Utility is started from Windows Start menu.
It performs four functions, Link, Divide, Convert, and Restructure, on the data file or
report file that the DAQLOGGER creates.  The functions are the same as those for
DAQLOGGER File Utility.
See the description on DAQLOGGER File Utility.
For details on the File Utility, see chapter 5.

• Remote Controller
The remote controller can be run from the Windows start menu.  Enter settings for
connection with the control server (host name, port number used, login/password) to
be used when opening/closing the connection.  The following operations can be
performed while connected.
• Start scan, start/stop recording
• Start/stop the event processor, generate user events

1.1  Overview of the DAQLOGGER/DAQLOGGER Client Package
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11.2 PC System Requirements and Recorders That
Can Be Connected

PC System (for DAQLOGGER)
OS
• Windows NT 4.0 Service Pack 3 or later (recommended)
• Windows 2000
• Windows XP
• Windows 98

PC
PC that can run the OS above with the following CPU and memory.
• For a 400-channel model

MMX Pentium 166 MHz or faster (Pentium II 300 MHz or faster is recommended)
64 MB memory or more (128 MB or more recommended)

• For a 1000-channel model
Pentium II 300 MHz or faster (Pentium III 400 MHz or faster)
128 MB memory or more (256 MB or more recommended)

• For a 1600-channel model
Pentium III 400 MHz or faster (Pentium III 600 MHz or faster recommended)
128 MB memory or more (256 MB or more recommended)

Hard Disk
Free disk space of at least 30 MB (More free space may be required depending on the
amount of data to be scanned and recorded)

CD-ROM drive (used during installation)

Mouse
Mouse supported by the OS

Display
Display supported by the OS with 800-by-600 resolution and 32768 colors or better.
(1024-by-768 resolution and 65536 colors recommended.)

Communication port
• COM port supported by the OS (selected from COM1 to COM9).
• An Ethernet port supported by the OS (when connecting DAQSTATION, MV, or

DARWIN via the Ethernet network or when using the monitor server)

Printer (used when printing)
Printer and printer driver supported by the OS

Communication converter (necessary for RS-422A communication)
RS-232/RS-422A converter

Recorder
• µR recorder

µR1000 or µR1800 with communication option (RS-422-A/485, /C3).
µR12000 cannot be used.
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• VR View Recorder
VR100 (VR104P, VR104D, VR106P, and VR106D) or VR200 (VR202, VR204,
VR206, VR202 S2, VR204 S2, and VR206 S2) with communication option (RS-422-A/
485, /C3).

• DX DAQSTATION
DX100 (DX102, DX104, DX108, and DX112), DX200 (DX204, DX208, DX210,
DX220, and DX230), or DX200C.
When using serial communications, communication option (RS-232, /C2 or RS-422-A/
485, /C3).

• MV MobileCorder
MV100 (MV102, MV104, MV108, MV112), MV200 (MV204, MV208, MV210, MV220,
MV230).
When using serial communications, commucation option (RS-232, /C2 or RS-422-A/
485, /C3).

• CX DAQSTATION
CX1000 (CX1006, CX1206), CX2000 (CX2010, CX2020, CX2210, CX2220, CX2410,
CX2420, CX2610, CX2620).
When using serial communications, commucation option (RS-232, -1, RS-422-A/485,
-2).

• DARWIN
DA100, DR130, DR200 (DR231, DR241, DR232, and DR242), or DC100 with a
communication module (Ethernet, RS-232, or RS-422A/485).

Note
• It is more likely that data dropouts will occur when using Windows 95/98 as compared to

Windows NT 4.0.  If data dropouts occur, set a longer scan interval.

• In some cases, Window 95/98 temporarily hangs up, if it continues to run over 49.7 days.  If

you wish to continuously run DAQLOGGER for over 49.7 days, get the patch program from

Microsoft Corporation that solves this problem or use Windows NT 4.0.

• When using Windows 95/98, set the time zone using the “Date/Time” in the Windows “Control

Panel.”  If daylight savings exist in the specified time zone, check “Automatically adjust clock

for daylight savings changes.”  Do not specify time zone settings in the Windows

autoexec.bat file.  If you see lines such as “TZ=GTM0” in the autoexec.bat file, deactivate

then by inserting a REM command in front.

• Data created in 2035 or later cannot be handled.

• DAQLOGGER creates a time stamp based on the clock of the PC in which DAQLOGGER is

installed.  Because of this, you should not change the PC’s clock settings or related settings

while DAQLOGGER is running.  Also, Windows NT, Windows 2000, and Windows XP

operate by default under the Windows Time service in which the time is automatically set on

the PC per a time server, so you must shut down this service.  For details, see the Windows

user's manual.

1.2  PC System Requirements and Recorders That Can Be Connected
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1PC System (for DAQLOGGER Client Package)
OS: Same as for DAQLOGGER.
PC:
Pentium III 400 MHz or faster (Pentium III 600 MHz or faster recommended)
128 MB memory or more (256 MB or more recommended)
Hard Disk: Free space of at least 30 MB.
CD-ROM drive (used during installation)
Mouse: Same as for DAQLOGGER.
Display: Same as for DAQLOGGER.
Communication port: Ethernet port supported by the OS.
Printer (used when printing): Same as for DAQLOGGER.

Note
• In some cases, Window 98 temporarily hangs up, if it continues to run over 49.7 days.  If you

wish to continuously run DAQLOGGER Client Package for over 49.7 days, get the patch

program from Microsoft Corporation that solves this problem or use Windows NT 4.0/2000/

XP.

• Data created in 2035 or later cannot be handled.

1.2  PC System Requirements and Recorders That Can Be Connected
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1.3 Installing the DAQLOGGER/DAQLOGGER
Client Package

A serial number is required for installing the DAQLOGGER/DAQLOGGER Client
Package.  Check the serial number that is indicated on the CD-ROM case beforehand.

Procedure
1. Turn ON the PC and start Windows.

2. Insert the CD-ROM into the CD-ROM drive.

3. After a few moments, the “DAQLOGGER Install CD” window appears.  Proceed to
step 4.

If the “DAQLOGGER Install CD” window does not appear, carry out the following
procedure.

Click “My Computer” and double-click the CD-ROM icon (Daqlogger).  When the
“DAQLOGGER Install CD” window appears, proceed to step 4.

If the “DAQLOGGER Install CD” window does not appear, and the Daqlogger folder
opens instead, double-click “Install.exe” in the folder.  The “DAQLOGGER Install CD”
window will appear.  Proceed to step 4.

4. Click the button corresponding to the software program you wish to install.  Then,
follow the instructions that appear on the screen.

Note
• DAQLOGGER/DAQLOGGER Client Package should be run on a dedicated machine.

If other applications run in the background when DAQLOGGER is in operation, data scanning

and recording may not be carried out properly.  For this reason, stop all memory-resident

programs such as virus protection programs while DAQLOGGER is running.  Also, do not

start other applications along with DAQLOGGER.

• Terminate memory resident programs such as virus protection programs before installation.

• When the installation is complete, Software Manager and Viewer are registered in the Start

menu.

• When reinstalling the software, uninstall the software first.  To uninstall the program, use

“Add/Remove Programs” in Windows Control Panel.
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Chapter 2 Configuring the DAQLOGGER

2.1 The Workflow of the Configuration

The workflow of the configuration is shown below.

Section 2.2

Section 2.3

Section 2.4

Section 2.5

Section 2.6

Section 2.7

Section 2.8

Chapter 5

Section 2.9

Section 2.10

Section 2.11

Section 2.12

Prepare the recorder

Start DAQLOGGER

Set a project

Set the security

Set communications 
and the connected 

recorder models

Set tags

Set groups

Set the recorder

Configure the Logger

Configure the report 
function

Set up the 
DDE Server

Set up the 
Monitor Server

Section 2.13Set up the 
Control Server

• Create a new project
• Select an existing project
• Delete an existing project

• Set operation level to a project
• Set password protection
• Set desktop protection

• Set communications
• Set connected recorder models
• Save the settings
• Revert to the last saved settings
• Initialize the serial port
• Print the settings
• Terminate the Software Configurator

• Assign tags to groups
• Show/hide tags
• Change the group name
• Save the group information
• Terminate the Group Editor

• Set tag information
• Reading tag names from the 
  recorder
• Search tags
• Moving the display by the specified 
  number of tags
• Print tag information
• Save tag information
• Terminate the tag editor

• Upload setting parameters
• Set VR series
• Set mR series
• Set DX series
• Set CX series
• Set DARWIN
• Print setting parameters
• Save setting parameters
• Write setting parameters to the recorder
• Send control commands to the recorder
• Handling of setting data using a floppy disk

• Configure the Logger
• Start the scanning
• Start the recording
• Start/stop computation on recorders
• Display the  information of the scanned 
  and recoded data
• Stop scanning/recording operation

• Set the contents of 
  hourly/daily/weekly/monthly reports
• Set the printer
• Save the report configuration
• Re-display the current settings
• Terminate the report configuration
• Start/stop the report function

• Start the DDE Server
• Set up the DDE Server
• Pause/terminate the DDE server
• Prepare the DDE client

• Start the Monitor Server
• Set up the Monitor Server
• Pause/terminate the Monitor Server
• Prepare the Remote Monitor

Recorders can be set using 
the “Hardware Configurator.”
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2.2 Preparing the Recorder

Before starting DAQLOGGER, set recorder’s communication parameters then connect
the recorder to the PC.

For µR1000/µR1800/VR100/VR200
Settings for RS-422A communication
Provide the following settings.
• Baud rate: 9600 bps
• Data length: 8 bits
• Parity: None
• Stop bit: 1 bit
• Address: Set a unique address to each recorder.
See the Communication Function Manual of the recorder (IM 4D5B1-10E, IM 4H3B1-
10E, or IM 4N1A1-11E).

For DX100/DX200/DX200C/MV100/MV200/CX1000/CX2000/DARWIN
Settings for Ethernet communication
For a model capable of Ethernet communication, set the following items.
• IP address
• Subnet mask
• Default gateway

Settings for RS-232 communication
For a model capable of RS-232 communication, provide the following settings.
• Baud rate: 38400 bps
• Data length: 8 bits
• Parity: None
• Handshake: CR:RS
• Protocol: Normal (for DX/MV)
• Stop bit: 1 bit (fixed to 1 bit on DX/MV)

Settings for RS-422A/485 communication
For a model capable of RS-422A/485 communication, provide the following settings.
• Baud rate: 38400 bps

(9600 bps when connecting µR and VR recorders on a single multidrop line.)
• Data length: 8 bits
• Parity: None
• Address: Set a unique address to each recorder.
• Protocol: Normal (for DX/MV)
• Stop bit: 1 bit (fixed to 1 bit on DX/MV)
For more details about communication settings, see the Communication Function
Manual for the recorder (IM 04L02A01-17E, IM MV100-17E, IM DA100-11E, IM DR231-
11E, IM DC100-11E, IM 04L31A01-17E).
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2.3 Starting DAQLOGGER

Starting DAQLOGGER
Procedure

1. From the Start menu, select “Programs” - “DAQLOGGER” - ” Manager.”  Software
Manager starts and the “DAQLOGGER Manager” window appears.  In the window,
there are 13 buttons used to start the individual applications (functions).

Start scanning

Start Viewer

Start Tag Editor

Start Group Editor

Stop scanning/recording
Start the Data Monitor

Start recording

Start the DDE Server
Start Monitor Server

Status indicationIcons that indicate conditions
Menu Bar

Start File Utility

Start Software Configurator

Start Hardware Configurator

Starts the control server

The meanings of the icons that indicate conditions are as follows:

Report function in operation: white, stopped: gray
• EScanning/Alarm occurred: blinking red

If you point to the icon and click the right button, the "Reset Alarm 
Status" button appears.  Click the button and the indicator changes 
to blinking green.

• EScanning/No alarm: blinking green
• EScanning stopped: gray

• EScanning/Normal response from the recorder, scanning stopped: white
• EScanning/Abnormal response from a recorder: displays an "X" mark
  If you point to the icon and click the right button, the "Disconnect Recorder" 
  and "Reconnect Recorder" menu appears.  If you select a certain recorder 
  from the "Disconnect Recorder" menu, the communication with the recorder 
  is disconnected.  To reconnect the communication with the recorder, select 
  the recorder from the "Reconnect Recorder" menu.

• EScanning/No data dropouts: blinking blue
• EScanning/Data dropouts occurred: blinking yellow

If you point to the icon and click the right button, the "Reset Missing Data 
Status" button appears.  Click the button and the indicator changes 
to blinking blue.

• ERecording: Red, a section of the icon blinks
• ERecording stopped: gray

• EScanning: A section of the icon blinks
• EScanning stopped: No blinking

Event Processor
Event Processor in operation: blinking light blue, 
stopped: gray, waiting: light blue, error: blinking red
If you point to the icon and click the right button, 
the "Reset Error Information" menu appears. 
Click the menu.  The indicator changes to blinking light blue.

2. To start a program, click the corresponding button.

Note
• Use the recorder disconnect function such as when replacing the chart paper of the recorder.
• Do not change the input range of channels after disconnecting the recorder.  If you change

the input range of a channel, the channel is processed as if it is turned OFF when the
recorder is reconnected.

• The recorders that have been disconnected using the above procedure cannot be
automatically reconnected.  For details on the auto reconnect function, see section 2.9.
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Terminating DAQLOGGER
Procedure

1. From the menu bar of “DAQLOGGER Manager,” select “File” and then “Exit” or click
the “Close” button at the upper right corner of the window.

Note
Exit all DAQLOGGER programs before terminating Software Manager.

2.3  Starting DAQLOGGER
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2.4 Setting a Project

DAQLOGGER operates on a project basis.
For each project, you can save the settings for logging and report generating functions
and those for the applications started by Software Manager.
By changing this project, you can easily switch between the sets of different settings that
have previously been saved.

Note
The operations described in the following are possible only when all DAQLOGGER

applications other than Software Manager are terminated and the password protection is not

used.

Creating a New Project
To create a new project, the operation level of the current project must be “Supervisor.”

Procedure
1. Before operation, make sure that DAQLOGGER is not communicating, applications

other than Software Manager are not running, and the password protection is not
used.

2. In the menu bar of the “DAQLOGGER Manager” window, select “File” then “Project
Setting.” The “Project Setting” dialog box appears.

In the initial state, the dialog box comes out with “Project1” at the operation level of
“Supervisor.”

3. Press the “New...” button.  The “New Project” dialog box appears.
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4. Input a project name and select an operation level; then click “OK.”
For more details about the operation level, see “Setting Operation Level to a Project”
in section 2.5.

Note
• You cannot use the following characters in a project name:  \  /  :  ,  ;  *  ?  ”  <  > |.

• The following character combinations cannot be used as project names.

con, prn, aux, aux1, aux2, com1, com2, com3, com4, com5, com6, com7, com8, com9,

nul, clock

• You cannot create a new project with the same name and operation level as that of an

existing project.  You can create a new project with an existing name if its operation level

is different.

5. If you wish to set password protection, carry out the operation described in “Setting
Password Function” in section 2.5.

6. Sets the logger auto start function.  Select “Off,” “Only scan measurement data,” or
“Scan and record measurement data.”

Note
In the logger auto start function, you can select “Only scan measurement data,” “Scan and

record measurement data,” or “Off” when starting the Manager.

Selecting an Existing Project
To select a project when more than one project has already been created, do the
following.

Procedure
1. Same as the operation in “Creating a New Project.”
2. Same as the operation in “Creating a New Project.”
3. In the “Project” combo box, select the project.
4. If “Use Password Protection” has been checked for the selected project, the “Input

Password” dialog box appears.

5. Type the password and click “OK.”
You cannot open the project if the password does not match.

2.4  Setting a Project
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Copying Project
You can copy project settings from one project to another.

Procedure
1. Same as the operation in “Creating a New Project.”
2. Same as the operation in “Copying a New Project.”

3. Select the project you want to copy settings to in the Project list.  Only select a project
whose operation level is Supervisor.

4. Click Copy.  The Copy Project dialog box appears.

5. Select the project from which you wish to copy settings, as well as the settings to be
copied.  Only the settings appearing in the list may be copied.  The items that were
not set for the selected project are dimmed.

Deleting an Existing Project
To delete an unneeded project, do the following.

Procedure
1. Same as the operation in “Creating a New Project.”
2. Same as the operation in “Creating a New Project.”
3. In the “Project” combo box, select the project.
4. Click the “Delete” button.

Note
• If there is only one project of “Supervisor” operation level, you cannot delete this project.

• If there is only one project which does not use password protection, you cannot delete this

project.

2.4  Setting a Project
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2.5 Setting the Security

To prevent misoperation, you can set an operation level to each project.
In addition to this operation level, DAQLOGGER’s security function offers password
protection and desktop protection.

Setting Operation Level to a Project
For individual projects, you can set an operation level selecting from “Supervisor,”
“Operator,” and “User.”
Under these operation levels, operation will be limited as follows.

Function Supervisor Operator User

Logging Software No limitation No limitation Setting change disabled
Start/Stop operation possible

Data Monitor No limitation No limitation No limitation

Historical Viewer No limitation No limitation No limitation

DDE Server No limitation No limitation Setting change disabled
Pause/Resume operation possible

Monitor Server No limitation No limitation Setting change disabled
Pause/Resume operation possible

Report Generator No limitation No limitation Setting change disabled
Start/Stop operation possible

Group Editor No limitation No limitation Saving disabled

Hardware Configurator No limitation Sending and Sending and
saving disabled saving disabled

Tag Editor No limitation Saving disabled Saving disabled

Software Configurator No limitation Operation disabled Operation disabled

File Utility No limitation No limitation No limitation

Event Processor No limitation No limitation Setting change disabled Start/Stop
operation possible

Control Server No limitation No limitation Setting change disabled Start/Stop

Procedure
The operation level is only set for the process of creating a new project and cannot be
changed once it is set.
Setting the operation level is not an independent operation but is carried out in step 4 of
“Creating a New Project” in section 2.4.

4. In the “Level” list box, select the operation level you wish to set.
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Setting Password Protection
Password protection is a function to limit operation as shown below, regardless of the
project’s operation level.

Function Protection OFF Protection ON

Logging Software Follows project’s operation level. All operation disabled

Data Monitor Follows project’s operation level. Setting change/save disabled

Historical Viewer Follows project’s operation level. No limitation

DDE Server Follows project’s operation level. All operation disabled

Monitor Server Follows project’s operation level. All operation disabled

Report Generator Follows project’s operation level. All operation disabled

Group Editor Follows project’s operation level. Cannot start

Hardware Configurator Follows project’s operation level. Cannot start

Tag Editor Follows project’s operation level. Cannot start

Software Configurator Follows project’s operation level. Cannot start

File Utility Follows project’s operation level. No limitation

Event Processor Follows project’s operation level. All operation disabled

Control Server Follows project’s operation level. All operation disabled

To set up password protection, first specify the use of password function then set the
password protection to ON.

Setting password function
Specifying the use of password function

Procedure
1. In the menu bar of the “DAQLOGGER Manager” window, select “File” then “Project

Setting.”  The “Project Setting” dialog box appears.

2. Click the check box of “Use Password Protection” to select it.  The “New Password
Setting” dialog box appears.

2.5  Setting the Security
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3. Type the password in the “New Password” and “Confirm” boxes then click “OK.”

Note
• A password must be within 16 characters.  Any character is acceptable.

• Do not forget the password you set.

Canceling the use of password function
This operation does not clear the password already set.  The password will take effect if
you specify its use again.

Procedure
1. In the menu bar of the “DAQLOGGER Manager” window, select “File” then “Project

Setting.” The “Project Setting” dialog box appears.

2. Click the check box of “Use Password Protection” to clear it; then click “OK.”

Changing the password
This operation changes the password already set.

Procedure
1. In the menu bar of the “DAQLOGGER Manager” window, select “File” then “Project

Setting.”  The “Project Setting” dialog box appears (See the figure above).
2. Press the “Change...” button.  The “New Password Setting” dialog box appears.

3. Type the password in the “New Password” and “Confirm” boxes then click “OK.”

Note
• A password must be within 16 characters.  Any alphanumeric characters are acceptable.

• Do not forget the password you set.

2.5  Setting the Security
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Setting the password protection ON
With a project for which the use of password function is specified, this operation turns the
password protection ON.  This operation is disabled while Hardware Configurator, Tag
Editor, or Software Configurator is running.

Procedure
1. In the menu bar of the “DAQLOGGER Manager” window, select “File” then “Password

Protection.”
The password protection is turned ON.

Setting the password protection OFF
This operation sets the password protection to OFF.

Procedure
1. In the menu bar of the “DAQLOGGER Manager” window, select “File” then “Password

Protection.” The “Input Password” dialog box appears.

2. Type the password and click “OK.”
If the password does not match, you cannot turn the protection OFF.

Note
• Protection by a password will not be established by just specifying the use of password

function.  You must also set the password protection to ON.

• A password must be within 16 characters.  Any character is acceptable.

• Do not forget the password you set.

2.5  Setting the Security
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Setting Desktop Protection
Desktop protection is a function that temporarily hides the start menu bar and icons
(shortcuts) of Windows normally displayed on the screen.
When desktop protection is ON, other software cannot be started, so the personal
computer is protected from careless operations.

Setting the desktop protection ON

Procedure
1. In the menu bar of the “DAQLOGGER Manager” window, select “File” then “Desktop

Protection.”
The “Hide Desktop” dialog box appears.

2. Type the password in the “Password” and “Confirm” boxes then click “OK.”

Note
• A password must be within 16 characters.  Any character is acceptable.

• Do not forget the password you set.

Setting the desktop protection OFF

Procedure
1. In the menu bar of the “DAQLOGGER Manager” window, select “File” then “Desktop

Protection.”  The “Password to Display Desktop” dialog box appears.

2. Type the password and click “OK.”

2.5  Setting the Security
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2.6 Setting Communications and the Connected
Recorder Models

To ensure proper collection of the measured/computed data, it is necessary to set
communication and the connected recorder models.

Basic Operation
To select recorder/communication port
• Click the number cell (recorder number / port number).
• To select more than one recorder/port from a series of numbers, click the first cell,

then pressing the SHIFT key, click the last cell.

To switch Use/Not Use of ports
• Clicking the check box alternately switches between Use and Not Use.
• If a series of numbers is selected, pressing the tool button at the bottom switches the

selected ports collectively.

To set the cells
• Click the cell to open a list box and select the item you wish to set.

Setting Communications
Set serial ports.  Data length is fixed at 8 bits.

Procedure
1. In the “DAQLOGGER Manager” window, press the “ENVI” button.  Software

Configurator starts and its window opens.

The address is reassigned, starting from the smallest 
address number available, to the recorders in the 
selected range that are connected via RS-422A in the 
order of the record numbers.

Switches the “Expandable/Standalone” setting of the 
DARWIN recorders in the selected range at once.
 Switching the “Expandable/Standalone” setting 
initializes the settings (see page 2-17).

 Copies the settings of the first recorder 
number in the selected range to the 
settings of all the recorder numbers in 
the selected range.

Initializes the settings of the recorder 
numbers in the selected range.  Initialization 
refers to the act of removing recorder 
assignments from recorder numbers and 
clearing all other settings as well.



2-14 IM 04D05C01-62E

2. Click the “Serial Setting” tab.  The serial setting panel appears.

Turns ON/OFF the 
ports in the selected 
range at once.

Copies the settings of the first port number in the 
selected range to the settings of all the port numbers 
in the selected range.

3. Click the check box in the “Port No.” column to set the port for use.

When more than one port is selected, clicking the tool cell at the bottom allows the
Use/Not Use statuses of the selected ports to be switched collectively.

4. Set the selected ports.  Clicking the individual cells in the “Type,” “Baud Rate,” “Parity
Bit,” or “Stop Bit” column opens a list box containing the choices.  Select one from the
list box.

Provide the same settings as those set for the connected recorder.
For information about recorder setting, see “2.2  Preparing the Recorder.”

Pressing tool button at the bottom copies the settings of the first port number in the
selected range to the settings of all the port numbers in the selected range.

2.6  Setting Communications and the Connected Recorder Models
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Setting the Connected Recorder Models
Before you start this setting operation, obtain information about the recorders connected
to the communication ports: model, channels, options, communication address, etc.
Serial port setting must be completed in advance (see the previous section, “Setting
Communications”).

Procedure
From the “Recorder Setting” tab panel, assign the communication port and address to
each of the connected recorders.
1. To set the communication port, click the cell in the “Port” column and select from the

list box.
For example, when using Ethernet, COM1, and COM2, assign Ethernet, COM1, and
COM2 in the “Port” cells, respectively.

Next, click the cell in the “Address” column and set the address of that port. However,
no address setting is needed for a port to which RS-232C is assigned.
Pressing tool button at the bottom reassigns the address, starting from the smallest
address number, to the recorders in the selected range that are connected via RS-
422A in the order of the record numbers.

• For Ethernet
The following dialog box appears. Set the items manually.

IP Address or Host Name
Enter IP address or the host name of the recorder (up to 255 alphanumeric
characters).

Login Name
Enter the login name (User name) set on the DX, MV, or CX (up to 16 alphanumeric
characters).

Note
To send the settings data using Hardware Configurator, or to operate starting/stopping

computation on Software Manager (see section 2.9),  log onto an account that has

administrative privileges.

2.6  Setting Communications and the Connected Recorder Models
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Password
Enter the password for the “Login Name” set on the DX, MV, CX (up to 6
alphanumeric characters).

Monitor Server
When carrying out Ethernet communications with the PC in which DAQ32Plus,
DAQEXPLORER, or DAQLOGGER is installed, you must enter the port number and
system number (DAQEXPLORER only) if you wish to connect to a specific system.
The items that can be entered vary depending on the model that is performing remote
monitoring.

Note
Note the following points depending on which software application you access.

• For communications with a PC running DAQLOGGER:

Before acquiring data, start the DAQLOGGER scan on the computer you will connect to. If

you are running DAQLOGGER version R5.01 or later, you can not open a connection

unless the scan is running.  If you stop the scan during data acquisition, please note the

following:

For DAQLOGGER R5.01 or later: The connection will be cut.

For DAQLOGGER R3.0x or R4.0x: Data after the scan or calculation was stopped will

not be updated, and will remain at its original value.

If you restart the scan, the connection will be cut

(however if autoconnect is specified in the logger

condition settings, the connection will be

automatically reopened).

• For communications with a PC running DAQ32Plus:

Before acquiring data, start the DAQ32Plus monitor on the computer you will connect to. If

you are running DAQ32Plus version R10.03 or later, you can not open a connection

unless the monitor is running.

If you stop the monitor during data acquisition, please note the following:

For DAQ32Plus R9.0.0x, R10.01.0x, or R10.02: Data after the scan was stopped will not

be updated, and will remain at its

original value.

• For communications with a PC running DAQEXPLORER: Before acquiring data, turn

monitoring ON on the DAQEXPLORER desktop at the computer you will connect to, and

mount the recorder. During data acquisition, if you turn the monitoring setting OFF on the

mounted recorder or unmount it, the connection will be cut.

2.6  Setting Communications and the Connected Recorder Models
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• For RS-422A
The following dialog box appears. Set the address manually.
uR Series: 1 to 16
VR View recorder: 1 to 16
DX/CX DAQSTATION, MV MobileCorder: 1 to 32
DARWIN: 1 to 31

2. Selecting a recorder for which a port is set activates the “Recorder Model
Determination” button.
Press the “Recorder Model Determination” button or, in the menu bar, select
“Communication” then “Recorder Model Determination.”
The model of the recorders connected to the set port and with designated address,
will be identified, and the “Communication Message” window appears.

Recorder Model Determination button

If there is any recorder whose model cannot be determined, the following dialog box
appears, asking you to specify the model.

2.6  Setting Communications and the Connected Recorder Models
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When the recorder model determination ends, the following communication messages
are displayed.

Note
In some cases, model and options cannot be detected correctly using the recorder model

determination.

3. After you have read the communication messages, click “OK.”
The settings table shows the model names, measurement channels, and other
information that has been automatically detected.

4. Confirm that the model information that was displayed through automatic detection
matches the model information of the recorder that is actually connected.
If it is not correct, reset the items according to the following procedure.

2.6  Setting Communications and the Connected Recorder Models
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Manual settings operations
A. If necessary, click the “Model” cell and select the model name from the list box.

On the other hand, after selecting an area of the “Model” cells, clicking the tool cell in
the bottom will copy the selected area’s first cell model to all other cells in the selected
area.

B. If necessary, click the “Meas Ch.” cell and select the correct measurement channel
from the list box.
The number of channels displayed in the list box varies depending on the model.
• VR series: 1, 2, 3, 4, 6
• µR1000: 1, 2, 3, 4, 6
• µR1800: 1, 2, 3, 4, 6, 12, 18, 24
• DX100: 2, 4, 6, 12
• DX200: 4, 8, 10, 20, 30
• DX200C: 4, 8
• MV100: 2, 4, 6, 12
• MV200: 4, 8, 10, 20, 30
• CX1000: 6
• CX2000: 10, 20
• DARWIN: Not selectable, see “Setting the modules”
• DAQLOGGER: 400, 1000, 1600
• DAQ32Plus: 420
• DAQEXPLORER: 0 to 1600

C. If necessary, click the “Math Ch.” cell and select the correct computation channel from
the list box.
The number of channels displayed in the list box varies depending on the model.
• VR100: Not selectable (no computation option)
• VR200, VR200 S2: NONE, 1, 2, 3, 4, 6
• µR1000: NONE, 4 (when the number of measurement channels is 1,

2, 3, or 4)
NONE, 6 (when the number of measurement channels is 6)

• µR1800: NONE, 4 (when the number of measurement channels is 1,
2, 3, or 4)
NONE, 12 (when the number of measurement channels is
6, 12, 18, or 24)

• DX100: NONE, 4, 8 (when the number of measurement channels is
2 or 4)
NONE, 12 (when the number of measurement channels is 6
or 12)

• DX200: NONE, 8 (when the number of measurement channels is 4
or 8)
NONE, 30 (when the number of measurement channels is
10, 20, or 30)

• DX200C: NONE, 8
• MV100: NONE, 4, 8 (when the number of measurement channels is

2 or 4)
NONE, 12 (when the number of measurement channels is 6
or 12)

• MV200: NONE, 8 (when the number of measurement channels is 4
or 8)
NONE, 30 (when the number of measurement channels is
10, 20 or 30)

2.6  Setting Communications and the Connected Recorder Models
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• CX1000: NONE, 12
• CX2000: NONE, 30
• DARWIN: NONE, 30 (“standalone” models)

NONE, 60 (“expandable” models)
• Monitor Server Type: Not available, since there are no computation channels.

D.  If necessary, click Meas. Ch.  The dialog box below appears.  The Ctrl. Ch cell is only
available for CX models.

• Setting the presence or absence of options (system configuration) and the
subunit/module configuration for the DARWIN recorder
For DA100, DR130, DR200, and DC100 recorders, select expandable model or
standalone model and set the presence or absence of options and the subunit/module
configuration.
A. Click the “Standalone” or “Expandable” cell in the “System” column.  The “System

Options” dialog box opens.  Set the displayed items according to the following
procedure:
“Standalone” or “Expandable”: Select using the option (radio) button (“Standalone”
only for the DR130).
Style: Select from the drop-down list box.
Memory (for DC100 only): Select from the drop-down list box.
Options: Select the appropriate check box.

2.6  Setting Communications and the Connected Recorder Models
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Note
When making system changes with the DARWIN series, if the changes do not effect the

system configuration, do not initialize the system (see step B).  The Initialize button is only

active when initialization is needed.  The OK button is displayed when initialization is not

needed.

Switching “Standalone” and “Expandable” on the “Recorder Setting” tab
panel
By clicking the tool cell at the bottom of the “Recorder Setting” tab, you can switch
between “Standalone” and “Expandable” for the selected DA100, DR200, and
DC100 recorders.  If you switch “Standalone” and “Expandable,” “Initialization” is
executed as described in step B below.
Changing the number of computation channels (“Math ch”) on the “Recorder
Setting” tab panel
The number of computation channels can also be selected by clicking the “Math
Ch.” cell and selecting from the list.  If you set the number of computation channels
to some number other than “None,” a check mark appears at “Mathematical Func.(/
M1)” in the “System Option” dialog box.

B. If you click “Initialize,” the specified items are activated and the recorder settings
are initialized as follows:

Model Standalone Measurement Computation Number of Module
 /Expandable Channel Channel* Subunits Configuration

DA100 Standalone 0 30 0 No module
Expandable 0 60 0 No module

DR130 Standalone 10 30 0 DU100-1 1 unit

DR200 Standalone 10 30 0 DU100-1 1 unit
Expandable 0 60 0 No module

DC100 Standalone 0 30 0 No module
Expandable 0 60 0 No module

* If the computation function (Mathematical Func.(/M1)) is not present, “NONE” is displayed.

Clicking “Close” cancels the specified items and closes the dialog box.

2.6  Setting Communications and the Connected Recorder Models
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C. Click the cell on the right side in the “System” column (the cell with the number of
subunits displayed).  The “System Module” dialog box opens.  Set the displayed
items according to the following procedure:
If you set the following items in the “System Module” dialog box, the number of
measurement channels is displayed in the “Meas Ch.” cell, and the number of
subunits in the cell on the right side in the “System” column.

Unit 0

Unit 3

Unit 5

Unit 1

Unit 2

Unit 4

This figure shows a dialog box when a subunit is assigned.

Setting the modules
Click the position where the module is to be attached.  The “Select Module” dialog box
opens.

2.6  Setting Communications and the Connected Recorder Models
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If you clear the check mark by clicking “Delete,” the modules that can be attached
become selectable.  Select the module with the option button.

For clamp input terminals, select the “Clamp” check box.
To delete a module, clear the check mark by clicking “Delete.”

Click “OK” to activate the new settings and close the module selection dialog box.
Click “Revert” to set the settings back to the settings that existed when the module
selection dialog box was opened.
Click “Cancel” to discard the settings and close the module selection dialog box.

Setting the subunits
Click the subunit position.  The “Select Unit” dialog box opens.

If you clear the check mark by clicking “Delete,” the subunits become selectable.
Select the subunit with the option button.
To delete a subunit, clear the check mark by clicking “Delete.”
Click [OK] to activate the new settings and close the subunit selection dialog box.
Click “Revert” to set the settings back to the settings that existed when the “Select
Unit” dialog box was opened.
Click “Cancel” to discard the settings and close the “Select Unit” dialog box.

The method to set the modules for the subunit is the same as the method described in
the aforementioned section, “Setting the presence or absence of options and the
subunit/module configuration for the DARWIN recorder.”

By clicking the tool cell at the bottom of the “Recorder Setting” tab, you can copy the
module configuration of the subunit of the first recorder in the selected range, to all
the DA100, DR200, DC100 expandable models in the selected range.

Saving the Settings
Save the current settings.

Procedure
1. In the menu bar of the “DAQLOGGER Software Configurator” window, select “File”

then “Save.”
The environmental information that has been set will be saved.

2.6  Setting Communications and the Connected Recorder Models



2-24 IM 04D05C01-62E

Reverting to the Last-saved Settings
Load the settings data that was saved last.

Procedure
1. In the menu bar of the “DAQLOGGER Software Configurator” window, select “File”

then “Revert.”
The last-saved environmental information will be loaded.

Initializing the Serial Port
In some cases, unwanted data are present in the serial interface buffer such as
immediately after booting up the PC.  This can cause errors when communication is
started.  This function initializes the serial interface buffer.

Procedure
1. Click the “Serial Setting” tab.  The “Serial Setting” tab panel appears.
2. Select the port to be initialized.
3. In the “DAQLOGGER Software Configurator” window, select “Initialize Serial Port”

from the “Communication” menu.  The communication buffer is initialized.

Printing the Settings
Operations of “Print,” “Print Preview,” and “Set Printer” under the “File” menu of
“DAQLOGGER Software Configurator” window are the same as those of Windows’ print
commands.
Settings of both “Recorder Setting” and “Serial Setting” are printed.

Procedure
1. In the menu bar of the “DAQLOGGER Software Configurator” window, select “File”

then “Print.”
The “Print” dialog box opens.

Terminating the Software Configurator
If the current settings have not been saved yet, a confirmation message appears. Follow
the instructions in the message and save the settings if necessary.

Procedure
1. In the menu bar, select “File” then “Exit.” Or click the close button in the upper right

corner of the window.
The Software Configurator closes.

2.6  Setting Communications and the Connected Recorder Models
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2.7 Setting Tags

Name the channels of the recorders which have been set using the Software
Configurator.
The Data Monitor and Historical Viewer use these names (tag names) to handle the
collected data.

Basic Operation
To select tag
• Click the number cell (Tag No.).
• To select a series of numbers from more than one tag, click the first cell then,

pressing the SHIFT key, click the last cell.

To change the use status of a tag
• Clicking the check box of “Use” cell alternately switches between Use and Not Use.
• If a series of numbers is selected, pressing the tool button in the bottom collectively

switches the status of the selected tags.

To set a cell
• Click the cell to open a list box and select the item you wish to set.

To sort by a header item
• Click the header item (“Tag No.” “Use” “Tag Name,” “Recorder Number,” or

“Channel”).  The tag list contents will be sorted by the clicked header item.

Setting Tag Information
To set tag information, first execute the automatic assignment.  After that, edit the
information as necessary.
This automatic assignment function assigns a tag number to every channel of the
recorders set using the Software Configurator.  A maximum of 1600, 1000, or 400 tags
can be assigned depending on the software.

Procedure
1. In the “DAQLOGGER Manager” window, press the “TAG” button.  Tag Editor starts

and the “DAQLOGGER Tag Editor” window opens.

Starting with the first “Recorder Number/Channel Number”
 in the selected range, recorder numbers and channel 
numbers are assigned to the tag in the selected range in 
the order of the recorders that are assigned by 
the Software Configurator.
Example:  Recorder  Channel
 (in the selected range)
1st tag  Rec05  07
2nd tag   Rec05  08
3rd tag   Rec06  02

Click an item name 
to sort the list 
using the item in 
ascending order.

Search setting button

Select/Deselect 
all tags at once.

Switch use/not use of tag  in the 
selected range at once.
Assign tag names in the selected range by 
adding sequential numbers to the tag name of 
the first tag name in the selected range.
Example:  Before  After
(in the selected range)
1st tag name   TAG-A  TAG-A-0001
2nd tag name -  TAG-A-0002
3rd tag name  -  TAG-A-0003
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2. Click the “Auto Assignment” button or, in the menu bar, select “Edit” then “Auto
Assignment.”
The recorder and channel numbers are assigned automatically according to the
instrument settings entered in the Software configurator.  Tag numbers are assigned
starting with Tag No. 1 in the following order:  measurement channel 1 on recorder
number 1, computation channel 1 on recorder number 1, internal loop channel 1 on
recorder number 1 (CX only), external loop channel 1 on recorder number 1,
measurement channel 1 on recorder number 2…and so on.

Auto Assignment button

3. Click the check box of “Use” cell to switch the Use/Not Use of the tag.
Clicking the tool cell in the bottom enables the Use/Not Use of the tags in the selected
area to be collectively switched.

To edit each item of the tag information that has been automatically set, perform the
following procedure.

• Manual settings operation
A. If necessary, change the tag name.

A tag name of up to 32 characters long can be entered.

Clicking the tool cell in the bottom renames the tag names of a selected area.  Taking
the first tag name as a base form, the following tag names will be renamed in the form
of “TagName-nnnn” (nnnn: a number which increments by 1, see page 2-21).

B. If necessary, click the “Recorder Number” cell and select the recorder that is to be
assigned to the tag from the list box.
The recorder numbers appear in the list box are as shown below.  However, recorder
numbers not connected using the Software Configurator do not appear in the list box,
so you cannot select them.

• NONE
• R01: model name to R32: model name

2.7  Setting Tags
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C. If necessary, click the “Channel” cell and select the channel that is to be assigned to
the tag from the list box.
The list box lists the channel numbers of the measurement channels, computation
channels, Int. Loop channels, and Ext. Loop channels which were set using the
Software Configurator.

Clicking the tool cell in the bottom sets the channel numbers for the tags in the
selected area. The channel connected to the first tag is used as a base and the
channel numbers of the following tags are incremented by 1.
When the channel number reaches the last channel of that recorder, it transfers to the
next recorder number. When the last recorder number is reached, it returns to the
smallest recorder number.

Note
A single channel can be assigned to multiple tags.

Reading Tag Names from the Recorder
The tag string can be read from the recorder and entered in the tag name.

Procedure
1. Select the tag for which to read the tag information.
2. In the “DAQLOGGER Tag Editor” window, select “Receive Tag Setting” from the

“Communication” menu.
A window appears indicating that the tag is being received, and the tag is received.
The tag names in the selected range are replaced with the tag string of the specified
channel of the recorder.  After execution, the “Communication Message” dialog box
appears.  Read the message and click “OK.”  The “Communication Message” dialog
box closes.
If an error message appears, see Chapter  9, “Messages.”

Note
DA does not have tag settings.  Thus, tags cannot be received from it.

Searching Tags
You can search tags by specifying the tag name, tag number, or recorder number.  If a
tag is selected, the search begins from the selected tag.

Procedure
1. Click “Search” on the toolbar or select “Search” from the “Edit” menu of the

“DAQLOGGER Tag Editor” window.  The “Move/Find” dialog box opens.

2.7  Setting Tags
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2. Click “Tag Name,” “Tag Number,” or “Recorder No.”
3. Enter the item to be searched in the entry box of the selected item.

The search operation is as follows:
Tag Name: Searches for tags that contains the specified string in the tag name (case-
sensitive).
Tag No.: Searches the tag with the specified tag number.
Recorder No.: Select the recorder number from the list.  The tag that is assigned to
the recorder corresponding to the selected recorder number is searched.

4. Click “Search Next” or “Previous.”  The tag that matches the search condition is
selected and displayed.  If you click “Search Next” or “Search Previous” again, the
next tag that matches the search condition is selected and displayed.
If the corresponding tag does not exist, nothing happens.
You can change the tag settings while the “Move/Find” dialog box is displayed.

5. Click “Close” to close the “Move/Find” dialog box.  You can perform the search by
selecting “Search Next” or “Search Previous” from the “Edit” menu or by clicking
“Search Next” or “Search Previous” on the toolbar.

Moving the Display by the Specified Number of Tags
You can move the display by the specified number of tags.

Procedure
1. Click “Search” on the toolbar or select “Search” from the “Edit” menu of the

“DAQLOGGER Tag Editor” window.  The “Move/Find” dialog box opens.

2. Enter the number of tags to move for each operation in the width box.
3. Click “Up” or “Down” to move by the specified number of tags.  Only the display

moves.  The selected tags to not change.
4. Click “Close” to close the “Move/Find” dialog box.  You can move the display by

selecting “Page Down” or “Page Up” or by clicking “Page Down” or “Page Up” on the
toolbar.

2.7  Setting Tags
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Printing Tag Information
Operations of “Print,” “Print Preview,” and “Set Printer” under the “File” menu of the
“DAQLOGGER Tag Editor” window are the same as those of Windows’ print commands.
Tag information for selected tags are printed.  When no tag is selected, however, tag
information for all tags are printed.

Procedure
1. In the “DAQLOGGER Tag Editor” window, select “File” then “Print.”

The “Print” dialog box appears.
2. In the dialog box, provide settings for printing then click “OK.”

Saving Tag Information
Save the current settings.

Procedure
1. Select “File” then “Save.”

The currently set tag information will be saved.

Terminating the Tag Editor
If the current settings have not been saved yet, a confirmation message appears.  Follow
the instructions in the message and save the settings if necessary.

Procedure
1. Select “File” then “Exit.”  Or click the close button in the upper right corner of the

window.
The Tag Editor window closes.

2.7  Setting Tags
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2.8 Setting Groups

Assigns the tags set by Tag Editor to groups.  Up to 32 tags can be assigned to a single
group, and up to 50 groups can be specified.  In addition, names can be placed on the
groups.
Data Monitor and Viewer display the scanned and recorded data by groups that are
specified here.

Basic Operation
To select the waveform number (W**)
• Click the appropriate number cell.
• To select tags consecutively, click the first cell, and then, pressing the SHIFT key,

click the last cell.
• Click “No.” at the top of the waveform number column to select or deselect all

waveform numbers.
To show/hide tags
• Click the check box of the waveform number cell to switch between show and hide.
• By clicking the tool cell at the bottom when consecutive cells selected, you can switch

between show and hide in the selected range at once.
Setting the cell
• Click the cell to open the tag selection dialog box.  Then, select the desired tag.

Assigning Tags to Groups
There are two methods that you can use to assign tags to groups: auto grouping and
manual assignment.

Using auto grouping
You can specify the number of tags to assign per group, and automatically assign tags to
the groups.  The tags that have been set by Tag Editor are assigned to the groups in
order from the first tag.  However, the tags that are assigned are the ones that have
recorders and channels assigned to them by Tag Editor and set to “Use ON” (indicated
in white).  Tags that are set to “Use OFF” or the ones that do not have recorders and
channels assigned to them (indicated in gray) are skipped.

Procedure
1. Click “GROUP” in the “DAQLOGGER Manager” window.

Group Editor starts and the “DAQLOGGER Group Editor” window opens.
2. To select the group, click the cell in the “No.” column in the group list section or click

the group tab in the tag assignment display section.
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Starting with the first tag in the selected 
range, tags are assigned to the selected 
range in the order that is specified by
 the Tag Editor.

Waveform number
Auto Grouping button Group selection tab

Group list
(Group number and group name)

Turn ON/OFF the 
selected range at once

Click this button to show or 
hide the group list section.

3. Click “Auto Grouping” on the toolbar or select “Auto Grouping” from the “Edit” menu of
the “DAQLOGGER Group Editor” window.  The “Auto Grouping Setting” dialog box
opens.

Enter the number of tags per group and click “OK.”  The tags are automatically
assigned to the groups.  The number of tags assigned per group is saved even after
the dialog box is closed.

2.8  Setting Groups
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To manually assign the tags to groups or to change the assignment, perform the
following procedure.

4. Click the tab to select the group to assign the tags.
5. Click the “Tag No.,” “Tag Name,” or “Model: Channel” cell of the waveform number to

assign the tag.  A dialog box for selecting “Tag No.,” “Tag Name,” or “Model: Channel”
appears.
Select the “Tag No.,” “Tag Name,” or “Model: Channel” to be assigned.  Select
“None,” if the tag is not to be assigned.
Changing any one of “Tag No.,” “Tag Name,” and “Model: Channel” automatically
changes the other two.

If the waveform number are selected in a series, click the tool cell in the bottom to set
tag names in order from the tag name of the first waveform number in the selected
range.

Showing/Hiding Tags
Procedure

1. Click the check box of the “No.” column cell to switch the show and hide condition of
the tag.
By clicking the tool cell at the bottom when consecutive cells selected, you can switch
between show and hide in the selected range at once.

Changing the Group Name
Procedure

1. Click the “Group Name” cell in the group list section or click the group name display
section in the tag assignment display section.  Then, enter the group name using the
keyboard.  Changing the name in one changes the other.

2.8  Setting Groups
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Saving the Group Settings
Group settings cannot be saved while scanning or recording is in progress.

Procedure
1. In the “DAQLOGGER Group Editor” window, select “Save” from the “File” menu.  The

settings are saved.

Note
The group setting items are items that can also be set or changed in the display settings of

Data Monitor.  If you change the tag assignments, show/hide condition of tags, or group

names and save the information, the information is also reflected in Data Monitor.  However,

other items set in the display settings of Data Monitor (“Scale” and “Meter Type,” for example)

are left unchanged (Even if you change the tag assignments, other tag settings do not

change).

Printing the Group Setting Information
Procedure

Setting the printer
1. In the “DAQLOGGER Group Editor” dialog box, choose “Print Setup” from the “File”

menu.
2. The “Print Setup” dialog box appears.  Set “Printer,” “Paper,” and “Orientation”

according to the printer that you are using.

Displaying the print preview of the group setting information
3. In the “DAQLOGGER Group Editor” dialog box, choose “Print Preview” from the “File”

menu or click the “Print Preview” icon on the tool bar.
4. A dialog box for selecting the group to be printed appears.  Select the group.

Selects only valid groups (group in which at least one tag is assigned).
Selects all groups.

2.8  Setting Groups
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5. Click “OK” to display the print preview dialog box.  The print image of the selected
group is displayed.

6. Click “Close” in the print preview dialog box to close the print preview display.

Printing the Group Setting Information
7. In the “DAQLOGGER Group Editor” dialog box, choose “Print” from the “File” menu or

click the “Print” icon on the tool bar.
8. A dialog box for selecting the group to be printed (see the previous section,

“Displaying the print preview of the group setting information”) appears.  Select the
group.

9. Click “OK.”  The print process is performed for the selected group and the “Print”
dialog box appears.

10. Click “OK” to start printing.
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2.8  Setting Groups

Terminating the Group Editor
If there are group settings that have not been saved, a save confirmation message
appears.  Save the settings according to the message.

Procedure
1. In the “DAQLOGGER Group Editor” window, select “Exit” from the “File” menu.
The “DAQLOGGER Group Editor” window closes and the program terminates.



2-36 IM 04D05C01-62E

2.9 Configuring the Logger

Before collecting measured/computed data by executing SCAN and RECORD, set the
logger configuration.

Configuring the Logger
Procedure

1. In the menu bar of the “DAQLOGGER Manager” window, select “Logger” then
“Configuration.”
The “Logger Configuration” dialog box appears.

2. In the “Scan Interval” box, enter the scan interval in seconds.

Note
Depending on the number of connected recorders, the specified scan interval may be too

short to collect all of the data and may result in data dropouts.  In this case, change the scan

interval to a larger value.

3. In the “Recording Rate” box, enter the recording rate in terms of scans.
For example, if the scan interval and recording rate are set to 2 seconds and 5,
respectively, then the measured data are saved to the file at intervals of 10 seconds
(2 x 5).
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4. If necessary, set whether or not to measure in zero start adjustment mode.
In zero start adjustment mode, when the scan interval is less than a minute (1 to 59),
the start time of the scanning operation is adjusted so that the operation takes place
at 00 sec every minute.  If the scan interval is greater than or equal to one minute (60
to 3600), the scanning operation is adjusted so that the operation takes place at 00
min 00 sec every hour.
The zero start adjustment mode is valid for scan intervals which are a divisor of 60
when it is less than a minute, and for scan intervals which are a divisor of 3600 when
it is greater than or equal to one minute.

5. If necessary, set whether or not to record in the zero start adjustment mode.
The zero start adjustment for recording is valid when the zero start adjustment for
scanning is enabled.
When the record interval (scan interval x recording rate) is less than a minute (1 to
59), and is a divisor of 60, the start time of recording is adjusted so that recording
starts at 00 s every minute.  If the record interval is greater than or equal to one
minute and less than one hour (60 to 3599), and is a divisor of 3600, the start time of
recording is adjusted so that recording starts at 00 min 00 s every hour.   If the record
interval is greater than or equal to one hour and less than or equal to one day (3600
to 86400), and is a divisor of 86400, the start time of recording is adjusted so that
recording starts at 00 hour 00 min 00 s everyday.

6. In the “Start” box, select the start condition, “On Record” or “Fixed time.”
If you select “On Record,” the recording operation starts when the “RECORD” button
is clicked.  If you select “Fixed time,” the recording operation starts automatically at
the specified time.

7. In the “End” box, select the end condition, None, Fixed time, or Data count.
If you select “None,” the recording operation stops when the “STOP” button is clicked.
If you select “Fixed time,” the recording operation stops automatically at the specified
time.  If you select “Data count,” the operation stops when the specified number of
data points have been recorded.

8. Click the “Select folder” button to specify the folder used to save the recording results
(data file).
The “Browse for Folder” dialog box appears.

2.9  Configuring the Logger
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9. Specify the folder to save the data file, then click “OK.”

Note
Report files are also saved to this folder.

10.If necessary, specify the name of the data file in the “Extra file name” box.
The specified character string will be placed at the beginning of the file name.  For
example, if “ABCD” is specified, the file names will be ABCD-0000.mld, ABCD-
0001.mld, etc.  If it is not specified, the file names will be 000.mld, 0001.mld, etc.  The
file extension “.mld” is fixed.

11.If necessary, check the “Add Date” box.
If it is checked, an 8-digit number will be placed at the beginning of the file name.  For
example, if the files are recorded on January 25, 1999, the file names will be
19990125-0000.mld, 19990125-0001.mld, etc.
However, if “per Hour” is specified for “File division” in step 11, a 10-digit number will
be placed at the beginning of the file name.  For example, if the file is recorded at the
15th hour (3 p.m.) on January 25, 1999, the file name will be 1999012515-0000.mld.
If the “Extra file name” is specified, the date will be added after the specified file name
as in ABCD-19990125-0000.mld.

12.In the “File division” list box, select the method of file division which is performed
when data is saved.
The list box shows 4 methods: “Off,” “Data count,” “per Day,” and “per Hour.”
If you select Data count, enter the number of data points to be saved in a file.
If you select per Day or per Hour, the file will be divided at 0 a.m. every day or at 0
minute every hour, respectively.

13.If necessary, set the “Action on Undesired Disconnection.”
After you select the check box, enter the time interval (in seconds) for checking the
recovery of the disconnected recorder.
This auto-reconnecting function checks, at the specified intervals, whether the
recorder that went out of communication due to a trouble has recovered or not, and if
recovered, the logger starts scanning that recorder again.

Note
When more than one recorder is connected on a single RS-422A line, setting the auto-

reconnection to ON may cause data dropouts.  This is because if one of the recorders goes

out of communication, the scanning operation for auto-reconnection has some effect on the

data collecting operation for other recorders.

2.9  Configuring the Logger
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14.If necessary, set “Math.”  From the “Action” list box, select the recorder computation
operation to be executed at the start of the scanning operation.  This setting is
common to all recorders that have the computation function.
None: Does nothing.
Start: Starts the computation.
Stop: Stops the computation.
Clear: Clears the computed data.
Clear&Start: Clears the computation and then starts the computation.

However, the following restrictions exist depending on the recorder.
• µR recorders do not accept “Clear” action.
• As for VR, DX, MV, and CX “Clear” action operates when the computation is

stopped.
• When the DX/MV/CX is connected to the Ethernet network, administrator-level

login name must be specified (see section 2.6).
15.Click the “OK” button.

The new logger configuration is saved.

Starting the Scanning
In the scanning operation, data is being collected from the connected recorders via
communication and the personal computer receives the data, but does not save it.

Procedure
1. In the “DAQLOGGER Manager” window, click the “SCAN” button.

After obtaining the information of each recorder, the scanning operation starts.

Note
The time it takes to start the scanning operation depends on the number of connected

recorders.  For example, if 8 recorders are connected, it takes about 40 seconds.

2. Monitor or Record the data.
See chapter 3 “Data Monitor” or “Recording” in the following.

3. Click the “STOP” button.
The scanning operation stops.

Starting the Recording
In the recording operation, the data being scanned are saved in a file.

Procedure
1. In the “DAQLOGGER Manager” window, click the “RECORD” button.

After obtaining the information of each recorder, the recording operation starts.  The
measured data is saved according to the conditions set in “Configuring the Logger.”

2. When the end condition is met or when the “Stop” button is clicked, the recording
operation stops and the logger enters the scanning operation.

Note
Do not change the date or time of the personal computer while scanning or recording.

2.9  Configuring the Logger
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Starting/Stopping Computation on Recorders
This operation is effective while scanning or recording is in progress.

Procedure
1. In the “DAQLOGGER Manager” window, select the operation from the “Logger” menu.

Math Start: Starts the computation
Math Stop: Stops the computation
Math Clear: Clears the computated data
Math Clear&Start: Clears the computation and then starts the computation.

However, the following restrictions exist depending on the recorder.
• µR recorders do not accept “Clear” action.
• As for VR and DX, “Clear” action operates when the computation is stopped.
• When the DX is connected to the Ethernet network, administrator-level login name

must be specified (see section 2.6).

Displaying the Information of the Scanned and Recorded Data
Procedure

1. In the “DAQLOGGER Manager” window, select “Logger Information” from the
“Logger” menu.  As shown below, the information about the data being scanned and
recorded is displayed.

Stopping the Scanning Operation
Stopping the Recording Operation

If you perform the following procedure when recording operation is in progress, the
logger stops recording data and enters the scanning operation.  When scanning
operation is in progress, the logger stops scanning and enters a communication-stopped
state.

Procedure
1. In the “DAQLOGGER Manager” window, click the “STOP” button.

The ongoing process (scanning or recording) stops.

2.9  Configuring the Logger
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2.10 Configuring the Report Function

The Report Function prints (or outputs to a file) at a specified time, the instantaneous
values, the minimum and maximum values from the data that are scanned and recorded
over an hour, a day, or a month and, in addition, the average values, sums, and
accumulating totals that are determined by computation.
The file is output in binary or text format.  You can view the binary files using Viewer.
This function generates the following four types of reports:

Types Interval of Report Generation Computed Data Contents

Hourly report Every hour Instantaneous value at the time the
(The 1st hour, the 2nd hour, ... report is generated.Average/maximum/
the 23rd hour, the 24th hour) minimum values of the hour

Sum of the hour/accumulating total

Daily report Every day (at a specified time) Instantaneous value at the time the
report is generated.
Average/maximum/minimum values of
the day
Sum of the day/accumulating total

Weekly report Every week Instantaneous value at the time the
(at a specified day and time) report is generated.

Average/maximum/minimum values of
the week
Sum of the week

Monthly report Every month Instantaneous value at the time the
(at a specified date and time) report is generated.

Average/maximum/minimum values of
the month
Sum of the month

Data that are used
You can select scan data or record data.
If you specify scan data, scanning operation must be in progress; if you specify record
data, recording operation must be in progress.

Sum and accumulating total
• Sum

This value is computed by summing the data over an hour for hourly reports, over a
day for daily reports, over a week for weekly reports, and over a month for monthly
reports.  It is reset at the time when the corresponding report is generated.

• Accumulating total
Accumulating total can be specified only on hourly and daily reports.
For hourly reports, this value is computed by summing the data until the time the
report is generated.  It is reset at the time the daily report is generated (the value is
the same as the sum of the daily report).
For daily reports, this value is computed by summing the data until the date and time
the report is generated.  It is reset at the time the monthly report is generated (the
value is the same as the sum of the monthly report).
The following example shows the accumulating total for hourly reports.  The time
when the daily report is generated is 8 O’clock.
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7:00 8:00 9:00 10:00
Time

Hourly report creation
Specified time for creating the report

Computation result

Accumulating total

Sum

8:00 9:00 10:00 11:00

About the sum unit
In the sum computation, data are summed over the scan interval.  However, for flow
values that have units /s, /min, /h, or /day a simple summation results in the actual value
not matching the computed result, because the scan interval and the unit of the input
values are different.  In these cases, the unit of the data measured over the scan interval
is converted to match the unit of the input values and the computation is performed.
For example, if the scan interval is 2 s, and the input value is 100 m3/min, a simple
summation would add 100 every 2 s resulting in 3000 after one minute.  However, if the
sum unit is set to /min, then 2s/60s is multiplied every scan interval before the value is
added giving a result that is close to the actual input value.   The scan interval unit is in
seconds.

Sum Unit Conversion

Off ∑(measured/computed value)
/s ∑(measured/computed value) × data acquiring interval*
/min ∑(measured/computed value) × data acquiring interval*/60
/h ∑(measured/computed value) × data acquiring interval*/3600
/day ∑(measured/computed value) × data acquiring interval*/86400

* Data acquiring interval refers to scan interval or record interval.

Processing for abnormal data
If any abnormality is detected in the data being computed, the following processing will
be performed according to the type of computation and the type of data abnormality.

Type of abnormality Average value Max/min value Instantaneous value Sum value

Overflow (+) Not used for 
computation

Used for 
computation

Computation result 
data is abnormal

Not used for 
computation

Overflow (-) Not used for 
computation

Used for 
computation

Computation result 
data is abnormal

Not used for 
computation

Source channel 
skipped

Not used for 
computation

Not used for 
computation

Computation result 
data is abnormal

Not used for 
computation

No source channel Not used for 
computation

Not used for 
computation

Computation result 
data is abnormal

Not used for 
computation

Error or power failure Not used for 
computation

Not used for 
computation

Computation result 
data is abnormal

Not used for 
computation

Data dropout Not used for 
computation

Not used for 
computation

Computation result 
data is abnormal

Not used for 
computation

Cannot output data Not used for 
computation

Not used for 
computation

Computation result 
data is abnormal

Not used for 
computation

2.10  Configuring the Report Function
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Basic Operation
To switch between “Group Name” and “Tag Number” display
To switch between “Tag Number” and “Tag Name” display
• Click the tool cell in the bottom to switch the display.
To select tag(s)
• Click the tag number cell or tag name cell.
• To select tags over an area, click the first cell, then, pressing the SHIFT key, click the

last cell.
To specify/cancel report item
• Click the cell of the item.
• If tags are selected over an area, click the tool cell in the bottom to collectively specify/

cancel the item that corresponds to the tool cell.
To specify/cancel report items collectively for a group
• Click the header item (“Inst,” “Min,” “Max,” “Ave,” “Sum,” or “Total”).  If any group is

already defined in the Data Monitor window, the “Group Selection” window will
appear, showing a listing of the groups.

• In the “Group Selection” window, click the check box in the “Number” cells to specify/
cancel the settings collectively for the group.

Setting the Contents of Hourly/Daily/Weekly/Monthly Reports
The tags initially displayed in the report settings window are those of the current project's
saved data.
Only valid tags that have already been set through the operations in the sections up to
section 2.8 are displayed.
You cannot set the contents of the reports when the report function is in operation.

Procedure
1. In the menu bar of the “DAQLOGGER Manager” window, select “Others,” “Report,”

and then “Configuration.”
The “DAQLOGGER Report” dialog box appears.

Click to open the “Group Selection” window.

Set the values in the selected range 
to the first value in the selected range.

Specify/Cancel the report item 
in the selected range at once.

Switch tag number/tag 
name display.

2. Click the tab of the type of report you wish to specify to show the tab panel.
The tab panel is common to the settings of hourly, daily, weekly, and monthly reports,
and those items that are not applicable are disabled (appears dimmed).

3. Set the report item.

2.10  Configuring the Report Function
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To set a link between a tag and report item(s)
Click the item cell (“Inst,” “Min,” “Max,” “Ave,” “Sum,” or “Total”) of the tag you wish to
report.  You can select more than one item for a tag.
To set the items collectively for the selected tags, click the tool cell at the bottom of
each item’s column.
To set the items on a group-by-group basis, see the following “To operate the Group
Selection window.”

To operate the Group Selection window
In this window, you can collectively set or clear report items on a group-by-group
basis.
Click the header item (any one from “Inst,” “Min,” “Max,” “Ave,” “Sum,” and “Total”)
you wish to set for the group(s).
The “Group Selection” window appears.

Note
If no group has been defined in the Group Editor or the Data Monitor, you cannot use the

Group Selection window, because no information is displayed.

Check box
Green: A portion of the tags within the group is selected for the report
Blue: All tags within the group are selected for the report
Gray: None of the tags within the group is selected for the report

(Window when the “Max” box is clicked)

Specify/Cancel the report item for 
the groups in the selected range at once.

Switch the group name/group 
number display.

To set the items group-by-group, click the check box in the “Number” cell that
corresponds to the group name and turn it ON (blue).
When you have finished selecting group(s), click “OK.”
A green check box indicates that only a part of the member tags of that group have
been specified to be reported.
To revert the display contents, click “Revert.”
To switch the display between “Group Name” and “Tag Number,” click the tool cell at
the bottom.

2.10  Configuring the Report Function
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If you display “Tag Number” and click the “Position” cell, the pointer moves, and you
can scroll the tag numbers.  By clicking the tool cell button at the bottom, you can
scroll the tag numbers of the selected group.

When the left column is displaying 
tag numbers, drag this knob to 
scroll through the tag numbers.

When the left column is displaying 
tag numbers, click this button to 
scroll the tag numbers one by one.

4. Specify the input source.
Select “Scan” or “Record.”
Scan :  Use the data per scan interval.
Record : Use the data per record interval.

5. Specify the output destination.
Binary:  Outputs the report to a file in binary format (extension: .rbi).  The report can
be viewed using Viewer.
Text:  Outputs the report to a text file in a tab-delimited format (extension: .txt).  The
format is as follows.

The first line: Type, “REPORT,” date of generation, and start time of data scanning or 
recording

 HOURLY REPORT Aug/20/1999 10:00:00 (START=Aug/20/1999 09:58:51)

The second line: Item names

NO TAG UNIT INSTANT MIN MAX AVERAGE SUM TOTAL

The third line and after: Data of individual tags

001 TAG-REC01-01 mV 173.2 -200.0 200.01.25667e+001 8.671000e+002 8.671000e+002

Print: Outputs to the printer specified in the printer setting.  Output format is the same
as that of the “Text.”
A print example is shown below.

Note
The output destination cannot be set only to “Print.”

2.10  Configuring the Report Function
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6. Specify the base time and date.
This is the date and time the reports are created.
Specify the time for hourly reports, date and time for monthly reports, and day and
time for weekly reports.  The time is common to all reports (hourly, daily, weekly, and
monthly reports).

Note
If you specify 29th, 30th, or 31st for the “Base Date” for monthly reports, the date of the report

generation on months that do not have these dates are set to the equivalent dates of 29th,

30th, and 31st as shown in the following example.

Example: If the “Base Date” is set to “31st,” the report for June is created on the following day

of June 30th, which is July 1st (at the base time).  The report for July is created on the data

between July 2nd and July 31st.

7. Specify the time unit of integration (“Sum Unit”)
Click the sum or accumulating total cell and select the unit of integration from the list
box.  The list box shows “None,” “Second,” “Minute,” “Hour,” and “Day.”
If you select the “by calculate” check box in the “Sum Unit” column, the unit of
integration applies to both sum and accumulating total (Changing one unit changes
the other).
If you select the “by Report” check box in the “Sum Unit” column, the selected unit of
integration is set to the unit of integration for the same computation of the same tag
for all types of reports.

Setting the Printer
Set the printer used to print the reports.
Printer setting operation is the same as that of the print command of Windows.

Procedure
1. In the “DAQLOGGER Report” dialog box, click “Print Setup” at the bottom of the

window.
The “Print Setup” dialog box appears.

2. Set the items in the dialog box, and then click “OK.”

Saving the Report Configuration
Save the current settings and terminate configuration.

Procedure
1. In the “DAQLOGGER Report” dialog box, click “OK” at the bottom of the window.

The setting data are saved, and the dialog box closes.

Redisplaying the Current Settings
To cancel the current setting operation and redisplay the setting data before the
operation, do the following.

Procedure
1. In the “DAQLOGGER Report” dialog box, click “Revert” at the bottom of the dialog

box.
The current data settings are discarded and the data before the setting operation are
displayed.

2.10  Configuring the Report Function



2-47IM 04D05C01-62E

C
o

n
fig

u
rin

g
 th

e D
A

Q
L

O
G

G
E

R

2

Report Function
You can print out the report settings.

Procedure
1. In the DAQLOGGER Manager window, choose Other > Report > Print Setting.
2. Enter the settings, then press OK.  The report settings are printed out.  The report

pages for time, day, month, and week must be printed out separately.

Terminating the Report Configuration
Procedure

1. In the “DAQLOGGER Report” dialog box, click “OK” at the bottom of the window.  The
setting are saved, and the dialog box closes.
Click “Cancel” to discard the settings and close the “DAQLOGGER Report” dialog
box.

Starting/Stopping the Report Function
Procedure

Starting the report function
1. In the menu bar of the “DAQLOGGER Manager” window, select “Others,” “Report,”

and then “Start.”  The report function is started.

Stopping the report function
1. In the menu bar of the “DAQLOGGER Manager” window, select “Others,” “Report,”

and then “Stop.”  The report function is stopped.

2.10  Configuring the Report Function
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2.11 Setting Up the DDE Server

Using the DDE server permits data and time that are scanned and recorded by the
logging software to be loaded into client applications, such as EXCEL.  For detailed
information about DDE, refer to a book that is commercially sold.

Starting the DDE Server
Procedure

1. Click “DDE” in the “DAQLOGGER Manager” window.
The DDE Server starts and the “DAQLOGGER DDE” window appears.
If you start the scanning or recording operation in this condition, the updating of the
topic data that are displayed on the “DAQLOGGER DDE” window starts (If the
scanning or recording operation is already started, the data updating starts when the
“DAQLOGGER DDE” window appears).
The number of data points displayed in topic “data” is the maximum number of
channels (1600, 1000, or 400).

Setting Up the DDE Server
Perform the following procedure when you need to change the configuration.

Procedure
1. In the menu bar of the “DAQLOGGER DDE” window, select “DDE Server” and then

“Set Application Name.”
The “Set Application Name” dialog box opens.

Type the application name and click “OK.”
The default application name is “MLDdeSrvr.”

2. In the menu bar of the “DAQLOGGER DDE” window, select “DDE Server” and then
“Update Mode.”
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The “Update Mode” dialog box opens.

Select either of the following and click “OK.”  “Scan Interval” is default.

Scan Interval
Updates data of individual items at the scan interval set in the logging software.
However, the data are updated only during the scanning operation.
Record Interval
Updates data of individual items at the record interval set in the logging software.
The time and data that are displayed are the ones that are actually recorded.
However, the data are updated only during the recording operation.

The intervals mentioned above are set in the “Logger Configuration” dialog box.
For details on how to set these intervals, see section 2.9, “Configuring the Logger.”

Pausing/Terminating the DDE Server
Procedure

1. To pause or resume the DDE Server, perform the following procedure.
In the menu bar of the “DAQLOGGER DDE” window, select “DDE Server” and then
“Pause.”  The updating of the topic data that are displayed in the “DAQLOGGER
DDE” window is paused.  The data updating on the DDE client side is also paused.

To resume the DDE Server, select “DDE Server” and then “Resume” in the menu bar
of the “DAQLOGGER DDE” window.

2. To terminate the DDE Server, perform the following procedure.
From the menu bar of the “DAQLOGGER DDE” window, select “DDE Server” and
then “Exit” or click the “Close” button at the upper right corner of the window.  The
“DAQLOGGER DDE” window closes and the data updating on the DDE client side is
stopped.

2.11  Setting Up the DDE Server
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Preparing the DDE Client
DDE Server uses the following character strings (application name, topic name, and item
name) to provide DDE services so that DDE clients can read the data.

(Changeable)

Topic name

TAG1600 (Scanned or 
recorded data)

(Scanned or 
recorded data)

.................

.................

.................

Item name

 time

no (Data No.)

(Time)

(Date)MLDdeSrvr sdate date

data TAG001 

Application name

Only the application name is changeable and all others are fixed.  The number of data
points is the maximum number of channels (1600, 1000, or 400).
For details on how to specify data in the DDE client, see the instruction manual for the
software program that you are using.
When using EXCEL, enter “=Application name|Topic name!Item name” in the cell.  For
example, to display TAG0001, enter “=MLDdeSrvr|data!TAG0001.”

2.11  Setting Up the DDE Server
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2.12 Setting Up the Monitor Server

The Monitor Server transfers the scanned or recorded data to the remote monitor* that is
connected via the Ethernet network.  Up to 16 remote monitors can be connected.
The remote monitor can be used to display and monitor the received data.

Starting the Monitor Server
Procedure

1. Click “M.SERV” in the “DAQLOGGER Manager” window.
The Monitor Server starts and the “DAQLOGGER Monitor Server” window appears.
The Monitor Server is running when the “DAQLOGGER Monitor Server” window is
displayed.  When a remote monitor connects to the Monitor Server, the host name
and the client name appears in the “DAQLOGGER Monitor Server” window.

(Host Name)

(Client Name)

Setting Up the Monitor Server
To change the port number, perform the following procedure.  The default port number is
“50280.”
The following procedure can be performed while communicating with a remote monitor.
However, the new port number is activated when the Monitor Server is restarted.

Procedure
1. In the “DAQLOGGER Monitor Server” window, select “Port No.” from the “Monitor

Server” menu.
The “Port No.” dialog box opens.
Enter the port number (0 to 65535) and click “OK.”
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Pausing/Terminating the Monitor Server
Procedure

1. To pause or resume the Monitor Server, perform the following procedure.
In the “DAQLOGGER Monitor Server” window, select “Pause” from the “Monitor
Server” menu.  The data updating on the remote monitor side is paused.

To resume the Monitor Server, select “Monitor Server” and then “Resume” in the
menu bar of the “DAQLOGGER Monitor Server” window.  The data updating on the
remote monitor side is resumed.

2. To terminate the Monitor Server, perform the following procedure.
From the menu bar of the “DAQLOGGER Monitor Server” window, select “Monitor
Server” and then “Exit” or click the “Close” button at the upper right corner of the
window.  The communication with the remote monitor is disconnected.

Preparing the Remote Monitor
See chapter 8.

2.12  Setting Up the Monitor Server
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2.13 Setting Up the Control Server

Entering Control Server Settings
The control server forwards each control request that is sent from the remote control
software (see chapter 8) to the manager software.

Procedure
1. Press the C.SERV button in the DAQLOGGER Manager window.

Starts the control server

When using the DAQLOGGER for the first time after installation, the Login Password
window is displayed.

Enter the password to be used for the remote control software.  Enter it again in the
Confirm box, then click OK.  The DAQLOGGER Control Server window appears.

The host name of the PC that will be sending the remote controls may appear in the
Host Name tab.
The following communications history information may appear in the Log tab.  The
newest history and/or selected history are highlighted.

Protect Cancel: Password protection cancelled by the controller.
Protect ERROR: Protect Cancel failed.
Connect ERROR: Connection was cut.
Port Open: The port is open.
Port Close: The port is closed.
Open Error: Open port failed.
Login: Password required.
Host:***: Host [***] is connected.
Logout: Remote controller logged out.
LoginERROR: Remote control login failed.
Scan Start: Recieved scan start command.
Record Start: Recieved record start command.
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2.13 Setting Up the Control Server

Scan Stop: Recieved scan stop command.
Record Stop: Recieved record stop command.
Event Processor Start: Recieved Event Processor start command.
Event Processor Stop: Recieved Event Processor stop command.
User Event: User event sent.

2. Choose Control Server > Port No., and enter the port number to which the remote
control software will connect.  Be sure not to enter settings that overlap with other
applications.

3. To change the login or password, choose Control Server > Login Password.
The Current Login Password dialog box appears.

4. Enter the current password.  A dialog box for entering the new password
appears.

5. Enter the new password.
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Chapter 3 Using Data Monitor

3.1 Displaying Waveforms on the Monitor Window

Data Monitor, the monitor software, displays the measured/computed data that is
currently being collected using the logger software.  Data monitor offers 5 display
formats to display measured data: trend, numeric, meter, alarm, and color graph.

Displaying the Monitor
Procedure

1. In the “DAQLOGGER Manager” window, click the “MONITOR” button.
The “DAQLOGGER Data Monitor” window appears.

Measured data is displayed only during the scanning or recording operation.  If no
measured data is displayed, click the “SCAN” or “RECORD” button in the
“DAQLOGGER Manager” window.

Standard Tool bar

Menu bar

Monitor bar

Status bar

• Even if the scanning operation is started without opening the monitor window, the
measured data is collected.  And when the monitor window is opened, the data
collected up to that point is displayed.

• The scanning operation can also be started after opening the monitor window.  For
the procedures regarding the scanning operation, see section 2.9 “Configuring the
Logger.”

• The trend monitor can display up to 3600 data points.

2. Click the “TREND,” “METER,” “NUMERIC,” “ALARM,” or “COLOR” button on the
monitor bar.
A new monitor window of the clicked button opens.

If Internet Explorer Ver. 4.0 or after is 
installed, a list box is displayed in the 
right of each button.
The list box shows the currently opened 
monitor window(s). If clicked, the 
selected window will be displayed on 
top. If Internet Explorer Ver. 4.0 or later 
is not installed, you can also open these 
listings by clicking the button with the 
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3.1  Displaying Waveforms on the Monitor Window

Note
• You can open multiple monitor windows at the same time, but doing so may lower the PC’s

performance.

• When multiple monitor windows are displayed, the windows can be aligned.  In the menu bar,

select “Window” then “Cascade” or “Tile.”

• For the alarm monitor, a maximum of two windows can be displayed.

Trend Monitor

Link ON/OFF button Display settings

Pause waveform 
display

Save display settings

Alarm display ON/OFF button

Tag number/name display switch button

Zoom in/out of time axis

Waveform display zone buttons

Waveform display limit (clip) button

Cursor value display button

Clicking the 
waveform zone 
bar changes 
the current 
waveform.

Zone bar display
area
Tab for 
adjusting grid 
Tab for 
adjusting the 
brightness of 
the waveform 

Waveform 
display ON/OFF

Display zone

Time (absolute time) or 
elapsed time (relative 

Alarm indicator Click this bar to show or 
hide the display zone 
bars

Drag this bar to adjust the 
width of the waveform 
display area (possible while 
the monitor is in pause 

Red bar start blinking 
when an alarm occurs

Select monitor

Select display group

Trip point 2

Trip point 1

Waveform display area

Auto Grouping

Meter Monitor

Link ON/OFF button Display settings

Pause updating data

Save display settings

Alarm display ON/OFF button

Tag number/name display switch button

Select monitor
Red bar start blinking 
when an alarm occurs

Select display group

Bar meter

Thermometer

Tag number
/name

Analog Meter

Alarm indicator
(Level1, 2, 3, 4 
from the left)

Waveform 
display color

Auto Grouping
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3.1  Displaying Waveforms on the Monitor Window

Numeric Monitor

Link ON/OFF button
Display 
settings

Pause updating data

Save display settings

Alarm display ON/OFF button Tag number/name display switch button

Tag number
/name

Current 
measured 
value with 
respect to 
the scale

 Waveform 
display color

Select monitor

Red bar start blinking 
when an alarm occurs

Select display group
Alarm indicator
(Level1, 2, 3, 4,

from the left)

Auto 
Grouping

Alarm Monitor

Link ON/OFF button Display settings
Pause updatring data

Save display settings

Tag number/name display switch button

Group number

Select monitor

Select display

Alarm indicator
Turns red when an alarm occurs.
A blinking yellow ring is displayed around the lamp when there is an unconfirmed 
alarm.
The alarms are considered to have been confirmed if you click the lamp. At this 

Auto Grouping

For the log display, see “Alarm Monitor” (P. 3-16).
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Color Graph Monitor

Link ON/OFF button Display settings

Pause waveform display

Save display settings

Tag number/name display switch button

Zoom in/out of time axis

Waveform display color

Cursor value display button

Tag number/name

The color of the graph changes with data value along the scale.
Blue (minimum value), light blue, green, yellow, and red (maximum 
value).

Time (absolute time) or 
elapsed time (relative 
time)

Select monitor
Red bar start blinking 
when an alarm occurs

Select display group

Auto Grouping

Arranging the Monitor Window
Procedure

1. Select “Tile” or “Cascade” from the “Window” menu.  The multiple monitor windows
that are displayed are arranged accordingly.

Showing/Hiding the Standard Bar, Monitor Bar, and Status Bar
Procedure

1. From the “View” menu, select the bar you wish to hide.  The check mark in front
disappears and the bar is hidden.  To show the bar, select the command again.

3.1  Displaying Waveforms on the Monitor Window



3-5IM 04D05C01-62E

U
sin

g
 D

ata M
o

n
ito

r

3

3.2 Setting the Display Conditions

In this section, set the display conditions common to all types of monitors, such as scale,
zone, and waveform color.  Also set the meter type for the meter monitor.

Note
In the following descriptions, “Tag Name” will be used to identify tags.  If you wish to display

and use “Tag Number” instead, click the tag number display button in the tool bar.

Basic Operation
To select waveform number(s)
• Click the waveform number (“No.” cell).
• To select waveform numbers in a series, click the first cell, then, pressing the SHIFT

key, click the last cell.
To switch the Use/Not Use of the settings
• Click the check box to switch the Use (blue)/Not Use.
• If waveform numbers are selected in a series, click the tool cell in the bottom to switch

the settings in the selected area at the same time.

To copy the display conditions
This operation is to copy the display conditions of a selected waveform number to
another waveform number.
1. In the “Display Settings” dialog box (see next page), click the “Copy Setting...” button.

The “Copy Setting” dialog box opens.

2. Check the items you wish to copy and click “OK.”
3. Click the “No.” cell of the copy source.
4. Click the “Copy” button.
5. Select the “No.” cell(s) of the copy destination.

To select consecutive numbers, click the first cell then, pressing the SHIFT key, click
the last cell.
When you have finished selecting numbers, click the “Paste” button.
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Automatically Assigning Tags to Groups
The scanned data are displayed by groups.  You can specify the number of tags per
group (up to 32 tags/group), and automatically assign tags up to 50 groups.

Procedure
1. From the “View” menu, select “Auto Grouping.”  The “Automatic Group Setting” dialog

box opens.

2. Enter the number of tags to assign per group in the “Amount of tags/group” box.
3. If necessary, select the “Use current display settings” check box.

If the check box is not selected, all information related to the tags in “Display Settings”
will be initialized.
If the check box is selected, only the tag assignment is changed, all other settings
remain the same.

4. Click “OK” to automatically assign the tags to groups.
The tags that have been set by Tag Editor are assigned to the groups in order from
the first tag.  However, the tags that are assigned are the ones that have recorders
(recorder numbers) and channels (channel numbers) assigned to them and set to
“Use ON.”  Invalid tags (tags that are set to “Use OFF” or the ones that do not have
recorders assigned to them) are skipped.
When the specified number of tags is assigned to a group, the tags are assigned to
the next group.

Note
• The information about group names, tag assignments to groups, and show/hide condition of

tags is also managed by Group Editor.  If you change these settings in the “Display Settings”

dialog box of Data Monitor, they are also changed in Group Editor.

• “Amount of tags/group” and “Use current display settings” are saved even after the dialog box

is closed.

3.2  Setting the Display Conditions
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3.2  Setting the Display Conditions

Setting the Display Conditions for Individual Groups
Waveforms are displayed on a group-by-group basis.  A group can contain up to 12 tags,
and the maximum of 32 groups can be registered.

Procedure
1. Click the “Display Settings” button on the tool bar or, in the menu bar, select “View”

then “Display Settings.”
The “Display Settings” dialog box appears.

Tag to be registered
Bar graph Display scale Turn ON/OFF trip point displayMeter

Y-axis display Group tabThermometer

Meter type

Zone (display position)

Display
color

Turn ON/OFF 
trip point 
displays in the 
selected range

Collectively 
set defaults in 
the selected 

Collectively set the trip 
point in the selected 
range as follows:
Trip1: Max.value of the scale
Trip2: Min.value of the scale

Copy the zone 
settings of the first 
waveform number in 
the selected range to 
all wave waveform 
number in the 

Copy the Y-axis settings of the first 
waveform number in the selected 
area to all wave waveform number in 
the selected range

Collectively turn ON/OFF the 
multiple-Y-axis displays in 
the selected range

Set tags in order from the tag 
name of the first waveform 
number in the selected range

Collectively turn 
ON/OFF the waveform 
displays in the 
selected range.

Turn ON/OFF 
the display Set trip points

Select items 
to copy

Collectively 
set defaults in 
the selected 

Collectively 
set meters in 
the selected 

Copy 
button

Paste button

2. Click the group tab to display the group you wish to set.
This operation switches between the condition setting tab panels for individual groups.

3. In the “Group Name” box, a group name is initially shown in the default format of
“Group+2-digit number.”
To change this default group name, type the name in the “Group Name” box. Up to 16
characters can be entered for a group name.

4. To register/change/delete a member tag of the group, click the “Tag Number” cell you
wish to operate.
The “Tag Name” dialog box appears.
Click the new tag name you wish to assign.  If you wish to assign no tag, click “None”
in the bottom.

Note
This dialog box shows the tag names that are set using the Tag Editor.

After the “Tag Name” dialog box closes, the new setting is shown in the “Display
Settings” dialog box.
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3.2  Setting the Display Conditions

5. Set the ON/OFF of the waveform display.
To display waveform in the graph, click the check box in the “No.” cell to turn it ON
(blue).

6. Set Y-axis display conditions.
Specify the ON/OFF of the Y-axis display when a multiple-axis zone is selected.  Also
specify the scale of Y-axis (linear or logarithmic).

7. Select the type of meter display in the “Meter Type” cell from bar meter, analog meter,
and thermometer.

Note
The meter type setting is valid only for the meter monitor.

8. Click the value in the “Scale” cell and type the scale value.
The selectable range is from -999999999 to 999999999 disregarding the decimal
point.
If you set the minimum value to a larger value than the maximum value, the waveform
will be displayed flipped from top to bottom.

Note
The decimal point positions of the entered values are adjusted for each tag according to the

number of significant digits to the right of the decimal point.

9. Click the value in the “Zone” cell and type the value that specifies the display zone.
The selectable range for minimum and maximum values are from 0 to 99% and from 1
to 100%, respectively.
On the monitor window, waveforms are displayed in zones where the top and bottom
of the waveform display area of the trend monitor correspond to 100% and 0%,
respectively.

10.Click the values in the “Trip 1” and “Trip 2” cells and type the display positions for trip
points 1 and 2.
Click the check box to specify the Use (blue)/ Not Use of the trip point.
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Note
• The trip points can be set within the range of scale values specified for each tag.

• Trip points 1 and 2 are displayed in red and blue, respectively.

• When the trend monitor is stopped, the trip points can be moved by dragging them on the

trend monitor.

• When the display position of a trip point is entered, the check box in the “Trip 1” and “Trip 2”

cells are automatically turned ON (blue).  If you do not wish to display the trip point, click the

check box to turn it OFF.

11.Click the “Color” cell of the tag you wish to change the display color.
The “Color” dialog box opens.

12.Click one of the basic colors you wish to change to.

Note
To create a new color, click the “Define Custom Colors” button.  A palette is displayed in the

dialog box. Create a new color with this palette.

13.Click the “OK” button in the “Color” dialog box.
The waveform is displayed in the new color.

Apply the new settings/Terminate the display setting
14.Click “OK” in the “Display Settings” dialog box.

The new settings are made effective and the “Display Settings” dialog box closes.
Clicking “Apply” will make the new conditions effective, but the window will stay open.
Click [Cancel] to discard the settings and close the dialog box.

Saving the settings
15.In the menu bar of the “DAQLOGGER Data Monitor” window, select “File” and then

“Save Display Settings” or click “Save Display Settings” on the toolbar.  The new
settings are saved.
You can also save the settings when terminating Data Monitor (see sectin 3.6
“Terminating  the Data Monitor”).

Note
The information about group names, tag assignments to groups, and show/hide condition of

tags is also managed by Group Editor.  If you change these settings in Data Monitor, they are

also changed in Group Editor.

3.2  Setting the Display Conditions
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3.3 Changing the Display Settings of Monitor Windows

The display settings of monitor windows can be changed as desired.
This section describes the display settings of monitor windows: trend monitor, alarm
monitor, and color graph monitor windows.

Changes Common to Monitor Windows
Making changes effective in other monitor windows
Changes made to the display settings in a monitor window-such as a change of display
group, switching between tag number display and tag name display, or a change of the
cursor position on the trend monitor window-can be made to other monitor windows by
simply clicking one button.

Procedure
1. Click the “Link” button on the toolbar or, in the menu bar, select “Monitor” then “Link.”

Link button

Switching the display group
The group of measured data that is being displayed can be switched.  If a link is set
between monitored windows, the measured data of that group is also displayed in other
monitor windows.

Procedure
1. Click the “Group” tab in the monitor window.

The measured data of that group is displayed.

Switching tag number/name display
The tag display can be switched between tag numbers and tag names.  If a link is set,
tag number/tag name display is also switched in other monitor windows.

Procedure
1. Click the “Tag Number” button or “Tag Name” button on the toolbar or, from the menu

bar, select “View” then  “Tag Number” or “Tag Name.”

Tag Number / Tag Name buttons

Saving the Settings
The procedure is the same as “Saving the Settings” on the previous page.
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Trend Monitor
Changing the time axis
The time axis notation can be changed between absolute and relative time.  For both
notations, the current zoom factor is shown on the right side of the time axis.  With the
absolute time notation, the date is displayed on the left side.

Procedure
1. From the menu bar, select “TimeAxis” then “Absolute Time” or “Relative Time.”

• Absolute time: Displays the time of the day.
• Relative time: Displays the elapsed time from the start of the scanning

operation.

Absolute time

Relative time

Zooming in/out of the time axis
The time span of the waveform display can be adjusted.

Procedure
1. Click the “Zoom In” or “Zoom Out” button on the toolbar or, from the menu bar, select

“TimeAxis” then “Zoom In” or “Zoom Out.”
The waveform display is expanded or reduced along the time axis (horizontally).

Note
• There are 14 zoom factors: 1/1000, 1/500, 1/200, 1/100, 1/50, 1/20, 1/10, 1/5, 1/2, 1, 2, 5, 10,

and 20 times.

However, the possible minimum zoom factor depends on the number of pixels in the

waveform display area.  Therefore, the minimum zoom factor varies depending on the size of

the monitor window.

• The display of absolute or relative times (example: MM/DD HH or HH: MM: SS) changes

automatically depending on the zoom factor.

Selecting the waveform display zone (Y-axis)
The waveform display can be changed by selecting the zone type.

Procedure
1. Click one of the “Zone” buttons on the toolbar or select the zone type form the

dropdown list of “Y-Axis” in the menu bar.

User Zone Full Zone Auto Zone
Slide Zone Multiple-axis ZoneEdit Zone

3.3  Changing the Display Settings of Monitor Windows
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• User Zone
Waveforms are displayed in the zones set in the “Display Settings” dialog box.
Zones settings cannot be changed in the trend monitor window, but can be
changed in the “Display Settings” dialog box.
For details about settings in the “Display Settings” dialog box, see section 3.2
“Setting the Display Conditions” (P.3-5).

• Edit Zone
Waveforms are displayed in the zones set in the “Display Settings” dialog box.
Zones can be changed in the zone bar display area of the trend monitor window.
In the zone bar display area, change the zone by dragging the control tips in both
ends of the individual zone bars.  The zones changed in the zone bar display area
will be reflected in the “Display Settings” dialog box.  Accordingly, if you switch to
the “User Zone” after changing the zones in the zone bar display area, the
waveforms are displayed using the new zones.

• Full Zone
All waveforms are displayed in full zones.

• Slide Zone
Waveforms are displayed by vertically offsetting the position of each waveform.
Each waveform is displayed with the same zone width.

• Auto Zone
The waveform display area is equally divided according to the number of displayed
waveforms.  The waveform is displayed in each divided zone.

3.3  Changing the Display Settings of Monitor Windows
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• Multiple-axis Zone
Waveforms are displayed in the zones set in the “Display Settings” dialog box
together with multiple Y-axis scales.  The operation to display multiple Y-axis
scales described in the following is possible when the trend monitor’s display
updating is paused.

To add a Y-axis scale:
In the zone bar display area, select the zone bar that you wish to add to the Y-axis
scale and drag it to the waveform display area.
To delete a Y-axis scale:
In the waveform display area, drag the Y-axis scale you wish to delete and drop it
in the zone bar display area.

Drag & drop the Y-axis scale you wish to delete.

Drag & drop the zone bar for which you wish to display a scale.

3.3  Changing the Display Settings of Monitor Windows
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Limiting the display
Set the style in which to display the portion of the waveform that extends off the
waveform display area.

Procedure
1. Click the “Clip” button on the toolbar or, from the menu bar, select “Y-Axis” then “Clip.”

Clip button

The waveform display range along Y-axis is limited to the minimum and maximum
scale values set in the  “Display Settings” dialog box.  The measured values are
displayed so that the values smaller than the minimum scale value attach themselves
to the minimum scale value and those larger than the maximum scale value attach
themselves to the maximum scale value.

• Display example in which the display limit is set

• Display example in which the display limit is not set

Turning ON/OFF the waveform display
To observe a certain waveform more clearly, turn OFF other waveform displays.

Procedure
1. Click the “Waveform display ON/OFF” button of the waveform you wish to turn ON

(blue)/OFF (gray).

Current waveform indicator

Adjust the brightness of the grid

Zone bar

Adjust the brightness of the waveform display area

Waveform display ON/OFF button

3.3  Changing the Display Settings of Monitor Windows
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Specifying the waveform line width

Procedure
1. In the menu bar, click “View” then select “Thin Line,” “Medium Line,” or “Thick Line.”

Adjusting the brightness
The brightness of the grid and background can be adjusted.

Procedure
1. Drag the corresponding brightness control slider located on the right of the zone bar

display area to change the brightness.

Moving the trip points
The trip points can be moved when the monitor is paused.
Turning ON/OFF the trip point display is only possible from the “Display Settings” dialog
box.

Procedure
1. Click the “Pause” button or in the menu bar, select “Monitor” then “Pause.”

The monitor stops updating the display.
2. Drag the trip point to the desired position.

Before dragging After dragging

3.3  Changing the Display Settings of Monitor Windows
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Displaying alarm indication
Alarm conditions are displayed in the bottom of the waveform display area of the trend
monitor window.
If an alarm occurs, a horizontal bar, which increases in size according to the time period
of the alarm duration, is displayed in the color of the waveform that is causing the alarm.
Alarm indicator bars are displayed for level-1, level-2, level-3, and level-4 alarms from
top to bottom.
If more than one alarm occurs at the same time, the indicator bars will be displayed in a
stack with the one for the current waveform (marked with a current waveform indicator)
being displayed on top.

No alarm

Alarm occurrence

Alarm 1
Alarm 2
Alarm 3
Alarm 4

Procedure
1. Click the “Alarm ON/OFF” button on the toolbar or in the menu bar, select “View” then

“Alarm.”
The alarm indication appears or disappears.

Alarm ON/OFF button

Numeric Monitor/Meter Monitor
Displaying alarm indication
Alarm conditions are indicated by the color of the lamp in the numeric monitor and meter
monitor windows.  The lamp is shown in green when no alarm occurs, in red when an
alarm occurs, and in black when no alarm is set in the recorder.  Each window has 4 lamps
that indicate the conditions of level-1, level-2, level-3, and level-4 alarms from left to right.

Procedure
The operation procedures are the same as procedures on the trend monitor.

Alarm Monitor
Switching between the Overview and Alarm Log
The display of the alarm monitor can be switched between Overview and Alarm Log.

Procedure
1. Click the “Overview” or “Log” tab to switch between the two tab panels.

• Overview display
The alarms within a group are displayed in the following 4 conditions.

Green lamp: No tag is causing an alarm among the member tags of the group for
which the waveform display is turned ON or, no alarm is set for the tags.

Red lamp: One of the tags is causing an alarm among the member tags of the
group for which the waveform display is turned ON.

Green lamp with blinking ring:
No alarm is being caused now, and some alarm that occurred in the
past remains unconfirmed.

Red lamp with blinking ring:
An alarm is being caused now, and some alarm that occurred in the
past remains unconfirmed.

3.3  Changing the Display Settings of Monitor Windows
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Note
• The blinking ring displayed around the alarm lamp indicates that there are unconfirmed

alarms (Alarm Hold state).

• To confirm the unconfirmed alarms, click the lamp of the group with a blinking ring. The ring

will disappear.

To cancel the Alarm Hold state of all the tags at a time, select “View” then “Hold Reset” from

the menu bar.

• Displaying the Alarm Log
The alarm types, times of occurrence/termination, and tags are displayed in a list of
alarms that occurred in the past.
The Alarm Log can list for up to 100 alarms when the monitor is paused.
The display format is shown in the following.

Occurrence (On) / termination (Off)

Alarm type character

Tag

Alarm level

Time of occurrence/termination
Alarm type icon

Alarm condition icon

The alarm types are indicated using the following symbols.

Delay upper limit alarm (Red)

PV high-limit (Red)
Deviation high-limit
SP low-limit
Output high-limit

Delay lower limit alarm (Blue)

PV low-limit (Blue)
Deviation low-limit
SP low-limit
Output low-limit

Difference upper limit alarm (Red) Difference lower limit alarm (Blue)

Rate-of-change alarm (+) (Red) Rate-of-change alarm (-) (Blue)

Other alarmDeviation high-limit alarm Deviation high & low limit alarm

Alarm abbreviations are given as follows:
H: PV high-limit alarm
PVH: PV high-limit alarm (high-limit alarm for PV values of the CX control channels)
DVH: Deviation high-limit alarm (only CX)
SPH: SP high-limit alarm (only CX)
OTH: Output high-limit alarm (only CX)

3.3  Changing the Display Settings of Monitor Windows
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L: PV low-limit alarm
PVL: PV low-limit alarm (low-limit alarm for PV values of the CX control channels)
DVL: Deviation low-limit alarm (only CX)
SPL: SP low-limit alarm (only CX)
OTL: Output high-limit alarm (only CX)

dH: Difference upper limit alarm
dL: Difference lower limit alarm
RH: Upper limit on rate-of-change alarm
RL: Lower limit on rate-of-change alarm
tH: Delay upper limit alarm
tL: Delay lower limit alarm
DVO: Deviation high & low limit alarm (only CX)
DVI: Deviation within high & low limit alarm (only CX)
ETC: Other alarms (only CX)

Sounding or stopping the alarm warning sound
An alarm warning can be sounded when an alarm occurs.  The alarm warning is
sounded only when all the following conditions are met.
• The alarm monitor is displayed.
• The alarm sound function is turned ON.
• Of the tags displayed in the monitor, at least one alarm is occurring.

Procedure
1. Show “Alarm Sound” from the “Monitor” menu to see whether a check mark is

displayed.  If the check mark is present, the alarm warning sound is ON; otherwise, it
is OFF.  You can turn ON or OFF the sound by choosing Alarm Sound from the
Monitor menu.

2. To stop the alarm sound, click all the groups in the alarm monitor and choose the
menu command.  Or, choose View > Hold > Reset.

Note
• Once an alarm starts sounding, the sound continues until it is stopped even if all alarms

are cleared.

• A sound source is required in sounding the alarm.

• Up to two windows of alarm monitors can be displayed.  To stop the alarm sound when

two windows of alarm monitors are displayed, the steps taken to stop the alarms must be

performed on both windows.

Color Graph Monitor
The color graph monitor shows the measured data values in color bars.
The display color is determined depending on the data value and the scale.  The
maximum value of the scale is red, the minimum value is blue, and the mid-point value is
green.
Changing the time axis
The time axis notation can be changed between absolute and relative time.  For both
notations, the current zoom factor is shown on the right side of the time axis.  With the
absolute time notation, the current date is displayed on the left side.

Procedure
1. From the menu bar, select “TimeAxis” then “Absolute Time” or “Relative Time.”

• Absolute time: Displays the time of the day.
• Relative time: Displays the elapsed time from the start of the scanning

operation.

3.3  Changing the Display Settings of Monitor Windows
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3.4 Using the Cursors

On the trend monitor and color graph monitor, and color graph monitor the measured
data values at the position specified with the cursor can be displayed.
On the alarm monitor, the measured data values at the start and end points of the area
specified in the alarm log display can be displayed.
There are two types of cursors, cursor A and cursor B. In the “Cursor’s Value” dialog
box, the measured values at cursors A and B and the difference between the two cursors
are displayed.
If the link is turned ON, the cursor movements are reflected on all the trend monitor and
color graph monitor windows that are displayed.

Displaying the Cursors and Reading the Values at the Cursors
Cursor operation is possible while the monitor’s display updating is paused.

Displaying values at cursors on the trend monitor

Procedure
1. To pause the monitor’s display updating, click the “Pause” button on the toolbar, or

from the menu bar, select “Monitor” then “Pause.”

Monitor pause button

Note
The cursors are not displayed while the waveform display is being updated.  To display the

cursors, click the “Pause” button to pause the display.

The cursors disappear when the display updating is resumed.

2. In the waveform display area, click at a desired position and drag to another position.
At the first position, cursor A appears; and at the next position, cursor B appears.

Cursor BCursor A

3. Click the “Cursor’s Value” button on the toolbar or select “View” then “Display Cursor’s
Value” from the menu bar.

Cursor-point value display button 
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3.4  Using the Cursors

The “Cursor’s Value” dialog box appears showing the date and time of measurement
and the measured values at the cursor positions.
To precisely adjust the cursor position, click the “cursor adjustment” button on the
right of the data number.  The cursor moves by one data point at each click.
If the monitor window is used for operation, the results of the operation are reflected to
the “Cursor’s Value” dialog box; and vice-versa.

Cursor adjustment button

Alarm indicatio (Levek1, 2, 3, 4, from the left)
Alarm ON: red
Alarm OFF: green

Displaying cursor’s values with the Alarm Log display

Procedure
1. To pause the monitor’s display updating, click the “Pause” button on the toolbar, or

from the menu bar, select “Monitor” then “Pause.”
2. Click the “Cursor’s Value” button on the toolbar or select “View” then “Display Cursor’s

Value” from the menu bar.
The “Cursor’s Value” dialog box appears.
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3. In the “Log” tab panel (alarm log display) of the alarm monitor, drag the mouse from
one line to another.
The cursor’s values at the start and end points of the selected area are displayed in
the “Cursor’s Value” dialog box.

Values at the start and end points of the selected area are displayed.

Clearing the Cursors
To clear the cursors, perform the operation shown below.
However, cursors will disappear without doing the following operation when the monitor’s
display updating is resumed.

Procedure
1. From the menu bar, select “View” then “Hide Cursor.”

When the cursors are cleared, no data is displayed in the “Cursor’s Value” dialog
box’s table.

Note
The “Cursor’s Value” dialog box disappears when the monitor’s display updating is resumed.

3.4  Using the Cursors



3-22 IM 04D05C01-62E

3.5 Saving the Monitor Window

Snapshot Function
Saves the active monitor window to an image file (PNG format).

Procedure
1. Choose “Snapshot” from the “File” menu.
2. A dialog box appears for you to specify the output file name.  Specify the file name

and click “OK.”

The image file of the active monitor window is saved when the menu command is
selected.  The extension is .png.

Note
To view the image saved to PNG format, an application program that supports image files in

PNG format is required.
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3.6 Pausing and Terminating the Monitor

Pausing the Monitor
This operation pauses the display updating of the monitor.  The measured data is
collected even when the display updating is paused.  Therefore, when the display
updating is resumed, the data measured while the monitor was paused will be displayed.

Procedure
1. Click the “Pause” button on the toolbar or, from the menu bar, select “Monitor” then

“Pause.”
The display updating of the monitor stops.

Monitor pause button

2. To resume the display updating, click the “Pause” button on the toolbar again or, from
the menu bar, select “Monitor” then “Pause.”

Closing the Monitor Windows
The measured data is collected even when the monitor window is closed.  Therefore,
when the monitor window is opened again, the data measured while the monitor window
was closed will be displayed.

Procedure
1. Click the “Close” button in the right upper corner of each monitor window.

The monitor window closes.

Note
To open the monitor window again, click the button of the monitor you wish to display on the

monitor bar.

Terminating the Data Monitor
When terminating the Data Monitor, if the monitor’s display conditions have been
changed, a dialog appears for you to specify whether or not to save the changes. Click
“Yes” or “No” as necessary.

Procedure
1. In the menu bar of the “DAQLOGGER Data Monitor” window, select “File” then “Exit”

or click the “Close” button in the upper right corner of the “DAQLOGGER Data
Monitor” window.
The Data Monitor terminates.
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Chapter 4 Using Historical Viewer

4.1 Displaying Waveforms on the Viewer Window

Historical Viewer, the viewer software, displays the measured data collected using the
logger software in forms of waveform and numerical value.  It also displays the data
created using the report function.
The viewer can display the data in the following data files.
• Data files storing the data collected or being recorded using the logger software (file

extension: .mld)
• Binary report files created using the report function (file extension: .rbi)
• Link file that saves the link condition of the data file (file extension: .lml)

The Data Monitor described in chapter 3 displays data in real time, while the Historical
Viewer displays data saved in a file.

Note
Historical Viewer cannot load data files saved in a floppy disk on the VR, DX, MV, CX, DC, or

DR recorder.

Displaying the Historical Viewer
Procedure

1. Start the Historical Viewer using one of the following methods.
• In the “DAQLOGGER Manager” window, click the “VIEWER” button.
• From the Windows start menu, select “Program,” “DAQLOGGER,” then “Historical

Viewer.”

Note
Data that is being recorded using the logger software can be displayed only when the

Historical Viewer is started from the “DAQLOGGER Manager” window.  Data cannot be

displayed when the viewer is started from the start menu.

The “DAQLOGGER Historical Viewer” window appears.

2. Next, follow one of the procedures in “Opening the saved data file,” “Displaying the
waveform that is being recorded,” or “Displaying the binary report file data.”
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Opening a saved data file
Procedure

1. Click the “Open” button on the toolbar or select “File” then “Open” from the menu bar.
The “Open” dialog box appears.

2. Select the folder and the type of data file (*.mld) you wish to open.
File names are listed in the dialog box.

Note
• Multiple data files can be opened at a time.  The number of files that can be opened at a time

depends on the memory size and free disk space of the personal computer.

• The extensions of the files that can be opened are “.mld” (measured-data file), “.rbi” (binary

report file), and “.lml” (link file).

3. Select the data file from the file list, then click the “Open” button.
The data contained in the file is then displayed as waveforms.

Note
If the file size is large (the number of data points that are recorded is greater than or equal to

8 K and the size is 10 MB or more), the “Select Options” (file loading condition) dialog box

appears for you to decide how to read the file contents.

Select either of the following options and click the “Select” button.  The waveform is displayed.

• If you select “Read data as need (Minimum Memory),” the amount of memory used is

minimized, but the display speed will be slow.

• If you select “Read all data into memory (Fast Update),” all the data is read to memory to

be used for display.  This requires a large amount of memory, yet provides fast display

update speed.

4. To change the data display forms between waveform and numerical display, do the
following:
• Click the “Sheet” button on the toolbar, or select “Window” then “Sheet” from the

menu bar.
• Click the “Graph” button on the toolbar, or select “Window” then “Graph” from the

menu bar.

4.1  Displaying Waveforms on the Viewer Window
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4.1  Displaying Waveforms on the Viewer Window

Graph Viewer

Copy to clipboard

Set marks

Zoom in/out of time axis

Save

Open a file

Display sheetGeneral display settings

Search setting

Display data that is being recorded

Automatic zone setting
Turn ON/OFF the alarm display

Set limit on waveform display (set clip).

Display graph Display cursor values

Overview bar

Alarm indication
(Level1, 2, 3, and 4 
from the left)

Print

Waveform 
displayarea

Drag this bar to adjust 
the width of the waveform 
display area.

Waveform 
display ON/OFF 

Tab for adjusting 
the brightness of 
the waveform 
display area

Clicking a 
waveform zone bar 
changes the 
current waveform.

Click this bar to show or 
hide the zone bars.

Absolute or relative 
time (Time or elapsed 

Select display 
group

Zone bar 
display area

Zone bar

Compute statistics
over the interval 
between the cursors

Tab for adjusting 
grid brightness

Connect 
Previous/Succeeding 
Files

Sheet Viewer

Display sheetDisplay graph

Tag number/name
Display color

Absolute or relative 
time (Time or elapsed 

Trigger mark

Alarm indication (Level1, 2, 3, and 4 from the left)
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Data Overview
When the graph is displayed, pulling down the overview bar displays the data overview.
The data overview displays the loaded data values in color.  When the data value
exceeds the maximum scale, the color is red.  When the data value is less than the
minimum scale, the color is blue.  The colors in between change from red to yellow to
green to light blue to blue.

Overview spreader

Data overview

The waveforms in the section enclosed in the white frame are displayed.
Drag the frame to move the waveform display range.

Displaying the waveform that is being recorded
To display the waveform that is being recorded with the logger software, do the following.

Procedure
1. Click the “Current Data” button on the toolbar or select “View” from the menu bar then

select “Current Data.”
The waveform of the data that is currently being recorded with the logger software is
displayed.

Current data button

Note
• The “Current Data” button is enabled only when the logger software is executing the

recording operation.

• Even when saved data is being displayed (see page 4-2), the data that is currently being

recorded can be displayed by clicking the “Current Data” button.

2. To update the waveform display, click the “Current Data” button again.
The newest measured data is displayed (The data is loaded from a data file).

4.1  Displaying Waveforms on the Viewer Window
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Displaying the binary report file data
Data in a binary report file is displayed in a sheet.

Procedure
1. Carry out the step 1 operation in “Opening a saved data file” (P.4-2) to open the

“Open” dialog box.

2. Select the file type of binary report file (file extension: .rbi) to list the file names.
3. Select the file you wish to open from the file list, then click the “Open” button.

The report data is displayed in a sheet.

Note
You can convert and print the binary report file data, but it cannot be edited.

4.1  Displaying Waveforms on the Viewer Window
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Viewing information about the loaded data file
Information about the loaded data file (data file of the active viewer window) can be
viewed.

Procedure
1. From the menu bar, select “Information” then select “About Document.”

The “File Information” dialog box appears.

2. In this dialog box, you can enter or edit the header that will be used when printing the
data.
Type the print title into the entry box.  Up to 32 characters can be entered.

Note
The print title can also be entered or edited from the “Printout Setup” dialog box.  Changing

the print title here will also change the print title shown in the “Printout Setup” dialog box.

Arranging the Monitor Window
Procedure

1. Select “Tile” or “Cascade” from the “Window” menu.  The multiple monitor windows
that are displayed are arranged accordingly.

Showing/Hiding the Tool Bar and Status Bar
Procedure

1. From the “View” menu, select the bar you wish to hide.  The check mark in front
disappears and the bar is hidden.  To show the bar, select the command again.

4.1  Displaying Waveforms on the Viewer Window
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4.2 Setting the Display Conditions

In this section, we will explain how to set the display conditions of the viewer such as
scale, zone, and waveform color for each tag that was set using the Tag Editor.

Note
In the following descriptions, “Tag Number” will be used to identify tags. If you wish to display

and use “Tag Name” instead, select “View” from the menu bar then select “Tag Name.”

Basic Operation
To select waveform number(s)
• Click the waveform number (“No.” cell).
• To select waveform numbers in a series, click the first cell then, pressing the SHIFT

key, click the last cell.
To switch the Use/Not Use of the settings
• Click the check box to switch between Use (blue) and Not Use.
• If waveform numbers are selected in a series, click the tool cell at the bottom to switch

the settings in a selected area at the same time.
To copy the display conditions

This operation copies the display conditions of a selected waveform number to
another waveform number.

1. In the “General Display Settings” dialog box (see next page), click the “Copy
Setting...” button.
The “Copy Details” dialog box opens.

2. Check the items you wish to copy and click “OK.”
3. Click the “No.” cell of the copy source.
4. Click the “Copy” button.
5. Select the “No.” cell(s) of the copy destination.

To select consecutive numbers, click the first cell then, pressing the SHIFT key, click
the last cell.
When you have finished selecting numbers, click the “Paste” button.
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Setting the Display Conditions for Individual Groups
Data is displayed on a group-by-group basis.  A group can contain up to 32 tags, and a
maximum of 50 groups can be registered.

Operation of the “General Display Settings” dialog box is the same as that of the Data
Monitor’s “Display Settings” dialog box, except that the former dialog box has no meter
type setting and has a “Scale Calc” button.

Procedure
1. Click the “General Display Settings” button on the toolbar or select “View” from the

menu bar then select “General Display Settings.”
The “General Display Settings” dialog box appears.

Tag to be registered

Display scale Turn ON/OFF trip point display

Y-axis display Group tabZone (display position)

Display
color

Turn ON/OFF trip 
point displays in the 
selected range

Collectively set 
defaults in the 
selected range

Copy the parameter of the 
first waveform number in 
the selected area to all wave 
waveform number in the s
elected range

Collectively turn ON/OFF the 
multiple-Y-axis displays in 
the selected range

Set tags in order from the tag 
number of the first waveform 
number in the selected range

Collectively turn 
ON/OFF the waveform 
displays in the 
selected range.

Turn ON/OFF 
the display Set trip points

Select items 
to copy

Copy
button

Paste button

Collectively set the trip 
point in the selected 
range as follows:
Trip1: Max.value of the scale
Trip2: Min.value of the scale

2. Click the group tab to display the group you wish to set.
This operation switches between the condition setting tab panels for individual groups.

3. In the “Group Name” box, the group name that was set on the Data Monitor is
displayed.
To change this group name, type the name in the “Group Name” box. Up to 16
characters can be entered.

4. To register/change/delete a member tag of the group, click the “Tag Number” cell you
wish to operate.
The “Tag Number” dialog box appears.

4.2  Setting the Display Conditions
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Note
This dialog box shows the tag numbers of the tags that are set using the Tag Editor.

• Click the new tag name you wish to assign.

• If you do not wish to assign a tag, click the “None” at the bottom.

After the “Tag Name” dialog box is closed, the new settings will appear in the “General
Display Settings” dialog box.

5. Set the ON/OFF of the waveform display.
Click the check boxes in the “No.” cells for the tags you wish to display in the graph to
turn them ON (blue).

6. Set Y-axis display conditions.
Specify the ON/OFF of the Y-axis display when a multiple-axis zone is selected.  Also
specify the scale of Y-axis (linear or logarithmic).

7. Click the value in the “Scale” cell and type the scale value.
The selectable range is from -999999999 to 999999999 disregarding the decimal
point.
If you set the minimum value larger than the maximum value, the waveform will be
displayed flipped from top to bottom.

Note
The decimal point positions of the entered values are adjusted for each tag according to

the number of significant digits to the right of the decimal point.

Clicking the “Scale Calc” button automatically sets the minimum/maximum scale
values to the minimum/maximum values of the corresponding tag’s data.

8. Click the value in the “Zone” cell and type the value with which to display the zone.
The selectable range for minimum and maximum values are from 0 to 99% and from 1
to 100%, respectively.
Waveforms are displayed in zones where the top and bottom of the waveform display
area correspond to 100% and 0%, respectively.

9. Click the values in the “Trip 1” and “Trip 2” cells and type the display positions for trip
points 1 and 2.
Click the check boxes to specify the Use (blue) or Not Use of the trip points.

4.2  Setting the Display Conditions
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Note
• The trip points can be set within the range of scale values specified for each tag.

• Trip points 1 and 2 are displayed in red and blue, respectively.

• The trip points can be moved by dragging them to the graph viewer.

• When the display position of a trip point is entered, the check box in the “Trip 1” or “Trip 2”

cells is automatically turned ON (blue).  If you do not wish to display the trip point, click the

check box to turn it OFF.

10. Click the “Color” cell of the tag you wish to change the display color.
The “Color” dialog box appears.

11. Click one of the basic colors you wish to change to.

Note
To create a new color, click the “Define Custom Colors” button.  A palette is displayed in the

dialog box. Use this palette to create a new color.

12. Click the “OK” button in the “Color” dialog box.
The waveform is displayed in the new color.

13. In the “General Display Settings” dialog box, click the “OK” button.
The new conditions are made effective and the “General Display Settings” dialog box
closes.

4.2  Setting the Display Conditions
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4.3 Changing the Viewer Window

The display of the viewer window can be changed as desired.
This section describes how the display on the graph viewer can be changed.

The graph viewer window is similar to the trend monitor window, except that the graph
viewer has a zone bar display area in the left part of the window and the line width of the
waveform cannot be changed.

Changing the time axis
The time axis notation can be changed between absolute and relative time. For both
notations, the current zoom factor is shown on the right side of the time axis.  With the
absolute time notation, the date is displayed on the left side.

The measured/computed data copied to the clipboard have the time notation as set here.

Procedure
1. From the menu bar, select “Time Axis” then select “Absolute Time” or “Relative Time.”

• Absolute time: Displays the time of the day.
• Relative time: Displays the time elapsed since the first data.

Absolute time

Relative time

Zooming in/out of the time axis
The time span of the waveform display area can be adjusted.

Procedure
1. Click the “Zoom In” or “Zoom Out” button on the toolbar or select “Time Axis” from the

menu bar then select “Zoom In” or “Zoom Out.”
The waveform display is expanded or reduced along the time axis (horizontally).

Note
• There are 14 zoom factors: 1/1000, 1/500, 1/200, 1/100, 1/50, 1/20, 1/10, 1/5, 1/2, 1, 2, 5, 10,

and 20 times.

However, the possible minimum zoom factor depends on the number of pixels in the

waveform display area.  Therefore, the minimum zoom factor varies depending on the size of

the viewer window.

• The display of absolute or relative times (example: MM/DD HH:MM or HH:MM:SS) changes

automatically depending on the zoom factor.

Another way of zooming in or out is to select “Time Axis” from the menu bar and then
select “Set Scale.”
The “Time Axis Scale” dialog box appears.
The time axis can be expanded and reduced arbitrarily by the zoom factor specified in
the entry box.
• Range of zoom-in factor: 1 to 20 times (positive whole number)
• Range of zoom-out factor: 1/1 to 1/1000 times (the denominator is a positive

whole number)

Selecting “TimeAxis” from the menu bar then selecting “All” displays the entire waveform
by automatically adjusting the zoom factor.
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Selecting the Y-axis waveform display zone
The waveform display format can be changed by selecting the zone type.

Procedure
1. Click one of the “Zone” buttons on the toolbar or select the zone type form the

dropdown list of “Y-Axis” in the menu bar.

User Zone Auto Zone

Edit Zone Slide Zone

Full Zone

Multiple-axis Zone

• User Zone
Waveforms are displayed in the zones set in the “General Display Settings” dialog
box.
The zones cannot be changed in the viewer window.  Changing the zone settings
is possible in the “General Display Settings” dialog box or in the Edit Zone mode,
which will be described next.
For details on setting the “General Display Settings” dialog box, see section 4.2
“Setting the Display Conditions.”

• Edit Zone
Waveforms are displayed in the zones set in the “General Display Settings” dialog
box.
The zones can be changed from the zone bar display area in the viewer window.
In the zone bar display area, change the zone by dragging the control tabs from
both ends of the individual zone bars.  The zones changed in the zone bar display
area will be reflected in the “General Display Settings” dialog box.  Accordingly, if
you switch to the “User Zone” after changing the zones in the zone bar display
area, the waveforms are displayed with the new zones.

Dragging the “top tab” moves the zone’s upper limit.  Similarly, dragging the
“bottom tab” moves the zone’s lower limit.  Dragging the zone bar moves the entire
zone.

Current waveform (active waveform)
Top tab

Bottom tab

Zone bar

• Full Zone
All waveforms are displayed in full zones.

4.3  Changing the Viewer Window
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• Slide Zone
Waveforms are displayed by vertically offsetting the position of each waveform.
Each waveform is displayed in the same zone width.

• Auto Zone
The waveform display area is equally divided according to the number of displayed
waveforms.  Waveforms are displayed in each divided zone.

• Multiple-axis Zone
Waveforms are displayed in the zones set in the “General Display Settings” dialog
box together with multiple Y-axis scales.  Setting for multiple Y-axis display is
possible in the graph viewer window as well as in the “General Display Settings”
dialog box.

To add a Y-axis scale: In the zone bar display area, drag the zone bar for
which you wish to display Y-axis scale and drop it in
the waveform display area.

To delete a Y-axis scale: In the waveform display area, drag the Y-axis scale
you wish to delete and drop it in the zone bar display
area.

Drag & drop the scale you wish to delete.

Drag & drop the zone bar for 
which you wish to display a 
scale.

4.3  Changing the Viewer Window
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Note
Displayed trip points and grid are those for the Y-axis scale displayed in the most right of the

Y-axis display area.

Limiting the display
Set the style in which to display the portion of the waveform that extends off the
waveform display area.

Procedure
1. Click the “Clip” button on the toolbar or select “Y-Axis” from the menu bar then select

“Clip.”

Clip button

The waveform display range along Y-axis is limited to the minimum and maximum
scale values set in the  “General Display Settings” dialog box.  The measured values
are displayed so that the values smaller than the minimum scale value attach
themselves to the minimum scale value and those larger than the maximum scale
value attach themselves to the maximum scale value.

• Display example in which the display limit is set

• Display example in which the display limit is not set

Turning ON/OFF the waveform display
To observe a certain waveform more clearly, turn OFF other waveform displays.

Procedure
1. Click the “Waveform display ON/OFF” button of the waveform you wish to turn ON

(blue)/OFF (gray).
(The buttons are located under the corresponding zone bars.)

4.3  Changing the Viewer Window
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Adjusting the brightness
The brightness of the grid and background can be adjusted.

Procedure
1. Drag the corresponding brightness control slider located on the left of the zone bar

display area to change the brightness.

Moving the trip points
Turning ON/OFF the trip point display is only possible from the “General Display
Settings” dialog box.

Procedure
1. As necessary, drag the trip point to the desired position.

Before dragging After dragging

4.3  Changing the Viewer Window
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Displaying alarm indication
The conditions of the measured data alarms set in the recorder can be displayed in the
viewer window.

Procedure
1. Click the “Alarm” button on the toolbar or select “View” from the menu bar then select

“Alarm.”
The alarm conditions of the waveform data in the active viewer window are displayed
in the graph viewer and sheet viewer windows and the “Control” dialog box.  However,
if the loaded data file contains no alarm data, the alarm indication will not be displayed.

• Graph viewer window
In the graph viewer window, the alarm indication is displayed in the color of the
waveform that is causing the alarm.  If more than one alarm occurs at the same time,
the indication will be displayed in a stack with the one for the current waveform (active
waveform) displayed on top.

Alarm indication

Level 1
Level 2
Level 3
Level 4

• Sheet viewer window

Alarm indication

Level 1   Level 2   Level 3   Level 4

• “Control” dialog box

Alarm indication
(Level1, 2, 3, and 4 from the left)

Note
• Turning ON/OFF the alarm indication display in one of the windows above will also turn ON/

OFF the display in other windows.
• If the loaded data file contains no alarm data, the “Alarm” in the “View” menu is displayed in

gray and cannot be selected.

4.3  Changing the Viewer Window
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4.4 Using the Cursors

On the graph viewer, the measured data values at the position specified with the cursor
can be displayed.
There are two types of cursors, cursor A and cursor B.  The measured data values at
cursors A and B and the results of statistical computations between the two cursor points
can be displayed.

Displaying the Cursors and Reading the Values at the Cursors
Procedure

1. In the waveform display area of the graph viewer, point the position at which to read
the measured data values and drag to the next position.  The first position is cursor A,
and the position dragged to is cursor B.

Cursor A Cursor B

2. Click the “Control” button on the toolbar.

Control button

The “Control” dialog box appears showing the date and time of measurement and the
measured values at the cursor positions.
To precisely adjust the cursor position, click the “cursor adjustment” button on the
right of the data number.  The cursor moves by one data point at each click.
Changes to cursor movements in either one of the graph viewer or sheet viewer
windows or the “Control” dialog box window will also change the cursor positions and
display values in the other windows.
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The cursors can be shifted by 
pressing one of these buttons

Clearing the Cursors
To clear the cursors, perform the operation shown below.

Procedure
1. From the menu bar, select “View” then “Erase Cursor.”

When the cursors are cleared, no data is displayed in the “Control” dialog box’s table.

4.4  Using the Cursors
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Copying Measured Data between the Cursors to the Clipboard
The measured data between the cursors can be copied to the clipboard and used in
other applications.

Procedure
1. Select the area (1000 data points at maximum) on the graph or sheet viewer window

you wish to copy to the clipboard by dragging and dropping the cursor.
2. Click the “Copy” button on the toolbar or select “Edit” from the menu bar then select

“Copy.”
The measured data is copied to the Windows clipboard.

Copy button

3. The measured data copied to the clipboard can be pasted into other applications.

• Example of Copying to the Clipboard

Note
• A maximum of 1000 data points can be copied to the clipboard.

• In addition to the measured data, all the information registered in the selected group -

channels, tag numbers, and tag names - will be copied to the clipboard.

• The time information copied to the clipboard differs depending on the display mode of the

time axis.  For the absolute time mode, the time of the day and for the relative time mode, the

relative time from the first data.

4.4  Using the Cursors
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Displaying the Results of Statistical Computation
The statistics are calculated over the data between cursors A and B, and the results are
displayed.
The statistics have the following 5 types of values: minimum, maximum, P-P, mean, and
RMS.

Procedure
1. In the graph or sheet viewer window, select the interval over which the statistics will

be computed by dragging and dropping the cursor.  The position pointed to first is
cursor A, and the position where the point is dragged to is cursor B.

2. Click the “Statistics” button on the toolbar or select “Window” from the menu bar then
select “Statistics.”

Statistics button

The results are displayed in the “Statistics” dialog box.

Data range over which the statistics are culculated.

Note
• If you change the computation conditions such as the computation interval (Section), carry

out the steps above again to compute the statistics.

• The “Statistics” dialog box displays the tag names or tag numbers shown in the active viewer

window, regardless of whether the waveform display is turned ON or OFF.

• If the computation interval is not specified, the statistics are computed over the interval

between the first and the last data.

4.4  Using the Cursors
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4.5 Using Marks

Marks can be placed on the time axis at the positions specified with the cursor.  The
marks are displayed above the waveform on the graph viewer, and to the left on the
sheet viewer.
By default (reset condition), the following marks are placed.
TRIG: Data at the time the recording operation was started (first data point of the file) by
the logging software.
BOUNDARY: Data at the division point when the recorded data are stored to divided files
by the logging software (first data point of files after the 1st file) and the first data point of
the file that is created by data exporting (see section 4.7).

Placing a Mark
Procedure

1. In the graph viewer window, click the position where you wish to place a mark or in
the sheet viewer window, click the “Date [No.]” cell to which you wish to place a mark.
Cursor A is displayed. Cursor B is not created.

2. Click the “Append Mark” button on the toolbar or select “Edit” from the menu bar then
select “Append Mark.”

Append mark button

3. The “Mark Setting” dialog box appears.  Type the mark character string in the entry
box. Up to 16 characters can be entered.

4. Click the “OK” button.
The mark character string is displayed at the cursor position.

Note
• To change the mark character string, double-click the mark you wish to change.

• A mark cannot be placed unless the cursors A and B positions match.

Deleting a Mark
Procedure

1. In the graph or sheet viewer window, select the area where you wish to delete marks
using the cursors A and B.

2. From the menu bar, select “Edit” then select “Delete Mark.”
The marks in the specified area are deleted.
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Resetting the Mark Display
The reset condition is a condition in which only the “TRIG” or “BOUNDARY” marks are
placed.

Procedure
1. From the menu bar, select “Edit” then select “Reset Mark.”

All the marks are cleared.

4.5  Using Marks
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4.6 Searching Measured/Computed Data, Alarms,
and Marks

You can set conditions and search for measured/computed data, alarms, and marks.

Searching Measured/Computed Data, Alarms, and Marks
You can search data that match the specified conditions and position the cursor there.
The search range is the range specified by the cursors.  If there are no cursors
displayed, the search is carried out over the entire range.  If there is one cursor
displayed, the search is carried out from the cursor position to the end of the data.
When the specified data are found, the range containing the data is displayed, and the
cursor is placed at the data position.  If the display of the waveform containing the data
was set to “OFF,” it is changed to “ON.”

Procedure
1. In the graph viewer or sheet viewer, select the range to be searched using cursors.
2. From the “Edit” menu, select “Search.”  You can also click “Search Settings” on the

toolbar.  The “Search” dialog box opens.

Group name button

Tag button

3. You can set two search conditions in the search function.  Specify whether to take the
OR or AND of the two conditions.  Click the cell and select OR or AND from the list
box.
OR: When either of the two conditions is met.
AND: When both conditions are met.

Repeat steps 4 to 8 to set conditions 1 and 2.
4. Set the search type.  Click the cell and select the type from the list box.

None: Set no conditions.
Data: Search abnormal data (LACK, +OVER, -OVER, and OFF, see step 7)
Mark: Search marks.
Alarm: Search alarms.
Value: Search measured/computed data values.
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Searching Measured/Computed Data
5. Select the groups to be searched.

Click the group name button to display the “Select Group” dialog box.  Then, select
the group.  Click “ALL” to select all groups.

6. Select the tags to be searched.
Click the tag button to display the “Tag Number” or “Tag Name” dialog box.  Tags that
are contained in the groups that were selected in step 5 are displayed.  Select the
tags.  Click “ALL” to select all tags in the specified group.

7. Set the data type to be searched.
Click the cell and select the data type from the list box.
LACK: Search for data dropouts.
+OVER: Search measured/computed data that are over the upper limit.
-OVER: Search measured/computed data that are below the lower limit.
OFF: Search for OFF data.*
* OFF data refers to recorded data when the communication between the recorder and the

DAQLOGGER fails.

Searching Marks
5. Select the group to search.

The operating procedure is the same as for “Searching Measured/Computed Data.”
6. Set the mark string.

Marks containing the specified string in their name are searched.  The search is not
case-sensitive.  If you specify only an asterisk, all marks are searched.

Searching Alarms
5. Select the group to search.

The operating procedure is the same as for “Searching Measured/Computed Data.”
6. Select the tags to search.

The operating procedure is the same as for “Searching Measured/Computed Data.”

4.6  Searching Measured/Computed Data, Alarms, and Marks
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7. Select the alarm type.
Click the cell and select the alarm type from the list box.
Alarm All: Search all alarms.
Alarm 1, Alarm 2, Alarm 3, or Alarm 4: Search for the specified Alarm No. (alarm
level).

8. Set the alarm condition to be searched.
Click the cell and select the alarm condition from the list box.
Changed: Data position where the alarm changed from ON to OFF or OFF to ON.
Start: Data position where the alarm ON condition started.
End: Data position where the alarm ON condition ended (data position immediately
before the alarm turned OFF).
ON: Data position where the alarm is ON.
OFF: Data position where the alarm is OFF.

Searching Data Values
5. Select the group to search.

The operating procedure is the same as for “Searching Measured/Computed Data.”
6. Select the tags to search.

The operating procedure is the same as for “Searching Measured/Computed Data.”
7. Set the type of comparison.  The comparison value is set in step 8.

Click the cell and select the type of comparison from the list box.
==: Search data that are equal to the comparison value.
>: Search data that are greater than the comparison value.
<: Search data that are less than the comparison value.
>=: Search data that are greater than or equal to the comparison value.
<=: Search data that are less than or equal to the comparison value.
!=: Search data that are not equal to the comparison value.

8. Set the comparison value.
Click the cell and enter the value.
The range of values is from -9999999999 to 9999999999.  You can also use
exponential notation (example: 32E+5).

Search Direction
9. Select “Opposite” (reverse direction) or “Sequence” (forward direction) using the

option button.  The search direction depends on the number of cursors that are
displayed and the “Opposite” or “Sequence” setting as follows:

Number of Cursors Displayed Opposite/Sequence Search Direction

None Sequence From the first data point to the last
data point.

Opposite From the last data point to the first
data point.

1 Sequence From the cursor position to the last
(A and B are at the same position) data point.

Opposite From the cursor position to the first
data point.

2 Sequence From cursor A to cursor B
(A is in front of B on the time axis) Opposite From cursor B to cursor A

4.6  Searching Measured/Computed Data, Alarms, and Marks
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10.Specify the cursor to be displayed at the data position that matched the search
conditions.  Specify Cursor A, Cursor B, or Cursor A and B.

11.Click “Run” to execute the search, and the cursor is displayed at the data position that
matched the search conditions.  The search result (group number, waveform number,
and data number) is displayed at the bottom section of the dialog box.
If you click “Run” again, the cursor is displayed at the next data position that matched
the search conditions, and the search result is displayed at the bottom section of the
dialog box.
If there are no data that match the search conditions, “Not Found” is displayed at the
bottom section of the dialog box.

12.Click “Close” to close the “Search” dialog box.

Example of an alarm search
The procedure for moving the cursor to the point where alarm level 1 changed within the
range specified by the cursors for Group 1 and Tag No. TAG0005 is described below.
1. Display the waveform of Group 1 and specify a range using the cursors.
2. Click “Search” on the toolbar.  The “Search” dialog box opens.
3. Set the search conditions as follows.

OR/AND: You do not have to change this, because only one condition will be
specified.
Search Type: “Alarm”
Group: “Group01”
Tag: “TAG0005”
Alarm Level: “Alarm 1”
Alarm Condition: “Point of Change”
2nd Condition: “None”

4. Set the search direction equal to the progression of time.
Click the “Sequence” option button.

5. Place cursor A at the search result.
Cursor Positioning: Select the cursor A check box.

6. Click “Run” to execute the search.  Cursor A is displayed at the data position where
the alarm changed.  Data at the cursor position can be read.

7. Click “Run” to execute the search again.  Cursor A is displayed at the next data
position where the alarm (that matches the conditions) changed.

The first search result
(cursor A)

Position of cursor A when 
the search range is specified

Position of cursor B

Alarm 1

Click “Run” to move cursor A to 
the next point of the search result.Waveform of TAG0005

4.6  Searching Measured/Computed Data, Alarms, and Marks
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4.7 Converting Data Formats

The measured data and report data can be converted to ASCII, Lotus 1-2-3, and MS-
Excel data formats.
The file extensions for the data files in each format are as follows.
• ASCII: .txt
• Lotus 1-2-3: .wrk
• MS-Excel: .xls

Procedure
1. From the “Convert” menu, select “To ASCII,” “To Lotus,” or “To Excel.”

The dialog box for the selected data conversion appears.
2. For measured data, enter the range of data to be converted (the data numbers of the

start and end points of the data) and the number of data points in a step.
To convert all the data in the specified range, set the “Step” to 1.

3. For measured data, specify the data to be converted in terms of groups, click the
“Group” radio button and enter the start and end group numbers in the entry boxes.

To specify the data to be converted in terms of tag numbers, click the “Tag” radio
button then click the tag number button.
A dialog box for selecting tag numbers appears.  Click the desired tag number.

4. To change the destination folder or the file name, select “File” from the menu bar.
The “Change the file name” dialog box appears.
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5. Select the folder and file type, and type the file name.
6. Click the “OK” button.

The measured data is converted to the selected format and saved in a file.

File Format of the Converted Measured Data
The file format for Lotus 1-2-3, MS-Excel, and ASCII are shown below.

Lotus 1-2-3 File Format

MS-Excel File Format

ASCII File Format

Title

Date and time of the first data collected

Date and time of the last collected data

Data collection interval

Number of data points

Group

Tag number

Tag name

Unit

Date format

Time of data collection and measured data
(Repeats by the number of data points)

CR

CR

CR

CR

CR

CR

CR

CR

CR

CR

CR

LF

LF

LF

LF

LF

LF

LF

LF

LF

LF

LF

4.7  Converting Data Formats
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Title

1

"

2

D

3

A

4

Q

5

L

6

O

7

G

8

G

9

E

10

R

11 12 13

(

14 15

6

16

.

17

0

18

1

19

)

20

21 22

 

23 24

o

25

f

26

t

27

w

28

a

29

r

30

 e

31 32

I

33

D

34 35

1

36

2

37

3

38

-

39

4 

40

5

41

6

42

7 

43 44

8

45

" CR 

R4.01 is the software version number.  The software is the serial number.

R

S

46

LF

Date and time of the first collected data

1

"

2

S

3

t

4

a

5

r

6

t

7 8

T

9

I

10

m

11

e

12

"

13

,

14

"

15

1

16

9

17

9

18

8

19

-

20

0

21

3

22

-

23

3

24

1

25 26

0

27

1

28

:

29

0

30

2

31

:

32

0

33

0

34

.

35

0

36

"

37

CR

38

LF

Date and time of the last collected data

1

"

2

E

3

n

4

d

5 6 7 8

T

9

i

10

m

11

e

12

"

13

,

14

"

15

1

16

9

17

9

18

8

19

-

20

0

21

3

22

-

23

3

24

1

25 26

2

27

3

28

:

29

5

30

9

31

:

32

5

33

9

34

.

35

0

36

"

37

CR

38

LF

Data collection interval

1

"

2

S

3

a

4

m

5

p

6

l

7

e

8 9

R

10

a

11

t

12

e

13

 

14

(

15

S

16

e

17

c

18

)

19

"

20

,

21

Example: 60 seconds (the upper line), 1 second (the lower line)

22 23 24 25 26 27 28

Data collection interval

29 30 31

CR

32

LF

21 22 23 24 25 26 27 28 29 30

6 0 . 0

1 . 0

4.7  Converting Data Formats
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Number of data points

1

"

2

D

3

a

4

t

5

a

6 7

C

8

o

9

u

10

n

11

t

12

"

13

 ,

14

Number of data points

15 16 17 18 19 20

21

Example: 100 data points (the upper line), 120000 data points (the lower line)

22 23 24 25

CR LF

15 16 17 18 19 20 21 22 23

1 2 0 0 0 0

1 0 0

Group

1

If the data was specified in terms of groups, the range of the groups are set.
If the data was specified in terms of tags, the field for the range of groups is filled with blanks.

"

2

G

3

r

4

o

5

u

6

p

7

"

8

,

9

"

10

0

11

2

12

-

13

1

14

0

15

"

Tag number

1

"

2

T

3

A

4

G

5 6

N

7

o

8

.

9

"

10

, ,

11 12 13

11

"

12 13

A G 0 0

" A G 0 0

" A

T

T

T G 1 6

14 15 16

0

0

0

17

1

2

0

18

14 15 16 17 18 19 20

21 22 23 24 25 26 27 28 29 30

, . . . . . . . .

?

CR

?

LF

"

"

"

19

The length of a tag number is fixed to 9 characters, including the double quotation marks that 
enclose each tag number. So, tag numbers cannot be longer than 7 characters.

Examples:

Tag number

Tag number

4.7  Converting Data Formats
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Tag name

1

"

2

T

3

a

4

g

5 6

N a m e " ,

7 8 9 10 11

Tag name

12 13 14 15 16 17 18 19 20

12

" "

13

T

14

A

15

G

16

0

17

0 0 1

18 19 20 21 22 23 24 25 26 27 28 29

21

Example: when the tag name is TAG0001

22 23 24 25 26 27 28 29

. . . . . . . . .

?

CR

?

LF

The length of a tag name is fixed to 18 characters, including the double quotation marks that enclose each tag 
name. For tag names shorter than 16 characters, blanks are appended. Tag names cannot be longer than 16 
characters.

Unit

1

"

2

U

3

n

4

i

5

t

6

" , ," " "Data unit

7 8 9 10 11 12 13 14 15 16 17 18 19 20

8

" "

9

V

10 11 12 13 14 15

21 22 23 24 25

" , . . . . . . . . . . .

?

CR

?

LF

The length of a tag name is fixed to 8 characters, including the double quotation marks that enclose 
each unit. For units shorter than 6 characters, blanks are appended. Units cannot be longer than 6 
characters. If no unit is specified, the filed is filled with blanks.

Example: when the unit is V

Date format

1

"

2

Y

3

Y

4

Y

5

Y

6

- M M - D D

7 8 9 10 11 12 13 14 15

H H : m m : SS

16 17 18 19 20

1

"

2

D

3

D

4

D

5 6

H H : m m :

7 8 9 10 11 12 13 14 15

S S . S "

16

For relative time

For absolute time

21 22

. S

23

"

4.7  Converting Data Formats
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Time of data collection and measured data

1

"

2

Y

3

Y

4

Y

5

Y

6

- M M - D D

7 8 9 10 11 12 13 14 15

H H : m m : SS

16 17 18 19 20

21

.

22

S

23

"

24

,

25 26

Measured value

27 28 29 30 31 32 33 34 35

, Measured value

36 37 38 39 40

1

"

2

1

3

9

4

9

5

8

6

- 0 3 - 3 1

7 8 9 10 11 12 13 14 15

1 0 : 3 0 : 01

16 17 18 19 20

21

.

22

0

23

"

24

,

41 42 43 44

, . . . . . . . . . . . . . . LFCR

? ?

1

"

2

D

3

D

4

D

5 6

H H : m m :

7 8 9 10 11 12 13 14 15

S S . S " ,

16 17 18 19 20

21

Measured value

22

Measured value

23 24 25 26

Measured value

27 28 29 30 31 32 33 34 35 36 37

, ,

38 39 40

41 42 43 44 45 46 47

, . . . . . . . . . . . LFCR

? ?

For relative time

1

"

2

0

3

0

4

3

5 6

1 0 : 3 0 :

7 8 9 10 11 12 13 14 15

1 0 . 5 "

16

Example of absolute time: for 1998/3/31 10:30:10

25 26 27 28 29

1

30

0 . 1 2 ,

31 32 33 34

1 2 0 0 . 0 ,

Example of measured data value:

For absolute time

The length of absolute time is fixed to 23 characters. The length of relative time is fixed to 16 characters. The 
length of a measured value is fixed to 9 characters.

Example of absolute time: for 1998/3/31 10:30:10

4.7  Converting Data Formats
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File Format of the Converted Report Data
The file format for Lotus 1-2-3, MS-Excel, and ASCII are shown below.

Lotus 1-2-3 File Format
MS-Excel File Format
Converting ASCII data to this format allows the data to be displayed in cells.
ASCII File Format
A text file delimited with tabs.
The format is the same as the text file generated by Report Generator

The first line: Type, “REPORT,” date of generation, and start time of data collection

HOURLY REPORT Aug/20/1999 10:00:00 (START=Aug/20/1999 09:58:51)

The second line: Item names

NO TAG UNIT INSTANT MIN MAX AVERAGE SUM TOTAL

The third line and after: Data of individual tags

001 TAG-REC01-01 mV 173.2 -200.0 200.0 1.25667e+001 8.671000e+002 8.671000e+002

4.7  Converting Data Formats
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4.8 Exporting Data

You can cut out (copy) a section of a data file and save the result.  This operation does
not change the original data.

Procedure
1. Select the range of data to be cut out using the cursors.
2. From the “Convert” menu, select “Export.”

The “Export” dialog box appears.

3. The range that was selected by the cursors are indicated in the “Start” and “End”
boxes using data numbers.
To change the data range to be exported, enter values in the appropriate boxes.

4. Click “File” to display the “Change the file name” dialog box.  Change the file name
and destination as necessary and click “OK.”

Note
• The default file name is as follows:

“Original file name”-“first data number (8 digits) of the range to be exported”.mld

• You cannot export data from report data.

5. Click “OK” to create the file and close the dialog box.  Click “Cancel” to close the
dialog box without creating the file.
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4.9 Printing Data

The measured data and report data displayed in the viewer can be output to a printer
connected to a personal computer.

Setting the Printer
The printer is set with the same operation as the Windows Print command.

Procedure
1. From the menu bar, select “File” then select “Printer Setup.”

The “Print Setup” dialog box appears.
2. Set the print items in the dialog box and click “OK.”

Note
Set the printer in accordance with your system environment.

Previewing before Printing
Procedure

1. From the menu bar, select “File” then select “Print Preview.”
The “Printout Setup” dialog box appears.

2. Specify the print range and other items.
Set the “Range” and “Color” of the graph viewer by clicking the radio buttons. Also
type a title if desired.

Set the “Range” of the sheet viewer or the report data.

3. Click the “OK” button.
The print preview window is displayed.

Note
For details on the print preview window, see the manual of your system.
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Printing
Procedure

1. Click the “Print” button on the toolbar or select “File” from the menu bar then select
“Print.”

2. Specify the print range and other items.
Set the “Range” and “Color” of the graph viewer by clicking the radio buttons. Also
type a title if desired.

Set the “Range” of the sheet viewer or the report data.

3. Click the “OK” button.
The “Print” dialog box appears.

4. Set the “Name” of the printer and “Number of copies,” then click “OK.”
Printing starts.

Note
The “Print range” in the “Print” dialog box is invalid.  The “Range” specified in the “Printout

Setup” dialog box is used.

4.9  Printing Data
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4.10 Linking and Displaying Data Files

File Link and Display Function
The file link display function is used to virtually display the data files that are continuous
in time as if they were a single data file.  With this function, sets of data files that have
been scanned and recorded to divided files can be displayed and handled as if they were
of a single file on the Viewer.

Data files that are continuous in time

Reference time range

Time flow

No duplicated section with the reference time and continuous 
with the reference time.
Duplicated section with the reference clock and has time range 
that is before, after, or both.
The files that are continuous in time must be data files that were 
created in the same data record interval (from record start to record 
collection).  Even if the above conditions are met, data files that were 
created during different data record intervals are not files that are 
continuous in time.)

Not continuous with the reference time
Contained within the reference time range

Files that are continuous in time
• (1), (4):
• (2), (3), (5):

(1)

(2)

(3)

(4)

(5)

(6) (7)(8)

Files that are not continuous in time
• (6), (7):
• (8):

Connecting Previous Files
Searches for files containing data that is continuous in time that is before the range that
is currently displayed ((3), (4), and (5) in the above figure) and links the appropriate data
file.  The files are searched within the same directory as the data file that is currently
loaded and displayed.

Procedure
1. Choose “Link Previous File” from the “File” menu or click the “Link Previous File” on

the tool bar.  Files containing data that is continuous in time that is before the range
that is currently displayed are searched.

2. The following three operations are executed depending on the search result.
• If a file that can be linked does not exist, linking is not performed, and “Link

Previous File” in the “File” menu and the tool bar button become unavailable.
• If a single file that can be linked is found, the file is automatically linked.
• If two or more files that can be linked are found, the “Previous Linkable Files”

dialog box appears.  A list of linkable file names is displayed in the dialog box along
with the start and end times.  When linking previous files, the files are displayed in
order from those with the oldest start time.  Click the name of the file you wish to
link to perform the link.
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3. When the name of the file you wish to link is selected, a “Select Process” dialog box
may appear.  Select either process, and click “Select” to perform the link.

Note
• The “Select Process” dialog box appears when adding the selected file causes the number

of displayed data points to be 8 KB or more and the load size to be 10 MB or more.  For

details, see “Opening a saved data file” in section 4.1.

• When data files are linked, the extension of the data file name that is displayed on the title

bar changes from .mld to .lml.  (If the extension is already .lml, it does not change.)

Connecting Succeeding Files
Searches for files containing data that is continuous in time that is after the range that is
currently displayed ((1), (2), and (3) in the above figure) and links the appropriate data
file.  The files are searched within the same directory as the data file that is currently
loaded and displayed.

Procedure
1. Choose “Link Next File” from the “File” menu or click the “Link Next File” on the tool

bar.  Files containing data that is continuous in time that is after the range that is
currently displayed are searched.

2. The following three operations are executed depending on the search result.
• If a file that can be linked does not exist, linking is not performed, and “Link Next

File” in the “File” menu and the tool bar button become unavailable.
• If a single file that can be linked is found, the file is linked automatically.
• If two or more files that can be linked are found, the “Next Linkable Files” dialog

box appears.  A list of linkable file names is displayed in the dialog box along with
the start and end times.  When linking succeeding files, the files are displayed in
order from those with the oldest start time.  Click the name of the file you wish to
link to perform the link.

3. When the name of the file you wish to link is selected, a “Select Process dialog” box
may appear.  For details, see “Linking Previous Files” in the previous section.

4.10  Linking and Displaying Data Files
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4.10  Linking and Displaying Data Files

Displaying a List of Linked Files
You can display a list of linked files and check the link condition of the current file.

Procedure
1. Select “List Linked Files” from the “Window” menu.  The “List of Linked Files” dialog

box appears.

The displayed information consists of “File,” “Start,” and “End.”  The list is displayed in
order from the oldest start time.
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4.11 Saving the Display Conditions/Terminating the
Historical Viewer

When the Historical Viewer is terminated, the display conditions at the time of
termination can be saved.  The next time the software is started, the condition data is
loaded and the display conditions are restored.
You can also save the display conditions by selecting “File” then “Save Display Setting.”
When multiple data files are linked and displayed using the File Link Display Function
of section 4.10, the display condition at that point is displayed, and the link status are
saved as a link file.
If the link file is loaded when the Viewer is started the next time, the link status is also
restored and displayed.

The following information is saved in a file.
• Print title
• Cursors A and B positions
• ON/OFF condition of the display waveform limiter
• Parameters set in the “General Display Settings” dialog box
• Mark information
• Time axis zoom factor
• Time axis display mode (absolute/relative time)
• Waveform display area
• Brightness of the waveform display area’s background and grid
• Y-axis zone settings
• Current waveform (active waveform)
• Selected group
• ON/OFF condition of alarm indication display
• Tag display (tag number/name)
• Group names

Saving the Display Conditions
Saves the display conditions of the data file.  The display conditions are saved to a file
with “.dml” extension in the same directory as the data file.  When multiple files are
linked, the link status is saved to the link file (.lml extension) in addition to the display
conditions.
However, for the report data (binary report file), there is no display condition to be saved.

Procedure
1. From the menu bar, select “File” then select “Save Display Settings.”

The current display condition settings are saved.

Saving the Display Conditions by Assigning a Name
Saves the display conditions of the link file to a specified file name.  This is valid only
when multiple data files are linked and displayed.

Procedure
1. Choose “Save Display Conditions” from the “File” menu.
2. The “Select File” dialog box appears.  Specify the file name and click “OK.”  The

display conditions of the link file are saved.

Note
When reverting a link condition by loading a link file, the data files that are to be linked must

reside in the same folder as the link file.
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Terminating the Historical Viewer
When terminating the Viewer, if the display conditions have been changed, a dialog
appears for you to specify whether or not to save the changes.  Click “Yes” or “No” as
necessary.

Procedure
1. From the menu bar, select “File” then select “Exit” or click the close button in the

upper right corner of the window.
The Historical Viewer terminates.

4.11  Saving the Display Conditions/Terminating the Historical Viewer
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Chapter 5 File Utility

5.1 Starting the File Utility

The File Utility performs the following four functions on the data file or report file that the
DAQLOGGER creates.
Merge: Merges the files that are continuous in time to a single file.
Divide: Divides a single file into several files.
Convert: Converts the data to Excel, ASCII, and Lotus1-2-3 formats.
Restruct.: Merges the files once and then divide the file using new conditions.

The extensions for the applicable files are indicated below.  Applicable files differ for the
Merge, Divide, Convert, and Restructure operations.  See the explanation of each
operation.
.mld: Data file created by the Logger of the DAQLOGGER.
.rbi: Binary report file created by the Report Software of the DAQLOGGER.

Each operation is carried out by specifying the input file or directory (source file or
directory) and the output file or directory (save destination file or directory).  If “Directory”
is specified, all the files in the selected directory that match the conditions are applicable.
The process information is displayed in the status display section during execution.
The source files are not affected by the Merge, Divide, Convert, and Restructure
operations.

Starting the File Utility
Procedure

You can start the File Utility using the following methods.
• After selecting a project, click the “File Utility” button on the Software Manager, or

right-click the “Launcher” icon on the task bar and choose “Start File Utility.”
• From the Start menu of Windows, select “Programs” then select “DAQLOGGER” -

“File Utility.”
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5.2 Merging Measurement Data Files

Merges multiple files that match the following conditions and creates a single file.  The
extension of the output file is .mld.
• Data files that have been saved through file division by enabling the file division mode

(Data Count, Per Day, or Per Hour) during data scanning and recording.
• Data files that have been divided through the Division Point mode of the File Utility

(excludes fixed time mode).
• Data files that have been divided using the division mode of the File Utility.

Displays the location of the file/directory to which the dada are saved.
Displays the location of the selected original file/directory.

Status bar

Select the input type (File/Directory)
Select the output type (File/Directory)
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Procedure
1. Click the “Merge” tab.  The Merge Setting page appears.

Displays the approximate progress of the process.

Specifying the files to be Merged
Enter the files to be merged under “Input.”
The input type list box is fixed to “Directory.”
2. Click “Select” and specify the directory containing the files to be merged in the dialog

box that appears.
3. Files that can be merged into a single file are arranged and displayed.  Click the

possible file group tab.
4. Drag across the row of numbers at the left edge of the file list to specify the files to be

merged.

Note
If the files are not specified by dragging, all the files are merged.

5.2  Merging Measurement Data Files
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Specifying the output file
Specify the output file name and save destination under “Output.”
5. The output type list box is fixed to “File.”
6. Click “Select.”  In the dialog box that appears, select the directory in which the output

data is to be saved and enter the file name.

Note
• Do not specify an external storage medium such as a floppy disk for the save destination of

the output file, because saving to such medium takes a long time.

• Do not specify a root directory for the save destination of the output file.

• Make sure there is enough free disk space at the save destination.

7. Click “OK” to execute the merge operation.  Click “Abort” to abort the operation.

Note
Abort operation may take a long time to be processed.

5.2  Merging Measurement Data Files
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5.3 Dividing Measurement Data Files

Divides a file and creates multiple files.  The output file names are automatically created.
The extension is .mld.
There are three division types: Division Point, Interval Length, and Single Fixed.

Division Point
Divides the source file in units of one day or one hour.
When dividing the file in units of one day, you can divide the data at certain hours of the
day.

Interval Length
Divides the source file into files of a specified length.

Single Fixed
Extracts a certain section from the source file by specifying the number of data points or
the time.

Note
When dividing the file using Division Point or Interval Length, the last output file may be

shorter than the specified length.

Output file name
When dividing the file using Division Point or Interval Length, the file names are created
by adding an index number to the original file name (input file).

source file name_index number.mld
When dividing the file using Single Fixed, the output file name is created by adding .mld
extension to the source file name.  If there is a file with the same name in the output
directory, the output file name is created by adding an index number to the source file
name.

Procedure
1. Click the “Divide” tab.  The Divide Setting page appears.
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2. Enter the source files to be divided under “Input.”
Select “File” or “Directory” in the input type list box.

Note
If “Directory” is specified, all the files in the selected directory that match the conditions are

divided.

3. Click “Select” and specify the files or directory in the dialog box that appears.
4. Specify the directory in which to save the output file under “Output.”

The output type list box is fixed to “Directory.”
Click “Select” and specify the directory in the dialog box that appears.

Note
• Do not specify an external storage medium such as a floppy disk for the save destination of

the output file, because saving to such medium takes a long period.

• Do not specify a root directory for the save destination of the output file.

• Make sure there is enough free disk space at the save destination.

When set to “Division Point”
5. From the “Type” drop-down list, choose “Division Point.”

• When dividing the file in units of one day
6. Under “Interval Setting,” click the “Per Day” option button.
7. Click “OK” to execute the divide operation.  Click “Abort” to abort the operation.

• When dividing the file in units of one hour
6. Under “Interval Setting,” click the “Per Hour” option button.
7. Click “OK” to execute the divide operation.  Click “Abort” to abort the operation.

• When extracting data at a certain time (fixed time mode)
6. Under “Interval Setting,” click the “Per Day” option button and select the “Fixed Time

of Day” check box.
7. Specify the range to be extracted in terms of time in the text box.  In the example in

the following figure, the data is output between 10:00 and 14:00.
8. Click “OK” to execute the divide operation.  Click “Abort” to abort the operation.

Note
You can specify a time range that spans over two days such as from 23:00 to 1:00.

5.3  Dividing Measurement Data Files
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When set to “Interval Length”
5. From the “Type” drop-down list, choose “Interval Length.”

• When specifying the length in terms of the number of data points
6. Under “Interval Type,” click the “Data Count” option button.
7. Enter the number of data points in the text box.
8. Click “OK” to execute the divide operation.  Click “Abort” to abort the operation.

• When specifying the length in terms of time
6. Under “Interval Type,” click the “Time Count” option button.
7. Enter the time in the text box.  In the example in the figure, a single file is divided so

that the length is 1 day 2 hours 3 minutes 4 seconds.
8. Click “OK” to execute the divide operation.  Click “Abort” to abort the operation.

5.3  Dividing Measurement Data Files
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5.3  Dividing Measurement Data Files

When set to “Single Fixed”
5. From the “Type” drop-down list, choose “Single Fixed.”

• When specifying the position in terms of the data number
6. Under “Position Setting,” click the “Data No.” option button.
7. Enter the first data number of the extracted position in the “Start Data No.” text box.
8. From the list box, select “End Data No.” or “Data Count” and enter the data number of

the last data point to be extracted or the number of data points in the text box.
9. Click “OK” to execute the divide operation.  Click “Abort” to abort the operation.

• When specifying the position in terms of time
6. Under “Position Setting,” click the “Time” option button.
7. Enter the start position for extracting the data in terms of time from the beginning of

the source file in the “Start Time” box.
8. From the list box, select “End Time” or “Time” for the condition for the last data point

to be extracted.  If you select “End Time,” enter the relative time from the beginning of
the source file.  If you select “Time,” enter the time span for extracting the data.  In the
example in the figure, data is extracted from the data at 1st day 2nd hour to 3rd day
4th hour.

9. Click “OK” to execute the divide operation.  Click “Abort” to abort the operation.

Note
• The file is not created if the specified position (for extracting) does not exist within the source

file.

• Abort operation may take a long time to be processed.
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5.4 Converting the Data Format

Converts data files or report files with .rbi extension to Excel, ASCII, or Lotus1-2-3
formats.

Procedure
1. Click the “Convert” tab.  The Convert page appears.

Specifying the files to be data-converted
Specify the file to be converted or a directory containing the files under “Input.”
2. Select “File” or “Directory” in the input type list box.

Note
If “Directory” specified, all the files in the selected directory that match the conditions are

divided.

3. Click “Select” and specify the files or directory in the dialog box that appears.
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5.4  Converting the Data Format

Specifying the output file or directory
Specify the file or directory in which to save the output file under “Output.”
4. In the output type list box, select “File” if the input is set to “File,” “Directory” if input is

set to “Directory.”

Note
If you set output to directory when input is set to file or if you set output to file when input is

set to directory, the input setting is automatically changed.

5. Click “Select” and specify the files or directory in the dialog box that appears.

Note
• Do not specify an external storage medium such as a floppy disk for the save destination of

the output file, because saving to such medium takes a long period.

• Do not specify a root directory for the save destination of the output file.

• Make sure there is enough free disk space at the save destination.

6. Select the conversion format in the “Convert Setting” dialog box.
If a data file is to be converted, select the range to be converted in the “Range
Setting” dialog box.
You can select “Tag” or “Group.”  If you select “Tag,” specify “All” or “Select” for the
range of tags.

For Tag

For Group

7. Click “OK” to execute the conversion operation.  Click “Abort” to abort the operation.

Note
• You can select multiple data conversion formats.

• The name of the output file is automatically set to the input file name followed by the

extension that identifies the conversion format.  The .xls, .txt, and .wrk extensions are added

for Excel conversion, ASCII conversion, and Lotus conversion, respectively.

• There is a limit in the number of data points that Lotus1-2-3 and Excel can handle.  You

cannot read data that exceeds this limit.  Note that even if the number of data points to be

converted is within the limits, loading the data may not be possible if the available free

memory on the PC is insufficient.

• Abort operation may take a long time to be processed.

• Do not specify an external storage medium such as a floppy disk for the save destination of

the output file, because saving to such medium takes a long period.

• Do not specify a root directory for the save destination of the output file.

• Make sure there is enough free disk space at the save destination.
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5.4  Converting the Data Format

File Format of the Converted Data
For details on the file format of the converted data, see section 4.7, “Converting the Data
Format.”
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5.5 Restructuring Measurement Data Files

This function carries out the “Merge” and “Divide” functions at once.  The file is
restructured by merging the files once and dividing the merged file again using new
conditions.
Files with .mld extension are applicable.
The output file name is automatically created based on the name of the first file that is to
be merged.  The extension is .mld.

Output file name
The output file name is created by adding an index number to the name of the first file of
the source files (input files) to be merged.

first file name_index number.mld

Procedure
1. Click the “Restruct” tab.  The Restructure page appears.

Specifying the files to be merged
Enter the files to be merged under “Input.”
The input type list box is fixed to “Directory.”
2. Click “Select” and specify the directory containing the files to be merged in the dialog

box that appears.
3. Files that can be merged into a single file are arranged and displayed.  Click the

possible file group tab.
4. Drag across the row of numbers at the left edge of the file list to specify the files to be

merged.

Note
If the files are not specified by dragging, all the files are merged.
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5.5  Restructuring Measurement Data Files

Specifying the output file
Specify the output file name and save destination under “Output.”
The output type list box is fixed to “Directory.”
5. Click “Select.”  Specify the directory in which to save the output file in the dialog box

that appears.

Note
• Do not specify an external storage medium such as a floppy disk for the save destination of

the output file, because saving to such medium takes a long period.

• Do not specify a root directory for the save destination of the output file.

• Make sure there is enough free disk space at the save destination.

Setting the division method
Set the division method under “Division.”  For the procedure, see section 5.3, “Dividing
the Measurement Data File.”

Note
“Single Fixed” cannot be specified.
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5.6 Exiting the File Utility

You can exit from the File Utility through the following methods.
• Select “Exit” from the “File Utility” menu.
• Select “Close” from the system menu.
• Double-click the File Utility icon on the system menu.
• Click the “Close” button at the upper right corner of the “File Utility” dialog box.

Note
You cannot exit from the File Utility while data is being written to a file.
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Chapter 6 Event Processer

6.1 Setting Events

In the Event Processor function, transmission to an FTP server, e-mail transmission, or
file conversion is performed on the target file when the specified conditions of alarm,
time, and system status are met.  For example, the following process can be performed.
• Transmit the contents of the alarm information in an e-mail message when an alarm

occurs.
• Transfer the data file to an FTP server when a data file is created.
• Periodically transmit the instantaneous values of the measured data in an e-mail

message.
• Convert the text file when a data file is created.

Events
The Event Processor can process up to 8 events simultaneously.  The settings of a
single event consist of three items, event condition, target file, and execution process.

Note
If the condition is met again for an event that is already in execution, a new process is not

started.

Event conditions
Event condition is used to specify the time when the event is to be executed.  The three
conditions that you can specify are as follows:
• Alarm: point of change, OFF→ON, ON→OFF
• Time: every minutely, every hour, every day, every week, every month, or interval
• System: When a data file is created, when a report file is created, when a recorder

disconnection is detected, when a recorder recovery is detected, and when a user
event is detected.

• Value: Events occur when the specified data meets the specified conditions.
You can specify up to two event conditions and the AND or OR logic of the two
conditions.

Target file
The target file is used to select the type of file to be handled in the execution process.
The following four types of target files are available.
• Data file: File created by the Logger Software of the DAQLOGGER.
• Report file: File created by the Report Software of the DAQLOGGER.
• PNG file: Saves the Monitor Software screen to a PNG file.
• User file: Scans and records the data when an event occurs (alarms or instantaneous

values) and saves the data to a text file.

Execution process
In the execution process, the process to be performed on the target file when the event
condition is met is specified.  The following four execution processes are available.
• FTP: Transfer the file to an FTP server.
• E-Mail: Transmit an e-mail message.
• Convert: Convert the file to a text file, Microsoft Excel file, and Lotus 1-2-3 files.  The

files that can be converted are data files (.mld) and report files (.rbi).
• Format: Tags the contents of text files. The tagged file is also output as a text file.
For each event, you can specify up to 10 processes.
You can copy and paste settings for the process.
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Setting Events
Procedure

Starting event settings
1. In the menu bar of the “DAQLOGGER Manager” window, choose Others > Event

Processor > Configuration.
The DAQLOGGER Event Processor dialog box appears.

Note
When the event processor is in execution, you cannot change the event settings.

Creating new events
2. Click “New.”  The “Event Page” appears.

3. Enter the name of the event in the “Event Name” box.
4. Set “Display Tag” to “Tag Name” or “Tag Number.”

Note
• You can create up to 8 events.
• When selecting an arbitrary event, click the tab with the event name.
• The “Display Tag” setting is valid only on the specified event page.
• The “Display Tag” setting is not saved.

6.1  Setting Events



6-3IM 04D05C01-62E

E
ven

t P
ro

cesser

6

Setting event conditions
5. Click the “Conditions” tab to display the “Event Condition Page.”

6. Even if a specified event condition is matched, the event only occurs if you enable
the function by selecting the Continue check box.

• When selected: Continue judging conditions even after first match.
• When cleared: Discontinue after matching the condition once.

7. The “Logic” list box is used to specify “AND” or “OR” when specifying the
relationship between two types of conditions.

8. Select the condition from “Alarm,” “Time,” “System,” and “Value” in the “Condition
Type” list box.

9. For each condition type, set as follows:

• When set to Alarm
The event is executed at the time when the specified alarm condition is met.
The condition is determined only when scanning is in progress.

Select the tag of the alarm you wish to detect.
Click All Groups or All Tags button to display the Group
Selection or Tag Selection dialog box.

Select the alarm you wish to detect.

Select the Alarm Status from “Changed”, “OFF -> ON”, and “ON-> OFF.”

6.1  Setting Events
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Select Group dialog box

 Click the desired group to close the dialog box and apply the selected group.

Select Tag dialog box

 Click the desired tag to close the dialog box and apply the selected tag.

• When set to Time
The condition is met when the time of the data being scanned exceeds the specified
time.
The condition is determined only when scanning is in progress.

Select a time interval of Minutely, Hourly, Daily, Weekly, Monthly, and Interval.  
The reference day is 0. The reference day and day of week are not saved.

The setting can only be entered when Interval is specified 
for Time By.  The condition is “true” from 00:00 up to the 
interval setting. 

Selectable only when Time By is set to
Hourly, Weekly, or Monthly.

Selectable only when Time By is set to Monthly.

Selectable only when Time By is set to Weekly.

6.1  Setting Events
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• When set to System
The condition is met when the specified system status occurs.  The following system
statuses are detected.
Data File Created: When the creation of a data file is completed.  If the division

mode is not specified, this status does not occur until the
recording is completed.

Report File Created: When the creation of a report file is completed.  The report
type does not matter.

Recorder Disconnected: When a recorder disconnect is detected.  The status occurs
for each recorder.

Recorder Reconnected: When a recorder reconnect is detected.  The status occurs
for each recorder.

Menu Start (User Event):When the user arbitrary issues an event.

Select the system status you wish to detect from “Data File Created,”
“Report File Created,” “Recorder Disconnected,” “Recorder Reconnected,”
and “Menu Start (User Event).”

• When set to Value
Events occur when the specified data matches the specified conditions.  Conditions
are judged only while scanning.

This setting is only available when Data Type is set to Value.  
Enter the operator and value.
• LACK: When matching the Lack data
• +OVER: When matching the +OVER value
• –OVER: When matching the -OVER value
• OFF:  When matching the OFF value
• Value:  When matching the comparison criteria selected below 
 (abnormal data is not included).
 =: equal to the specified value
 >: greater than the specified value
 <: less than the specified value
 >=: greater than or equal to the specified value
 <=: less than or equal to the specified value
 !=: not equal to the specified value

Enter the value.  You can enter exponential expressions.  
The value is automatically rounded to 4 decimal places.  
The available setting range is 9999999999.0000 to 9999999999.000(s).  

6.1  Setting Events
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6.1  Setting Events

Setting the target file
10. Click the “Target File” tab to display the “Target File Page.”

11. Select the target file from “Data File,” “Report File,” “PNG File,” and “User File” in the
“File Type” list box.

• When set to Data File
The newest created data file is the target file.

• When set to Report File
The newest created report file is the target file.  Report files are binary files.

Specify the type of report file.
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6.1  Setting Events

• When set to PNG File
When the event condition is met, the active window of the Monitor is saved to a PNG
file.

Specify the output file name.
You can specify “Auto Name” that automatically assigns names that are 
derived from the date and time of the time of execution or “Specify File” that
allows you to specify a fixed name.

Valid only when “Output File” is set to “Specify File.”
Click “Select” to display the “Select File” dialog box.

You can directly enter the string in the text box.  
This is valid only when "Select File" is selected.

Select File dialog box

Select the file from a list in the “Look in” box or enter
the name directly in the “File name” box.

Close the “Select File” dialog box and apply
the specified file name.

Note
When the output file is Select File and a file with the same name already exists, the file is

overwritten at the time of execution.
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• When set to User File
Creates a text file using the information of the items specified below.

Specify the output file name.
For details on this setting, see “PNG File” in the previous section.

 Specify the delimiter for items in the file. If the check box is selected,
 spaces are used to delimit the items in the file.  If the check box is cleared,
 tabs are used to delimit the items.

Specify the output of time information.

Specify the output of alarm information.

Specify the output of instantaneous values for each tag.

Specify an arbitrary string to be output.

Specify the output of recorder information.

Specify the tag or group to be output.  Click the button 
to display the selection dialog box.  For details on the 
settings, see the case when “Alarm” is specified in 
“Setting Event Conditions.”

Specify the recorder that is to output the text file. Click 
the button to display the recorder selection dialog box.

Select  Recorder  dialog box

Note
When the output file is Select File and a file with the same name already exists, the file is

overwritten at the time of execution.

6.1  Setting Events
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Example of User File

Specifying the execution process
12. Click the “Process” tab to display the “Process Page.”

None (extension only): Change only the extension per a preexisting name-rule. 
Add Event No. and Process No.: Add the event number Enn and process number 
 Pnn to the file name.  The format appears as follows:  
 [File name_EnnPnn].  You can also change the extension.

Event number Enn: The number assigned when a new event is created.  
 The default value for the Setting Name.  
 For example, if the Setting Name is Event01, the event number is E01. 
Process number Pnn: The process page number.  
 Leading 0 added when the number has 1 digit.  
 For example, if the number is 1, the process number is P01.

Changing the order of and copying processes (see page 6-15)

6.1  Setting Events
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6.1  Setting Events

13. Select from None (Extension Only) to Suffix is Event No. and Process No. in the
Rule of Auto Name box.

14. Click a number in the “No.” column to select the process number.
15. Select “FTP,” “E-Mail,” “Convert” and “Format” from the “Process” list box.

• When set to FTP

Bookmark: Select, edit, or register the FTP server to be accessed.  Click
“Add/Select” to display the “Add/Select Bookmark” dialog box.

Server: Specify the FTP server address. This parameter is always entered.
Enter using “host name + domain name” or “IP address.”

Port: Enter the port number of the FTP server in the range 0 through 65535.

User Name: Enter the user name for accessing the FTP server.

Password: Specify the login password.

Directory: Specify the directory path in which to store files.

Input File:
Select the file to be transmitted from “Target File,” “Prev. Output,” and “Select File.”
• Selecting “Target File” specifies the file that was specified in the “Target File” page.
• Selecting “Prev. Output” specifies the output file of the process of the previous

number that is displayed in the “Process List.”
• Selecting “Select File” allows you to specify the file name.  Directly enter the file name

in the text box or click “Select” to select the file from the “Select File” dialog box.
For details on the settings, see “PNG File.”

Add/Select Bookmark dialog box.

Enter the name, server name, port, login name, 
passwordand directory.

Enter an arbitrary string for user identification.

OK: Saves edited bookmarks and closes the dialog box. The bookmark 
       corresponding to the selected number is applied in the FTP dialog box.
Cancel: Discards the edited information and closes the dialog box.
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6.1  Setting Events

• When set to E-Mail

SMTP: Specify the SMTP server.  This parameter is always entered.  Click “Edit”
to display the “SMTP” dialog box.

Subject: Enter the subject of the e-mail message.

From: Enter the e-mail address of the transmitter.  Click “Select” to display
the “Select Address” dialog box.

To: Enter the e-mail address of the receiver.  Click “Select” to display
the “Select Address” dialog box.

Cc: Enter the e-mail address for the “carbon copy.”  Click “Select” to display
the “Select Address” dialog box.

Body File:
Specify the information to be transmitted.  The contents of the file becomes the body
of the message.  Select “None,” “Target File,” “Prev. Output,” or “Select File.”
• If “None” is selected, the information specified in Comment becomes the body

of the message.
• Selecting “Target File” specifies the file that was specified in the “Target File” page.
• Selecting “Prev. Output” specifies the output file of the process of the previous
number that is displayed in the “Process List.”

• Selecting “Select File” allows you to specify the file name.  Directly enter the file name
in the text box or click “Select” to select the file from the “Select File” dialog box.
For details on the settings, see “PNG File.”

Attach File:
Specify the file to be attached to the e-mail message.
Select “None,” “Target File,” “Prev. Output,” or “Select File.”
• If “None” is selected, no file is attached.
• Selecting “Target File” specifies the file that was specified in the “Target File” page.
• Selecting “Prev. Output” specifies the output file of the process of the previous
number that is displayed in the “Process List.”

• Selecting “Select File” allows you to specify the file name.  Directly enter the file name
in the text box or click “Select” to select the file from the “Select File” dialog box.
For details on the settings, see “PNG File.”

Comment: If “Body File” was set to “None,” the comment information becomes the
body of the message.
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Selection SMTP dialog box

Enter the port number using a value.

Enter the SMTP server address using a string.

OK: Save and close the dialog box.
Apply the server name to the E-Mail dialog box.

Cancel: Clear the edited information and close the dialog box.

Select Address dialog box

Enter an arbitrary string for identifying the user.

Save: Save the information and close the dialog box.
Cancel: Discard the edited information and close the

dialog box.

Enter the e-mail address.

Applies the address of the selected
number to the E-Mail dialog box.

6.1  Setting Events
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• When set to Convert

Select the file to be converted. The files that can be converted are data files (.mld)
and report files (.rbi).  Select “None,” “Target File,” or “Select File.”
• Selecting “Target File” specifies the file that was specified in the “Target File” page.
• Selecting “Select File” allows you to specify the file name.  Enter the file name directly
in the text box or click “Select” to select the file from the “Select File” dialog box.
For details on the settings, see “PNG File.”

These check boxes are valid when Input File is set to “Data File.”
Select the check box and specify “Start” and “End.”
Pressing the button to the right of “Start” or “End” displays the Group Selection
dialog box or Tag Selection dialog box.
Click the desired group or tag.  The dialog box closes and the selected group or
tag is applied.

Select the type of file to be converted
from “Text,” “Excel,” and “Lotus.”

Select the file to be converted from “Auto Name,” and “Select
File.”  For details, see “PNG File.” When set to Auto Name, 
the extension of the input file name changes according to 
the type of conversion.

6.1  Setting Events
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• When set to Format

Select the file to format.   Lets you specify the text file selected on the 
Target File page (user file, data file, or report file).   
• Select this only when None or User File is selected for the target file 
 on the Target File page.  
• Select Specify File to specify the file.  The data file group and tag 
 range of the output file will be the same as the input file.  If no range is 
 specified before the change, the name is not displayed.  
• Prev. Output is available when Form Type is set to Text on the previous 
 numbered setting. 

Select a form type from HTML, XML, XHTML.  If you change the Form 
Type, the extension of the specified file is automatically changed.  
The following extensions are available.  
• .html: HTML file
• .xml: XML file
• .xhtml: XHTML file
• .dtd: DTD file
• .css: Style sheet file
• .xsl: Style sheet file for XML

Select how the file to be formatted will be specified from Auto Name or 
Specify File.  When set to Auto Name, the extension of the input file 
name changes per the format type.  For detailed settings, see PNG File.

Indicates the title of the file after formatting.  
A title of up to 2047 alphabetic characters may be used.  
Available when specifying a data file for the input file. 

Select settings for the DTD (document type definition), and specify a file 
name if necessary.  Available when the Form Type is XML.
• None:  Do not specify a DTD file for the output.
• Fixed Name:  The contents of the DTD file are included in the file.
• Select (Relative): Adds to the output file the relative path to the DTD. 
• Select (Absolute):  Adds to the output file the absolute path to the DTD. 
• Internal: Embeds the DTD file in the output file. Specify a title for the file after formatting. 

Select style sheet settings, and specify a file name if necessary.  
• None: Do not specify a style sheet for the output file.
• Fixed Name:  The contents of the style sheet are included in the file.
• Select (Relative):  Adds to the output file the relative path to the style sheet . 
• Select (Absolute):  Adds to the output file the absolute path to the style sheet.

6.1  Setting Events
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Changing the Order of and Copying Process
16. In the table on the left side of the execution process page, click the number of the

process that you wish to change the order of.

17. The operation is selected using the +, �, �,  ,     and  buttons at the bottom
section of the table.  The operation of each button is as follows:
“+”: Add
“�”: Move upward
“�”: Move downward
“ ”: Delete
“    ”: Copies the source settings to the process settings of the selected numbers.
“ ”: Sets the process settings of the selected number as the copy source.

Testing the execution process
18. In the table on the left side of the execution process page, press the button in the

“Test” column corresponding to the process you wish to test.
19. If “Target File” or “Prev. Output” is specified in the “Select File” list box, a dialog box

with a confirmation message appears.  If there are no problems, click “OK.”  The test
execution is started.

20. When the test execution is complete, a message box showing the result (success or
fail) appears.

6.1  Setting Events
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21. Click “OK.”  The result (success or fail) is displayed on the button in the Test column.

Note
If the following message appears when you click a button in the “Test” column, the execution

process setting is not correct.  Click “OK” and set the execution process again.

Example
The following is an example for setting the event, “convert the data file to a text file when
the data file is created.”

Procedure
1. In the menu bar of the “DAQLOGGER Manager” window, choose Others > Event

Processor > Configuration.
2. Click “New.”  The “Event Page” appears.  To change the settings of a preexisting

event, click the tab with the event name.
3. To create a new event, enter an event name in “Event Name” (Event01 in this

example).
4. Set “Display Tag” to “Tag Name” or “Tag Number.”
5. To continuously evaluate event conditions, select the Continue check box.
6. Click the “Conditions” tab to display the “Event Condition Page.”
7. The “Logic” list box is used to specify “AND” or “OR” when specifying the

relationship between two types of conditions.  (In this example, there is only one
condition.  Thus, selecting either logic is okay.)

8. Set “Condition Type” to “System.”
9. Select “Data File Created” from the “System Status” list box.

6.1  Setting Events
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10. Click the “Target File” tab to display the “Target File Page.”
11. Select “Data File” from the “File Type” list box.

12. Click the “Process” tab to display the “Process Page.”
13. Click a number in the “No.” column to select the process number.
14. Select “Convert” from the “Process” list box.
15. Select “Text” from the “Convert To” list box.
16. Select “Target File” from the “Input File” list box.
17. Select “Auto Name” or “Select File” from the “Output File” list box.  If Auto Name is

selected, a text file is created using the name of the created data file with .txt
extension.

18. Specify the range of tags or groups over which the process is executed through “Tag
Range” or “Group Range.”

These check boxes are valid when Input File is set to “Data File.”
Select the check box and specify “Start” and “End.”
Pressing the button to the right of “Start” or “End” displays the Group Selection
dialog box or Tag Selection dialog box.
Click the desired group or tag.  The dialog box closes and the selected group or
tag is applied.

19. Click “OK” to save the settings.  For details on saving events, see section 6.2.

6.1  Setting Events
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6.2 Saving, Deleting, Redisplaying, or Copying
Events

Saving Events
Saves the settings for each event.

Procedure
1. Click “Save” in the DAQLOGGER Event Processor dialog box.
2. If there are no problems in the settings, the event is saved.

If there is a problem in the settings, a message dialog box appears.  Click “OK.”  The
page with the problem is displayed.  Set the parameters again.

Deleting Events
Deletes the setting of an event.

Procedure
1. Click “Delete” in the DAQLOGGER Event Processor dialog box.
2. A dialog box containing a confirmation message appears.  Click “OK.”

Redisplaying Events
Clears the current settings and reverts and displays the newest saved information for
each event.

Procedure
1. Click “Revert” in the DAQLOGGER Event Processor dialog box.
2. A dialog box containing a confirmation message appears.  Click “OK.”
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6.2  Saving, Deleting, Redisplaying, or Copying Events

Copying Events
Copies setting parameters between events.

Procedure
1. Click the event name tab and select the copy source event page.
2. Click “Copy” in the DAQLOGGER Event Processor dialog box.
3. Click the event name tab and select the copy destination event page.
4. Click “Paste” in the DAQLOGGER Event Processor dialog box.
5. A dialog box containing a confirmation message appears.  Click “OK.”

Exiting Event Setting
Automatically saves the current settings and exits the setting operation.

Procedure
1. Click “OK” in the DAQLOGGER Event Processor dialog box.
2. If there are no problems in the settings, the settings are automatically saved and the

DAQLOGGER Event Processor terminates.  If there is a problem in the settings, a
message dialog box appears.  For details about the dialog box, see “Saving Events.”
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6.3 Starting/Stopping the Event Processor

Starting the Event Processor
Starts the execution of the event that was specified in the event setting.

Procedure
1. From the menu bar of the “DAQLOGGER Event Processor” dialog box, choose

Others > Event Processor > Start.  An error dialog box appears if there are no
specified events.

Stopping the Event Processor
Stops the execution of the event.

Procedure
1. From the menu bar of the “DAQLOGGER Event Processor” dialog box, choose

Others > Event Processor > Stop.
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6.4 Displaying Error Information

Even if an error occurs during event execution, the Event Processor does not display
a dialog box containing an error message and does not abort the operation.  The error
information dialog box only displays the information of the newest error that occurred.
In addition, the error information can be initialized.

Procedure
1. From the menu bar of the “DAQLOGGER Event Processor” dialog box, choose

Others > Event Processor > Display Error Information.  The “Event Processor Error
Information” dialog box appears.

2. To select the event of which the error information is to be initialized, click the
event name in the “Event Name” column.  The “Initialize” button becomes valid.

3. Click “Initialize.”  The error information of the selected event is initialized.
4. Click “OK” to close the “Event Processor Error Information” dialog box.
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7.1 Starting the Hardware Configurator

The Hardware Configurator can be used to create setup parameters for the SET mode
(setting mode) and the SETUP mode (basic setting mode) of the recorder and write the
setup parameters back to the recorder to configure the recorder.  If the recorder is
already configured, you do not have to configure the recorder using this software
program.
The Hardware Configurator window consists of a “Recorder List” window that lists the
recorders that have been configured using the Software Configurator and a “Setting”
window that indicates details of each recorder.
In the “Recorder List” window, the model, the number of measurement channels, the
number of computation channels, and option information are displayed for up to 32
recorders that have been set by the Software Configurator.

Procedure
1. In the “DAQLOGGER Manager” window, click “SETTING.”

Hardware Configurator starts and the “DAQLOGGER Hardware Configurator” window
opens.

“Setting” window display area

Save settings (current recorder)

Save settings (all recorders)

Print preview

Receive setup parameters from the recorder

Transmit setup parameters to the recorder

Show/Hide “Recorder List”

Display recorder control dialog box

Print

Display version

Menu bar

Toolbar

Copy settings 
between recorders

Status bar

“Recorder List” window
Drag & drop this bar to move the boundary 
between the “Recorder List” and “Setting” windows.

Chapter 7 Setting the Recorder
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“Setting” windowwhen “Setting” windows are displayed

The following operations can be carried out using the Hardware Configurator.
• Read setup parameters from the recorder via communications

For the operating procedure, see section 7.2.
For limitations on each model, see “Hardware Configurator” in section 1.1.

• Write setup parameters to the recorder via communications
For the operating procedure, see section 7.9.
For limitations on each model, see “Hardware Configurator” in section 1.1.

• Edit the setup parameters
For the operating procedure, see sections 7.3 through 7.8.
You can also create setup parameters by changing the system configuration
(presence or absence of options, for example) and subunit/module configuration (for
DARWIN) of a recorder.

• Read setup parameters that were created on a recorder through a floppy disk.
For the operating procedure, see section 7.11.
For limitations on each model, see “Hardware Configurator” in section 1.1.

• Write setup parameters that were created to a recorder through a floppy disk.
For the operating procedure, see section 7.11.
For limitations on each model, see “Hardware Configurator” in section 1.1.

• Save the setup parameters
For the operating procedure, see section 7.12.
Saves the setup parameters to the hard disk.  Save the setup parameters
occasionally while editing the parameters.

• Print the setup parameters
For the operating procedure, see section 7.13.

• Initialize the setup parameters
For the operating procedure, see section 7.10.

• Transmit control commands to a recorder
For the operating procedure, see section 7.14.
Through control commands, you can change the date and time, start the recording
operation, and other operations.

• Start/Stop the DARWIN report function, execute balancing
For the operating procedure, see section 7.15.

7.1  Starting the Hardware Configurator
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Showing/Hiding “Recorder List” window

Procedure
1. Select “Recorder List” from the “View” menu.  The window is shown or hidden every

time the menu command is selected.

Arranging the “Setting” windows

Procedure
1. With the “Setting” window showing, select “Cascade” or “Tile” from the “Window”

menu.  The “Setting” windows are arranged accordingly.

Showing/Hiding the toolbar or status bar

Procedure
1. Select the item to show or hide from the “View” menu.  The corresponding bar is

shown or hidden every time the menu command is selected.

7.1  Starting the Hardware Configurator
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7.2 Loading the Setting Parameters

Load the setting parameters from the connected recorder.

Procedure
1. In the menu bar, select “Communication” then “Receive.”

The “Select Recorders” dialog box opens.

2. Select the recorders from which to receive data, then click the “Receive” button.
• To select all the recorders  Click “Select All.”
• To select individual recorders  In the list, currently connected recorders are

shown in blue. Click the recorder from which you wish to receive data and it turns
red. You can select more than one recorder.

3. When the setting parameters from the recorder have been received, a
“Communication Message” dialog box appears. Read the message and click “OK.”

Note
• You cannot load the setting parameters by the “Receive” command operation while the

scanning or recording is in progress.
• In some cases, the system configuration may not be properly loaded from VR and µR

recorders.  Please check that the system configuration that was loaded matches that of the
recorder.  If is does not, refer to sections 7.4 and 7.5 and correct the system configuration so
that they do match.

• As for VR series recorders, you cannot load the setting parameters by the “Receive”
command operation described in the previous pages. Use the “File Import” function instead
(See “Handling Settings Data Using a Floppy Disk”).

• Data cannot be received when the Logger Monitor or Record function is active.
• When using Ethernet, error detection may take a few minutes.
• When data were acquired with the DC100, a message may appear warning you that some

changes have taken place. In that case, please check if all data have been acquired.
• In the “DAQLOGGER Hardware Configurator” window, possible menu bar operation varies

depending on the project’s operation level.
• For more information about this limitation on operation, see section 2.5, “Setting the

Security.”
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7.3 Editing the Setting Parameters

Selecting the Recorder
Procedure

1. In the “Recorder List” window, click the “No.” cell of the recorder for which you wish to
change settings.
The settings window of the selected recorder appears on top.

If DARWIN (DA, DR, or DC) is selected and the system configuration or subunit/
module configuration on the Hardware Configurator is different from the system
configuration or subunit/module configuration that was specified in the Software
Configurator, the following message is displayed.
If you select “Yes,” the setup parameters of the recorder contained within the
Hardware Configurator are loaded and the “Setting” window opens.  If you select
“NO,” the “Setting” window is opened with the initial system configuration and module
configuration of the Software Configurator.

2. From here, recorder settings operations follow.  The operations are classified into six
types as shown below by the series of recorders.

Type Model

VR series VR100, VR200, VR200 S2

µR series µR1000, µR1800

DX series DX100, DX200, DX200C

MV series MV100, MV200

CX series CX1000, CX2000

DA DA100

DR DR130, DR200

DC DC100

Regarding the settings window and its operation of each type, see the following
pages.
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Basic Setting Operation
The operations in tab panels are summarized as the following two types.
Recorder-to-recorder copy and channel-to-channel copy are convenient editor functions.
Operation in Channel tab panels
• Operations in the tab panels for channel settings, which are titled with “Channel,”

“Meas,” or “Math.” However, the title may differ between each series.
• It is possible to input data directly to the items displayed in the tab panel, however,

dedicated entry dialog boxes are offered for efficient data input.  You can open the
dedicated entry dialog box by double-clicking the “CH (channel)” cell.

Operation in tab panels other than Channel tab panels
• Operation in the tab panels titled with “Misc.,” “SETUP,” “Setting,” or “Setup.”

However, the title may differ between each series.
• For some panels, select an item from the listing displayed in the left part of the tab

panel and the corresponding settings items will be shown in the right.  Input the
settings.

Recorder-to-recorder copy
You can copy the settings between recorders by using the “Copy” button in the
“Recorder List” window.

Note
• For VR, µR, and DARWIN, copying is only allowed on the same model.  Copying is not

allowed if the /N1, /N3, and /N5 option codes differ, even if the model is the same.  However,

if the calculation or IC memory options differ, copying is allowed.  If the number of channels

differs, only the common channels are copied (VR, µR, DARWIN).

• For DX, MV, and CX, each system information item is copied.

Procedure
1. Click the “No.” cell of the source recorder, then press the “Copy” button.

The “Copy” dialog box appears.

2. Among the recorder model names shown in the “Copy” dialog box, select the recorder
to copy to (you can select more than one recorder).  Then click “OK.”

7.3  Editing the Setting Parameters
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Channel-to-channel copy
You can copy the settings between channels by using the “Copy” button in the Channel
tab panel.

Procedure
1. Click the “CH” cell of the source channel, then press the “Copy” button.

“Copy” button
• For DARWIN

The “Selection of Copy Item” dialog box opens.  Select the items to be copied and
click “Close.”  The content of the “Selection of Copy Item” dialog box varies depending
on the recorder.
Click “All Items” to select all items.  Clicking “All Items” again deselects all items.
Proceed to step 4.

Absolute and relative position settings for DELTA, RRJC
When copying DELTA and RRJC channels, it is necessary to determine the relation to
reference channels.
• Absolute position

The reference channel of the copy destination doesn’t change.
For example, if the reference channel of Ch 005 is Ch 002, and you would copy Ch
005 settings to Ch 007, the reference channel of Ch 007 will remain Ch 002.
However, if you are copying between units, the reference channel of the copy
destination will change.
For example, if the reference channel of Ch 005 is Ch 002, and Ch 002 settings are
TC, Type R, and you would copy Ch 005 settings to Ch 107, the reference channel
of Ch 107 will become Ch 102.  Copying is, in this case, only possible if Ch 102,
like Ch 002, is set to TC, Type R, and in addition, the scale must be set OFF.

• Relative position
The relative positions of channels and relative channels set in DELTA or RRJC, will
be maintained when copied.  Therefore the reference channel of copy destination
and copy base will differ.
For example, if the reference channel of Ch 005 is Ch 002, and Ch 002 settings are
TC, Type R, and you would copy Ch 005 settings to Ch 009, the reference channel
of Ch 009 will become Ch 002. Copying is, in this case, only possible if Ch 009, like
Ch 002, is set to TC, Type R.  It is advisable to let the copying include the
reference channel.

7.3  Editing the Setting Parameters
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• µR, VR, DX, MV, CX
Proceed to step 2.

2. Press the “Copy Details” button.
The “Copy Details” dialog box opens.  The setting items contained in this dialog box
differ for each series of recorders.

3. After selecting the items to be copied, click “OK.”
4. Select the “CH” cell of the channel to copy to (you can select more than one channel).

To select channels over a series of numbers, click the first cell then, pressing the
SHIFT key, click the last cell.

5. When you have finished selecting, press the “Paste” button.

Note
You cannot copy between a measurement channel and a computation channel.

7.3  Editing the Setting Parameters
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7.4 Setting VR Series

Changing any of the system configurations, will result in initialization of Hardware
Configurator settings.  Therefore, perform system configuration before making any other
settings.

Editing the Settings
Open the setting window of VR100, VR200, or VR200 S2 and click the appropriate tab or
select the setup item from the menu.
Unavailable items appear dimmed (you cannot enter values for them).  For details on
each setup item, see the respective recorder manual.
The following examples of windows are those of VR200.

“Channel Setting” tab
Double-clicking the “CH” cell in this panel opens the “Channel Setting” dialog box (see
page 7-11) for inputting values.  You can enter values in either the panel or the dialog
box.

Enter the constant 
to be used in the 
expressionEnter the scale

Pressig this bar closes/opens 
the "Constant" dialog box

Double clicking here
 shows the "Channel 
Setting "dialogo box

Set the span

Turn ON/OFF the square 
root computation

Turn ON/OFF the scaling

Select the range type

Select the input mode

Select the 
reference for 
the difference 
computation

Enter the alarm valueSelect the alarm type Select the relay number

Enter the display zone

Turn ON/OFF the partial expanded display Turn ON/OFF displaying the scale

Enter the tag name Enter the unit Enter the expression

• Mode
Input type.  Select “MATH” for a computation channel.



7-10 IM 04D05C01-62E

• Range
Measurement range.

• Scaling
Specify whether or not to use the function that converts the measured values into
other units for display.

• Square root computation
Specify whether or not to use square root computation.

• Span
The upper and lower limits of the display.

• Scale
The upper and lower limits of the display of scaling, square root computation, or
computation channel.

• Decimal position
The decimal position of scaling or the scale of the computation channel.

• Ref. channel
The reference channel for difference computation.

• Alarm 1 to 4
Alarm type, alarm value, and output relay.  Relay output is valid when the recorder
has the alarm relay output option.

• Zone
Upper and lower limits of the waveform display zone.

• Partial expanded display
Whether or not to partially expand the waveform, boundary value between
compression and expansion, the destination position of the boundary value.

• Scale display
Specify whether or not to display the scale.

• Tag
Tag name used when displaying tags.

• Unit
The unit of scaling, square root computation, or computation channel.

• Expression
The upper and lower limits of the display of scaling or square root computation
channel.

• Constant
Constant used in the computation.

7.4  Setting VR Series
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“Channel Setting” dialog box
This dialog box is designed to facilitate the input operation of the “Channel” tab panel.  It
appears when you double-click the “CH” cell in the “Channel” tab panel.

Pressing the “Operator” 
button shows the dialog 
box to select operators 
when “Mode” is set to 
“MATH”

“Misc.” tab panel
From this panel, set items regarding LCD, data file, trip level, wave span rate, and
messages.
The display contents are switched by selecting an item listed in the left part of this panel.

• LCD/Data File
Set the brightness of the LCD, the function to dim the backlight when there is no key
operation for a certain period of time, and how the file is named when saving a data
file to the floppy disk.

The backlight will 
be dimmed when 
there is no key 
operation for the 
time period set
 here.

Select how the file 
is named when 
saving a data file 
to the floppy disk.

7.4  Setting VR Series
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• Trip Level
Set the trip point.  This figure shows the “Trip Level” setting dialog box for VR200 S2.

Click to open the 
“Select Color” 
dialog box
(for VR200 S2 
only)

• Waveform Span Rate
This is the rate at which the displayed waveform is updated.

For VR200 S2
only

• Message (for VR200 S2 only)

Copy and paste 
messages

Sets whether or not to display the menu 
that executes the message display on 
the setup menu of the operation mode.

Up to 16 
characters

7.4  Setting VR Series
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• Daylight Saving Time
Set the “Summer Time” and “Winter Time.”

“SETUP” tab panel
From this panel, set items regarding alarm function, input processing, display, data
storage method, remote control, TLOG computation, communication, selection of
channel or tag display, message display language, memory end time, password, and
temperature unit.
The display contents are switched by selecting an item listed in the left part of this panel.

• Alarm Function
“Relay AND”: Select the relays that are to use the AND logic.

• Input Processing
Set the burnout action, the integral time of A/D converter, the reference junction
compensation function, the moving average, and the filter.

For VR106, VR206, 
and VR206 S2

For  VR104, VR204, 
VR202 S2, and VR204 S2

Copy and paste the channel settings

7.4  Setting VR Series
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• Display

Click to open the “Select Color” dialog box
• AUX

Switches channel display and tag display, selects the language used to display
messages, sets the remaining time of the memory when the memory end alarm is to
be generated, sets the password, and selects the temperature unit.

Number (4 digits or less)
The initial value is “0”

• Data Storage Method
The format used to write measured/computed data to memory.

• Math
Sets the statistical calculation (TLOG) timer and operation.

7.4  Setting VR Series
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• Remote Control (for VR200 S2 only)
Assigns a function to the input terminal of the remote control.

• Communication (only for models with the communication function)

Changing VR system configuration
If necessary, change the system configuration such as the presence or absence of
options to match the VR that is to be configured.
Changing the system configuration initializes the settings of the SET mode and SETUP
mode.  Perform changes in the system configuration first.
The changes in options are reflected in the “Recorder List” window.

Procedure
1. Open the setting window of the VR of which the system configuration is to be

changed, and select “System Configuration” from the “System” menu of the
“DAQLOGGER Hardware Configurator” window.  The “System Configuration” dialog
box opens.

2. Set the model, options, etc. to match the VR.
3. When you finish setting the parameters, click “OK.”  The setup parameters are applied

to the setup items in the tab panel.

7.4  Setting VR Series
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7.5 Setting µR Series

Changing any of the system configurations, will result in initialization of Hardware
Configurator settings.  Therefore, perform system configuration before making any
other settings.

Editing the Settings
Below are the settings windows for µR1000 and µR1800.  The items which cannot be set
are displayed in gray and you cannot input to them.
For details of each setting item, see the manual of the recorder.
The display examples in the following are those for µR1800.

“Channel” tab panel
Double-clicking the “CH” cell in this panel opens the “Channel Setting” dialog box (see
page 7-18) for input.
You can input from either the panel or the dialog box.

Enter the constant 
to be used in the 
expressionEnter the scale

Pressig this bar closes/opens 
the “Constant” dialog box

Double clicking here
 shows the “Channel 
Setting” dialogo box

Set the span

Turn ON/OFF the square 
root computation

Turn ON/OFF the scaling

Select the range type

Select the input mode

Enter the alarm valueSelect the alarm type Select the relay number

Select the reference for 
the difference computation

Enter the display zone

Turn ON/OFF the partial expanded display

Turn ON/OFF digital printing

Enter the tag name Enter the unit Enter the expression

Turn ON/OFF saving data to IC memory card

• Mode
Input type.  Select “MATH” for a computation channel.



7-17IM 04D05C01-62E

S
ettin

g
 th

e R
eco

rd
er

7

• Range
Measurement range.

• Scaling
Specify whether or not to use the function that converts the measured values into
other units for display.

• Square root computation
Specify whether or not to use square root computation.

• Span
The upper and lower limits of the display.

• Scale
The upper and lower limits of the display of scaling, square root computation, or
computation channel.

• Decimal position
The decimal position of scaling or the scale of the computation channel.

• Ref. channel
The reference channel for difference computation.

• Alarm 1 to 4
Alarm type, alarm value, and output relay.  Relay output is valid when the recorder
has the alarm relay output option.

• Zone
Upper and lower limits of the waveform display zone.

• Partial expanded display
Whether or not to partially expand the waveform, boundary value between
compression and expansion, the destination position of the boundary value.

• Print
Specify whether or not to print numerical values at specified times.

• Save IC
Specify whether or not to save data to the IC memory card.

• Tag
Tag name used when displaying tags.

• Unit
The unit of scaling, square root computation, or computation channel.

• Expression
The upper and lower limits of the display of scaling or square root computation
channel.

• Constant
Constant used in the computation.

7.5  Setting µR Series
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“Channel Setting” dialog box
This dialog box is designed to facilitate the input operation of the “Channel” tab panel.  It
appears when you double-click the “CH” cell in the “Channel” tab panel.

Pressing  the “Operator” 
button shows the dialog 
box to select operators 
when “Mode” is set to 
“MATH”

“Misc.” tab panel
From this panel, set the chart speed, dotting period, and message.
The display contents are switched by selecting an item listed in the left part of this panel.

Chart Speed/Dot Period (dot printing model)

For dot printing 
models

7.5  Setting µR Series
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Message

Up to 16 characters

Daylight Saving Time
Set the “Summer Time” and “Winter Time.”

Changing µR system configuration
If necessary, change the system configuration such as the presence or absence of
options to match the µR that is to be configured.

Changing the system configuration initializes the settings of the SET mode and SETUP
mode.  Perform changes in the system configuration first.
The changes in options are reflected in the “Recorder List” window.

Procedure
1. Open the setting window of the µR of which the system configuration is to be

changed, and select “System Configuration” from the “System” menu of the
“DAQLOGGER Hardware Configurator” window.  The “System Configuration” dialog

box opens.

2. Set the model, options, etc. to match the µR.
3. When you finish setting the parameters, click “OK.”  The setup parameters are applied

to the setup items in the tab panel.

7.5  Setting µR Series
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7.6 Setting DX/MV Series

Changing any of the system configurations, will result in initialization of Hardware
Configurator settings.  Therefore, perform system configuration before making any
other settings.

Editing the Settings
Below are the settings windows for DX100, DX200, DX200C, MV100, and MV200.  The
items which cannot be set are displayed in gray and you cannot input to them.
For details of each setting item, see the appropriate DX/MV series manual.
The display examples in the following are those for DX200.

“Meas” tab panel
Double-clicking the “CH” cell in this panel opens the “Channel Setting” dialog box (see
page 7-24) for input.  You can input from either the panel or the dialog box.
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7.6  Setting DX/MV Series

Select this tab
Double-click to set the channel

Difference computation
Scale

Square root

Select the input mode
Select the range/type

Select the alarm type

Select the relay number

Select sampling count

Turn ON/OFF the partial 
expanded display

Set the value to the minimum value possible

Set the value to the 
maximum value possible

Select the reference for the difference 
computation

Set the span

Enter the scale Enter the scale unit

Enter the alarm value

Enter the tag name
Enter the delay period

Enter the display zone
Select the graph setting

Select the channel 
display color

Initialize

Initialize

Set the value to the minimum value possible
Set the value to the maximum value possible

Turn OFF at once
Copy the settings of the first channel in the selected range to all other channels

Set the selected range at once

Turn ON/OFF at once
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Input Type (Mode and Range/Type)
Select from the list of choices from the pull-down menu.

Mode Relevant Settings

VOLT (voltage) Range, span L, and span U
TC (thermocouple) Type, span L, and span U
RTD (resistance temperature detector) Type, span L, and span U
DI (voltage level/contact input) Range, span L, and span U
SKIP (Measurement/Display OFF) None

Note
• When a value outside the range is entered or when the span L and span U values are set to

the same value, they are corrected when the data are checked.

• If SKIP is selected, settings such as Delta/Scale/Sqrt and Range/Type are discarded.

Difference Computation and Reference
Displays the difference between the input and the reference channel.
If difference computation is performed between channles that have different range and
type settings, the decimal position of the computed result is set to that of the channel
computing the difference.  If the number of digits to the right of the decimal of the
reference channel is greater than that of the channel computing the difference, the
reference value below the least significant digit of the channel computing difference is
rounded beforehand.

Display Span
Sets the upper and lower limits (full scale) of the display.
When the span L and span U values are set to the same value or when a value outside
the range is entered, they are corrected when the data are checked.

Scale
• Scale L, scale U, and decimal point

Scale’s value is displayed by taking the range between
When the scale L and scale U values are set to the same value or when a value
outside the range is entered, they are corrected when the data are checked.

• Unit
Enter the unit using up to six characters.

Square Root
Computes and displays the square root of the input.  This setting can be used only when
the input mode is set to VOLT (voltage).  As necessary, set the span, scale, and unit.

Alarm
Four alarms (Alarm 1 to 4) can be specified on each channel.
• Type

Select H, L, h, l, R, T or t.  T or t is selectable when the style number is greater than
or equal to 2.  The selectable alarms vary depending on the input mode and
computation type.  For details, see section 6.2 in the DX100/DX200/DX200C/
MV100/MV200 User’s Manual.

• Alarm value
Alarm is generated using the specified value as the boundary.  The selectable range
of alarm values vary depending on the input mode and range.

• Alarm delay
Alarm is generated when the measured value stays above or below the specified
alarm value for the specified time (delay period).

• Relay
To output relays, select the output relay number.  Otherwise, select [NONE].

7.6  Setting DX/MV Series
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Input Filter and Moving Average
Moving average can be specified on models DX106, DX112, DX210, DX220, DX230,
MV106, MV112, MV210, MV220, and MV230.
Input filter can be specified on models DX102, DX104, DX204, DX208, DX204C,
DX208C, MV102, MV104, MV204, and MV208.
• Input filter

To use the input filter, select the time constant (2 s, 5 s, or 10 s).
• Moving average

To use the moving average, select the sampling count (2 to 16).

Tag
Up to 16 characters can be entered for the
You can use the tag name instead of the channel name to be displayed on the screen.
The [Setup] screen is used to select whether to display the channel name or the tag
name on the screen.
If tag is selected in the [Setup] screen, you will be able to select tag No., tag
comment, or tag in the Data Monitor or Data Viewer.

Display Zone
You can select the range of the screen in which the waveform of each channel is to be
displayed.
Specify positions (%) on the display scale for the upper and lower limits.
The conditions for setting the
• Range: 0% to 100%

The lower limit must be less than the upper limit
• The difference between the lower and upper limits is at least 5%.

Graph
• Divisions

Select the number of bar
• Bar graph

Select the reference position of the
It is set back to [Normal] when the data are checked.

• Scale
When using scale display on the trend screen, select the position to display the scale.
For details related to divisions, bar graph, and scale, see section 7.10 in the DX100/
DX200/DX200C/MV100/MV200 User’s Manual.

Partial Expanded Display
• Position (%)

Set the boundary for the partial expanded display.  The range is from 1 to 99%.
• Boundary

The conditions used to set the boundary vary depending on the measurement and
computation channels as follows:
• Measurement channel

When SCALE and SQRT are not used: Span L < boundary < span U
When SCALE and SQRT are used: Scale L < boundary < scale U

• Computation channel
Span L < boundary < span U

Note
The partial expansion settings take effect when the partial expansion function is set to [Use]

in the [Aux] section of the [Setup] tab.

7.6  Setting DX/MV Series
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Display Color
You can select the display color of each channel from 16 colors.

Copying and Pasting Setup Data
The items checked in [Copy Details] can be copied and pasted.  Click the channel
number to select the copy source or paste destination.
To select multiple channels to be copied, drag the channel number to specify the
range to be copied.  To select multiple copy destinations, select the range in a similar
fashion.

“Meas Channel Setting” dialog box
This dialog box is designed to facilitate the input operation of “Meas” tab panel.  It
appears when you double-click the “CH” cell in the “Meas” tab panel.
This dialog box contains the two tab panels, “Meas Channel Setting” and “Display.”
• Meas. Channel Setting

2. The channel setting 
dialog box opens.

3. Select the tab of the item 
to be configured.

4. After setting the 
items, click here.

1. Double-click the 
channel you wish to set.

7.6  Setting DX/MV Series
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“Math” tab panel
Double-clicking the “CH” cell in this panel opens a dialog box for input.
You can input from either the panel or the dialog box.

Double-click when setting each channel
Select this tab

Set the alarm (section 3.2)

Enter the tag (section 3.2)Enter the alarm period

Display zone (section 3.2)
Set the graph (section 3.2)

Partial expansion (section 3.2)
Display color (section 3.2)

Turn ON/OFF computation

Select the number of digits to the right the decimal

Enter the expression

Set the display span (6 characters or less)
Enter the unit

Enter the constant to be 
used in the expression

Turn ON/OFF at once
Copy the settings of the first channel in the selected range to 
all other channels

Initialize

Copy the settings of the first channel in the selected range to all other channels

Turning ON/OFF Computation
Select whether or not to perform computation for each channel.

Expression
Enter the expression using up to 40 characters.  For details related to the expression,
see the DX100/DX200/DX200C/MV100/MV200 User’s Manual.

Display Span
Sets the upper and lower limits of the display.
The range is from -9999999 to 99999999.  Set the number of digits to the right the
decimal to four digits or less.

7.6  Setting DX/MV Series
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Alarm and Tag
The settings are the same as the measurement channels.  For details, see section 3.2,
“Setting the Measurement Channel.”

TLOG Computation
• Timer

Select one of the timers (1 to 3) set in the setup mode.
The computation interval of TLOG computation is set to the time assigned to the
selected timer.

• Sum scale
Set the sum scale.

Rolling Average
• Interval

Select the sampling interval when rolling average is activated.
• Times (Number of samples)

Select the number of samples (number of data points used to compute the rolling
average).

Display Zone, Graph, Partial Expansion, and Color
The settings are the same as the measurement channels.  For details, see section 3.2,
“Setting the Measurement Channel.”

Constant
You can set constants to be used in the expression.  Up to 12 and 30 constants can be
specified on the DX100/MV100 and DX200/DX200C/MV200, respectively.

7.6  Setting DX/MV Series
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“Math Channel Setting” dialog box
This dialog box is designed to facilitate the input operation of the “Math” tab panel.  It
appears when you double-click the “CH” cell in the “Math” tab panel.
This dialog box contains the two tab panels of “Math Channel Setting” and “Display.”
• Math Channel Setting

2. The channel setting 
dialog box opens.

1. Double-click the channel 
you wish to set.

3. Select the tab of the item to be configured.
Click here to enter 
the operator

4. After setting the items, 
click here.

Set the maximum value.
Set the minimum value.

Copy the first setting.

Select Operator dialog box

Operator button

Select the operator type and click the operator button

7.6  Setting DX/MV Series
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“Setting” tab panel

Select this tab

Select the time per 1 division

Select the display format of 
the trend and bar graph

Recover by a key operation

Recover by a key operation 
or alarm occurrence

The screen saver function is activated, 
when there is no key operation or alarm 
occurrence for the specified time period.

Note
If you selected MV100 in the “System Configuration” dialog box, “User key” on the “Setting”

page will not be displayed.

Display update interval
You can select the display update interval from 1 min/div, 2 min/div, 5 min/div, 10 min/
div, 20 min/div, 30 min/div, 1 h/div, 2 h/div, and 4 h/div.  In addition to these selections,
15 sec/div and 30 sec/div can also be selected on the MV102, MV104, MV204, and
MV208 when the style number is greater than or equal to 3.

Auto save interval
The auto save interval can be specified when the [Ssave] is set to [Auto] and the data
type is seto to [DISPLAY] or [EVENT&DISP] in the memory sample section of the setup
tab.

7.6  Setting DX/MV Series
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Auto scroll time
This is the time period used to automatically switch the displayed group.  It can be
specified when the style number of the DX or MV is greater than or equal to 2.

Normal trend display
Circular display

Set the time 
corresponding 
to one cycle on 
the circular 
display

clear the entire waveform when one cycle of the waveform 
has been recorded.

one scale mark of the old waveform is cleared 
when the remaining amount of waveform 
reaches one scale mark 

• Message/File

Click here (also selectable from 
[Setting] - [SET [Regular] Setting])

Enter the message

Copy the entered message

Paste to another message 
number

Enter the comment
Enter the save destination 
folder

Message
Up to 16 characters can be entered for the message.

File header
Adds a comment to the header section of the measurement/computation data file.

Director name
Set the name of the folder in which the measurement/computation data files is to be
saved.

Note
• Up to eight characters can be entered for the file header and director name.  AUX, CON,

PRN, NUL, and CLOCK cannot be used.

• If the directory name is not specified, DATA0 (default) is automatically set.

Manual save
Select whether to save all the data or data that have not been saved during manual
save.

7.6  Setting DX/MV Series
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• Group/Trip Line
Click here (also selectable from 
[Setting] - [SET [Regular] Setting])

Select the tab of the group 
to be configured.

Check the channels that you wish to register in the selected group (blue: ON)

Select the color of 
the trip line

Enter the group name

Set the trip line by dragging

Set the trip line by 
entering a value

Turn ON/OFF the trip line display

Group name
Up to 16 characters can be entered for the group name.

Number of channels
The maximum number of channels that can be assigned to a group is 10 and 6 for
DX200/DX200C/MV200 and DX100/MV100, respectively.  The assigned channels are
listed under [Channel Configuration].
If no channels are specified, CH01 is automatically assigned.

Trip line
Up to four trip lines can be seto to one group.
With regard to the trip lines set here, the first and second settings (No.1 and No. 2) refer
to the trip lines in the Data Monitor and Data Viewer.  If you change them here, they will
also change in the Data Monitor and Data Viewer.

7.6  Setting DX/MV Series
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• View Group (for DX200, DX200C, MV200)
Assign screens to 4 screen display.

Click here (also selectable from [Setting] - [SET [Regular] Setting])
Enter the view group name

Select the type of screen to be displayed

Select the group to be displayed

Type of screens 
available

or drag & drop

View group
Up to four view groups can be registered.

Group name
Up to 16 characters can be entered for the group name.  The specified group name
appears as a sub menu of the [4 Panel] display of the DX200/MV200.

Screen type
The view group is made up of four screens.  Select the type of screen to display in each
screen.

• User Key (DX100, DX200, DX200C, and MV200 Only)/Day Light Saving/Batch
(Option, when the Style Number is Greater than or Equla to 2)
Batch function can be set on models with the style number 2 or greater.

Select the function to be assigned to the USER key

Select either one

Enter usint up to 
16 characters.

Enter the value 
in the range 
from 0 to 9999

7.6  Setting DX/MV Series
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“Setup” tab panel
From this panel, set items regarding alarm/relay/remote, scan interval/memory, channel,
key lock/login, timer, report, temperature, AUX, and network.
The display contents are switched by selecting an item listed in the left part of this panel.

• Alarm/Relay/Remote

Select the controlled item

Select from 1 to 
15 times

Copy/Paste the 
selected range

Alarm
Select the alarm format.  The selected items become blue.

Relay AND
Set the range of relays (from the first alarm relay) to take the AND logic.  All other relays
will be set to OR logic.  If [NONE] is selected, all relays will operate using the OR logic.

Remote (Option)
You can assign items to be controlled by the eight remote control terminals.  This is
possible, if the remote function is available.

7.6  Setting DX/MV Series
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• Scan Interval/Memory

Set these parameters when the data type is set to "EVENT & DISP" or "EVENT"

Check the channels you wish to sample

Scan interval
The selectable scan intervals vary depending on the model as follows:
DX102, DX104, DX204, DX208, DX204C, DX208C, MV102, MV104, : 125 ms and
MV204, and MV208  250ms
DX106, DX112, DX210, DX220, DX230, MV106, MV112, MV220, : 1 s and 2 s
and MV230

A/D Integrate
100 ms can be selected only when the scan interval is set to 2 s.

Memory Sample (save method of measured/computed data)
• Number of blocks

When the data type is [EVENT], select 1, 2, 4, 8, or 16.
When the data type is [EVENT&DISP], select 1, 2, or 4.

• Pre-Trigger Length
If 0% is selected, the event file will entirely consist of data after the trigger.  If 100% is
selected, the event file will entirely consist of data before the trigger.

• Memory Sample
Select the channels that are to be saved to the memory.

Note
If [Save] is set to [Manual], the data directory is created at a location that cannot be managed

by the DAQ Desktop.  Therefore, the DAQ Desktop cannot be used to handle data files in that

directory.

7.6  Setting DX/MV Series
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7.6  Setting DX/MV Series

• Channel (Setting the Burnout and RJC)
Set to the positive side (100%)

Set to the negative side (0%)
Set the reference junction compensation 
to internal or external

Burnout
For thermocouple (TC) inputs, select how the measurement results are to be handled
when the thermocouple burns out.

RJC Volt (uV)
When the reference junction compensation is set to [External], set the compensation
value in the range from –20,000 to 20,000.

Copying and pasting setup data
The items checked in [Copy Details] can be copied and pasted.  Click the channel
number to select the copy source or paste destination.
To select multiple channels to be copied, drag the channel number to specify the range
to be copied.  To select multiple copy destinations, select the range in a similar fashion.
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7.6  Setting DX/MV Series

• Timer (Option)
You can set three timers to be used in the statistical (TLOG, option) computation.

Select one

Reset computation when a timeout occurs
Save the data to the TLOG file when a timeout occurs.

Select the timeout time

Time out with the specified 
time as the reference

Timeout every time the specified time elapses

You can set three types of timers to be used in the statistical computation.  You can have
the data saved to a TLOG file or reset the computation when the specified timeout time
elapses.
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7.6  Setting DX/MV Series

• Key Lock/Login

Check when using login, auto logout, and user ID.
Turn ON when using user settings

DX100/DX200/DX200C/MV200 configuration screen

MV100 configuration screen

Setting the key lock
• Key Lock

When using the key lock function, select whether or not to activate the key lock
function (lock or free).

• Password
Enter the password used to release the key lock using up to six characters.  [???] is
displayed after the password is entered.

Setting the login
• User name

Up to 16 characters can be entered for the user name.
• User ID

Up to 4 characters can be entered for the User ID.  [???] is displayed after the
password is entered.

• Password
Up to 6 characters can be entered for the password.  [???] is displayed after the
password is entered.

• Setup
Select whether or not to allow setting changes in the setup mode.

Note
• If there is a duplicate [User Name] that is turned ON, the user with the larger user number is

turned OFF.

• If [Setup] of all users that are turned ON is set to [Disable], the [Setup] of the user with the

smallest number is set to [Enable].
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7.6  Setting DX/MV Series

• Report (Creating Hourly/Daily/Weekly/Monthly Reports)
Set the date and time at which to create the report

Enable (ON)/Disable (OFF) the report channel settings

Select the channel to be reported

Report channel
There are 30 channels and 12 channels on the DX200/DX200C/MV200 and DX100/
MV100, respectively.

Converting the reference unit time
Select whether or not to convert the computed results of the TLOG.SUM computation
channels to a specified time unit value.  Select [Off (no conversion)], [Sec (seconds)],
[Min (minutes)], or [Hour (hours)].

Copy
For details related to the copy/paste function, see page 7-7.
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7.6  Setting DX/MV Series

• Temperature/Aux/Time zone

Click either “Temperature,” “AUX” or “Time zone.”

Temperature
Select the °C or °F for the temperature unit.

Tag/Channel
Select whether to use the tag name or channel number as the measurement/
computation channel label (See “Selecting the Characters Used to Identify Channels”).
If you select tag name, you can select the label display from tag and channel.

Memory alarm time
Free space in the internal memory is monitored, and the memory full relay can be
programmed to activate some period of time before the memory is completely full.  This
time period is called the memory alarm time.

Displayed language
Select the language to be used on the display.
The types of displayed language vary depending on the style number of the DX or MV.  If
the style number is greater than or equal to 2, you can select German or French in
addition to English and Japanese.

Partial expanded display
If the partial expanded display is set to [Not], the partial expanded display settings of the
Meas/Math tab are void.

Batch function (option)
You can set the batch function when the style number of the DX or MV is greater than or
equal to 2.

Time zone
Set the time zone in the range from –12:00 to 12:00.
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7.6  Setting DX/MV Series

• Network (TCP/IP)

Set the IP address

Enter the timeout value when turned ON

Set these addresses when using the DNSSelect this tab

When communicating with the DX/MV via Ethernet, the IP address, subnet mask, and
default gateway must be set on the DX/MV beforehand.

• Network (FTP)

Select the file transfer destinationSelect this tab

By using the FTP function, you can automatically transfer the measured/computed
data files to the specified server.
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7.6  Setting DX/MV Series

• Network (Serial)

Select this tab

Set the protocol to MODBUS or MODBUS MASTER.
MODBUS:
MODBUS MASTER:

Modbus slave protocol
Modbus master protocol

• Network (Modbus master)

Select this tabSet Read cycle, Timeout, and Retrials

Turn ON/OFF the command

Set using an integer in the range
1 to 247

Set using an integer in the range
30001-39999, 40001-49999,
300001-365535, and 400001-465535

Set the variable type

Specify in the range
C01 to C12 for the DX100/MV100
C01 to C30 for the DX200/MV200
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7.6  Setting DX/MV Series

• Network (Web)

Select this tabWhen Operator is selected

When Monitor is selected

Set up to 6 characters

Set up to 16 characters

If ON is selected, the parameters under Operator and Monitor can be specified.



7-42 IM 04D05C01-62E

7.6  Setting DX/MV Series

• Network (E-Mail)

Select this tabWhen Alarm is selected

When Scheduled is selected

When System is selected

When Report is selected

Select the alarm to be
transmitted when an
alarm occurs.

Set up to 64 characters
Set up to 32 characters.

SMTP server: Set up to 64 characters
Port number: Set in the range 0 to 65535
Recipient1/2: Set up to 150 characters
Sender: Set up to 64 characters

Set the reference time for mail
transmission
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7.6  Setting DX/MV Series

Changing DX/MV system configuration
If necessary, change the system configuration such as the presence or absence of
options to match the DX/MV that is to be configured.
Changing the system configuration initializes the settings of the SET mode and SETUP
mode.  Perform changes in the system configuration first.
The changes in options are reflected in the “Recorder List” window.

Procedure
1. Open the setting window of the DX/MV of which the system configuration is to be

changed, and select “System Configuration” from the “System” menu of the
“DAQLOGGER Hardware Configurator” window.  The “System Configuration” dialog
box opens.

• DX

• MV

2. Set the model, options, etc. to match the DX/MV.
3. When you finish setting the parameters, click “OK.”  The setup parameters are applied

to the setup items in the tab panel.
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7.7 Setting DARWIN

Changing any of the system configurations, will result in initialization of Hardware
Configurator settings.  Therefore, perform system configuration before making any other
settings.
If you wish to change the module configuration, see “Changing Module configuration.”

Selecting Setting Screen
Settings screen contents differ depending on whether a DA100, DC100, or DR is the
object.  Select a setting screen by selecting Settings > SET (Regular) Settings, or
Settings > SETUP (Basic) Settings, followed by the desired setting item; or by clicking a
contents tab.  Below examples of instrument setting screens.

DA100

DC100

DR

For details on each setup item, see the respective recorder manual.

Setting Input Range, Span, and Linear Scaling
Double-clicking the “CH” cell in these panels opens the “Channel Setting” dialog box for
inputting values.  You can enter values in either the panel or the dialog box.
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Mode (input type)

Scale ON/OFF

Power monitor wiring
Power monitor input range

Scale left

Scale right

Span left

Span right

Measurement range

Scale unit

Reference channel for Delta or RRJC mode

Selecting the Range and Type of Input
The following types of input can be selected.  The default setting is VOLT.
• SKIP

Measurement, data saving and display (except for page display) will not be carried
out.  Measurement, data saving and display will be carried out for the next channel
whose input type is not set to SKIP.

• VOLT (DC voltage)
This input type can be selected from 20mV, 60mV, 200mV, 2V, 6V, 20V and 50V.
Refer to chapter 14 for the measurement range of each setting.  The default setting is
2V.

• TC (thermocouple)
This input type can be selected from R, S, B, K, E, J, T, N, W, L, U and KP
(KPvsAu7Fe).  Refer to chapter 14 for the measurement range of each setting.  The
default setting is R.

• RTD (resistance temperature detector)
This input type can be selected from PT1 (Pt100 1mA), PT2 (Pt100 2mA), JPT1
(JPt100 1mA), JPT2 (JPt100 2mA), PT50 (Pt50 2mA), NI1 (Ni100 1mA SAMA), NI2
(Ni100 1mA DIN), NI3 (Ni120 1mA), CU1 (Cu10 GE), CU2 (Cu10 L&N), CU3 (Cu10
WEED), CU4 (Cu10 BAILEY), PT1S (Pt100 1mA high resolution), PT2S (Pt100 2mA
high resolution), JPT1S (JPt100 1mA high resolution), JPT2S (JPt100 2mA high
resolution) and J263B (J263*B).  Refer to chapter 14 for the measurement range of
each setting.
The default setting is PT1.

• DI (select LEVL (voltage level) or CONT (contact)
For LEVL, a voltage of less than approx. 2.4 V will be recognized as “0 (OFF),”
whereas a voltage of approx. 2.4 V or more (max. allowable voltage is up to ±60 VDC)
will be recognized as “1 (ON).”
For CONT, an open, externally connected contact to which no voltage is applied, will
be recognized as  “0 (OFF),” whereas a closed contact will be recognized as  “1
(ON).”
The default setting is LEVL.

• mA (DC current, mA input module)
This input can be set only for mA input channels.  The measuring range is -20 mA to
20 mA.

7.7  Setting DARWIN
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• AC Power monitor
• Setting the Wiring Method for the power monitor

Select from the following methods:
Single-phase two-wire (1Ph2W)
Single-phase three-wire (1Ph3W; 3-wire input modules only)
Three-phase three-wire 2 Voltage 2 Current (3Ph3W-2I; 3-wire input modules
only).
Three-phase three-wire 3 Voltage 3 Current (3Ph3W-3I; 3-wire input module only).
Three-phase four-wire (3Ph4W; 3-wire input modules only).

• Setting the Input Range
Select from the following ranges: 250V-0.5A/250V-5A/25V-0.5A/25V-5A.
This setting is common to all channels.  Any change to this setting also changes
the settings of the rest of the channels.  Impose a voltage or current signal to the
input module within the limits you set here.

Note
If the connection method or input range is changed, alarm setting is turned off.

• Strain
The measurement mode should be 2 k, 20 k, or 200 k.  The measuring ranges are as
shown below depending on the measurement modes and gauge methods.

Gauge method 2 k 20 k 200 k

1-gauge method -2000 to 2000 µε -20000 to 20000 µε -200000 to 200000 µε

2-gauge method -1000 to 1000 µε -10000 to 10000 µε -100000 to 100000 µε
4-gauge method -500 to 500 µε -5000 to 5000 µε -50000 to 50000 µε

Note
If you have connected any new strain gauge or changed the measuring range initial balancing

is necessary (Initialization of settings or reconfiguration of the system also changes the

measuring range back to its default).

• PULSE (not possible for DR130/231/241)
Select the RATE or GATE range.

• DELTA (difference between channels)
Computation can be done only in the same unit.  Destination channels should lie
within the first channel No. to the last channel No. range.  The number of the
reference channel (REF) should be lower than the number of the destination
channels.  The default setting for the reference channel is 01.
The type of input and the measuring range in the destination channel are the same as
for the reference channel.  After setting the DELTA (difference between channels), if
you attempted to change the type of input and the measuring range, setting the
difference between channels is released, thereby the type of input and the measuring
range in the destination channel are returned to their original settings, and the span is
returned to its initial value.

• RRJC (Remote RJC, available for instruments with the optional MATH function, only)
Reference channel (RJC): Within the setting range of reference channel No.
TC (thermocouple) must be selected as the type of input to the reference channel.
If the channel No. or type of input for the reference channel, or the type of
thermocouple is changed, the alarm function will be turned OFF.

7.7  Setting DARWIN
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If the type of input for the reference channel or the type of thermocouple is changed,
the RRJC settings will be cleared and the type of input and measuring range for the
reference channel will be set to the one which was in effect before the change was
made.  The span will be set to the initial value of the measuring range.

Setting the Span
The measurement range is decided according to the type of input.  The left and right
span must lie within the measurement range.  However, the span is 0 to 1 for the DI
input type.
For the remote RJC, the setting range for span is the same as that for the reference
channel.
Click the “Range Information” tab on the single channel specific setting screen, to refer
the type of input and the measurable range.

Selecting the Input Type for Linear Scaling
The input type can be selected from the following.
• VOLT (DC voltage)
• TC (thermocouple)
• RTD (resistance temperature detector)
• DI (contact)
• mA (DC current)
• AC (Power Monitor
• STRAIN
• PULSE (For pulse, scaling setting is insufficient)

Setting Linear Scaling Values (SCL)
The left scaling and right scaling values are set following the left and right span values of
the span menu.  The value on the left side of the SCL menu shows the left scaling value,
and the value on the right side of the SCL menu shows the right scaling value.  The
setting ranges from -30000 to 30000.
• Set the number of digits to the right the decimal to four digits or less.
• The default settings are 0.00 for the left span and 100.00 for the right span.

Setting the power monitor channel number
This procedure sets the channel number for which you want to show and record the
values of a parameter selected from the effective voltage, effective current, active power,
reactive power, apparent power, frequency, power factor and phase angle which were
calculated using the measured data.  Therefore, it does not correlate with the terminals
of an input module.

Setting power monitor parameters
A power monitor module measures the voltage or current through the respective
channels.  The values that are shown and saved are not those of the voltage and current
being actually measured through each channel but the values of the parameters you set
here.
A combination of parameters being measured is fixed for each group of channels 1-2, 3-
4 and 5-6 within the same module.  For example, setting channel 1 to P1 (active power
1) sets channel 2 to VA1 (apparent power 1).  In addition, the configurable parameters
being measured varies depending on the wiring method selected.

Setting the Span for the power monitor
Set the left and right spans within the limits of the measuring range specified by the
“Input Range.”  In the SPAN menu item, the left-hand value is the left span and the right-
hand value the right span.

7.7  Setting DARWIN



7-48 IM 04D05C01-62E

Precautions in Power Module Measurement
Input the voltage or current being measured at a level between 10% and 100% of the
measuring range.  The instrument bases its calculations of all other parameters on the
frequency of V1.  Extra care must therefore be taken when setting the input level of V1.
If the input level fails to fall within the given limits, there is no guarantee that the
measurement of any other parameters will be reliable.

Setting the Reference channel
Set the reference channel when “DELTA” or “RRJC” is set to “Mode.”

Setting the Unit
Set the Unit you want to use for calculation using maximum 6 alphanumericals or the
symbols :, #, %, &, ( ), *, +, -, ., and /.
When the setting parameters are loaded via communication from the connected
recorder, or imported from FD, Ω and 

Ω

 are replaced to “space,” and e to e.

Setting Alarm
Alarm item 

Alarm relay

Alarm value
Alarm type

Selecting the type of alarm
Select an alarm type for each alarm number from among the following:
• OFF (default set):  No alarm is set.
• H:  Upper-limit alarm
• L:  Lower-limit alarm
• RH:  Rate-of-change upper-limit alarm
• RL:   Rate-of-change lower-limit alarm
• dH:  Difference upper-limit alarm
• dL:  Difference lower-limit alarm

Note
• Alarms can’t be set if the input type is SKIP, or if the Math channel mode is OFF.

• If you make below changes, channel alarms will automatically be switched OFF:

•  Input type.

•  Measurement range.

•  Reference channels of inter-channel computations.

•  RRJC reference channels, reference channel inputs, or thermocouples.

•  Setting Math channels ON, OFF, Math equations

Setting alarm values
Set one alarm value for each alarm number within the specified range, depending on the
type of input.

Setting Relays (Internal Switches)
Select the desired alarm output relay or internal switch (S01 to S60).

Note
As for the DA100 with the style number 8 or later,  if you set an alarm relay as a relay to be

turned ON or OFF externally,  you cannot select this relay for the alarm output.

7.7  Setting DARWIN
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Selecting the Alarm Printout (DR only)
This setting can be selected from the following.  The default setting is ON2.
OFF: Alarm printout will not be carried out;
ON1: Alarms will only be printed out on occurrence.
The alarm occurrence mark, channel No. or tag, type of alarm, alarm heading or time of
occurrence will be printed with trend recordings.
ON2: Alarms will both be printed out on occurrence and release.
The alarm occurrence/release mark, channel No. or tag, type of alarm, alarm heading or
time of occurrence/release will be printed with trend recordings.

Alarm print ON/OFF

Message setting

Selecting a Message Printout  (DC100, DR only)
This setting specifies whether to print a message on alarm occurrence, and if so, which
message will be printed.  The default setting is OFF.
OFF: No message will be printed.
See also “Setting Messages (DC100, DR Only).”

Setting Moving Average and Filter

Moving Average (MOVE AVE)
Moving average can be set for each channel individually.  The number of samples used
for the moving average can be set from 2 to 64.

Filter Settings
Setting the Filter ON can eliminate pulse chattering of up to 5 ms.

Recording-related Settings (DR Only)
In this Section the following recording-related setting for DR:
• Recording zones
• Partially expanded recording
• Interpolation
• Trend recording
• Digital printout ON/OFF
• Manual printout ON/OFF
• Scale printout ON/OFF
• List printout ON/OFF

7.7  Setting DARWIN
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Left recording zone
Right recording zone

List print ON/OFF

Scale value print ON/OFF
Manual print ON/OFF

Digial print ON/OFF
Trend recording ON/OFF

Baundary value
Interpolation ON/OFF

Partially expanded 
recording settings

Setting Recording Zones (ZONE)
The set left and right position of the zone correspond to the left and right span set at the
SPAN menu (recording span).  The minimum width of a zone is 5mm.  No decimal
points.
This setting can also be made for computation channels A01 to A60.

Partially Expanded Recording (PARTIAL)
This setting specifies whether to carry out partially expanded recording, and if so, which
percentage of the recording span will be compressed and the corresponding boundary
value.
This setting can also be made for computation channels A01 to A60.
• Notes on Partially Expanded Recording

• Partial recording cannot be carried out if the input type of the computation channels
is SKIP or DI or if the computation channels are OFF.

• Partially expanded settings will be automatically canceled when either of the
following changes occur.

• the input type has been changed;
• the measurement range has been changed;
• the recording span has been changed;
• linear scaling settings have been changed;
• the reference channel for difference between channels has been changed.

Interpolation (INTERPOL)
This setting can also be made for computation channels A01 to A60.  The default setting
is OFF.

Trend Recording
Recording can be set ON/OFF per channel.  The default setting is ON.

Digital Printout Setting (DIGITAL PR)
This setting applies to the digital print of the analog mode and logging mode.

Manual Printout Setting (MANUAL PR)
OFF: Manual printout will not be carried out for this channel;
ON: Manual printout will be carried out for this channel.
This setting can also be made for computation channels A01 to A60.

Scale Printout (SCALE PR)
The scaled values will be printed out with trend recordings.  This setting can also be
made for computation channels A01 to A60.

List Printout (LIST PR)
Setting information per channel will be printed. Starting a list printout can be done at the
PRINT menu.  This setting can also be made for computation channels A01 to A60.

7.7  Setting DARWIN
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Selecting Channels to Save (for DC100, and DR with FDD Option Only)
To save measurement data of the DC100, or a DR with FDD Option, to a floppy disk,
data will first be saved to an internal RAM disk.

Select here the channels to be saved

Tag Settings (DC100 or DR Only)

Tag setting

Set a tag in the setting area below the Tag label.  Maximum amount of alphanumerics for
DC100: 8; for DR: 16. Additionally allowed symbols #, %, &, ( ), *, +, -, ., and /.

Making Settings Per Channel
The settings in “Channels” screen can also be carried out per channel.  To open a single
channel-specific setting screen, double-click the desired channel number, displayed on
the left side of the Channels setting screen.

7.7  Setting DARWIN
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If a DR is connected, you can make print settings in the setting screen that appears
when clicking the About Printing tab.

Click the “Range Information” tab to refer the type of input and the measurable range.
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For power monitor channels, click the Power Module Information tab.

Setting Math Channel Equations
Math channels can be set on DARWIN recorders with the computation function (/M1) or
the Pulse Module, or DR with FD driver.

Math channel ON/OFF Equations Left and right span Unit

Making Settings Per Channel
The settings in “Channels” screen can also be carried out per channel.  To open a single
channel-specific setting screen, double-click the desired channel number, displayed on

the left side of the “Channels” screen.

Computation equation
In addition to operators in the Operators Selection dialog box the following symbols can
be used in equations:
(/): Used for (  ) setting.
K: Used if equations contain constants K01 to K60.
M: Used to specify the measurement channel No. for which the data saved on the RAM

disk is to be regenerated.  Applicable for the DR232-1/DR242-1 equipped with a
floppy disk drive.

A: Used to specify the computation channel No. for which the data saved on the RAM
disk is to be regenerated.  Applicable for the DR232-1/DR242-1 equipped with a
floppy disk drive.

C: Used to specify communication input data (digital data).
G: Used to specify the group No. for which CLOG (computation of data of a group

measured on the same time) is to be used.

7.7  Setting DARWIN
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F: Used to specify the flag on DC100 with the style number 7 or later, and DA100 and
DR with the style number 8 or later.

Restrictions in equations
• The specified computation equation for a computation channel No. can contain only

computation channel Nos. as variable which are equal to or smaller than said
computation channel No.
(Example) A02=001+A01
In this example, any computation channel No. which is equal to or greater than A03
cannot be used.

• Either TLOG or CLOG can be used in an equation.

Note
• Each equation must consist of up to 40 characters.

• The total number of channels and constants to be used for each equation is 16 or smaller.

Span
Set the display/recording span in the -9999999~9999999 range.  The number of digits to
the right the decimal is four digits or less.

Unit
Set the Unit you want to use for calculation using maximum 6 alphanumericals or the
symbols #, %, &, ( ), *, +, -, ., and /.

Setting Retransmission Output (only DA/DC)
Assign channels to the retransmission outputs when the retransmission module is used.
For the setting of the output filter, see “Setting Filter of Retransmission Output.”
To open the Retransmission Output Channels setting screen, click the “Retransmission”
button on the Channels tab screen or Math tab screen.

Click to open 
“Retransmission 
Output Channels” 
dialog box

Click to open a list 
box for selecting 
the channel

7.7  Setting DARWIN
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Setting Constants
Constants are used for computation equation on models with computation function (/M).
Up to 60 constants (K01 to K60) can be set (Thirty constants (K01 to K30) for the
standalone type).
The number of significant digits is 5 excluding the decimal point.  If an exponent is used,
the mantissa and exponent must consist of 5 digits and 2 digits, respectively.
• Configurable ranges:

-1.0000E+35 to -1.0000E-35
0
1.0000E-35 to -1.0000E+35

Constants tab

Selecting Events
Event/Action and Match Time settings are possible for the DA100, if  the (/M1) Math
option is being used, or if a pulse module is attached.
For DA100 and DC100,  Group settings are possible if the Math option is being used.

Group settings

Match time settingsAction settings
Edge/Level settingsEvent settings

Remote, Relay, Timer, and Match Time number settings

Event
Select any event from among the following:
NONE  — releases the event/action setting.
REMOTE
• This menu is displayed only with the DI/DO modules that are recognized as system

modules.
• When a remote control signal is applied, the action is executed.
• There are 12 control signals available.  Select any control signal from these numbers

for event setting.  Remote control signal terminal numbers are applicable for this
selection.
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ALARM
If an alarm occurs, the action is executed.

RELAY
If the selected internal switch or relay is operating, the action is executed.  When the
alarm module or the DI/DO modules are not recognized as system modules, the relay
is set to OFF.

CHART END
When the end of the chart is detected, the action is executed.

FILE END
When the end of file (the time when the writing operation is terminated and the file is
closed) is detected, the action is executed.

TIMER
• If the selected timer’s set time is up, the action is executed.  Six timers are available.

Select any from among these timers.  See page 7-59, “Setting Timers and Summer/
Winter Time.”

• In combination with the level action, the action is repeated alternately between
executing and stopping each time the timer’s set time is up.

MFUNC KEY
• When the M.FUNC key on the operation panel is pressed, the action is executed.
• In combination with the level action, the action is repeated alternately between

executing and stopping each time the M.FUNC key is pressed.
MATCH TIME

Match time setting allows you to preset a time to start/stop event/action functions.  Set
the Action you want to happen in the Action setting space.

Match Times Setting
• There are three types of applicable Match Times.  Select any of them in the Match

time dialog box on the right of the event/action setting screen.
Select the day and time you want the Match Time event to occur.  If the day is set to
0, events will occur every day at the set time.

• In combination with the level action, the corresponding action is repeated alternately
between executing and stopping for each set time.

Selecting Edge or Level Action
Edge action (EDGE)
This action is executed when an event is detected.
Level action (LEVL)
This action is executed when an event is detected.  When an event is released, this
action will be canceled.
• An edge action and a level action cannot be set at the same time.
• For a level action, only one setting can be made.

Selecting Actions
Actions may be selectable depending on earlier Events and Edge/Level action settings.
The following describes all available actions:
ALARM ACK
This allows alarm acknowledgment.
ALARM RST
Resets alarms. When the “RELAY” is selected for an event, this function cannot be
selected.
TIMER RST
Resets timers.
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RECORD (DR only)
• ON: Starts recording.  The recording format is set individually.  For details, see

“Setting the Recording Format,” on page 7-70.
• OFF:  Stops recording.  The level action does not include record ON/OFF functions.
• When the level action is set, the ON/OFF functions using the RECORD key are

disabled.
• The edge and level actions cannot be set simultaneously.
• For the level action, only one action is available.
MANUAL PR (DR only)
Enables manual printing.
DIGITAL PR (DR only)
• Digital printing starts in the analog trend mode.  The recording intervals depend on the

timer setting (see page 7-59).  When the event/action functions are set, normal digital
print functions are disabled.

• Only one setting can be made in the event/action function.
MSG PR (DC100, and DR only)
• Prints messages.
• Select any message from the corresponding codes 01 to 20.
MSG DISP (DC100, and DR only)
• Displays messages.
• Select any message from the corresponding codes 01 to 20.
• To cancel the message display, press any key.
SPEED CHG (DR only)
• Changes chart speed 1 to chart speed 2.  When the recording interval is set to

automatic, the recording interval is also changed.  When the event is released, the
chart speed and recording interval return to their original positions.

• Only one setting can be made in the event/action function.
GR TREND (DR only)
• This executes the recording in a channel in which the group setting has already been

made.  For this, set the dot-recording to “GROUP” and start recording by key
operations following the “RECORD” given above.

• Select any group from G01 to G07.
• Only one identical group can be set in the event/action functions.

Note
• If Chart End appears, counter-actions such as RECORD ON are not executed.

• Actions such as RECORD or SPEED CHG may operate later than an event occurrence.  For

example, with RECORD set in the action setting, if an alarm occurs, the measured values in

that condition are not recorded.  This is because recording operations are delayed due to an

action operation.

MATH (for instruments with /M1 option or FDD option only)
• START : Starts computation.
• STOP : Stops computation.
• RESET : Resets computation channel data at the end of completion of the first

computation in case an event takes place.
• CLEAR : Resets computation channel data immediately in case an event takes place.
• If MATH is selected as a level action, computation will be carried out while an event is

present. Computation will stop when the event is cleared.
MEMORY (for DC100, and DR with FDD option only)
DR with FDD option
• DATA_WR : Saves a data item each time an event occurs, until the specified data

length is reached.
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• WR_TRIG : Saves measured/computed data on the built-in RAM disk.
• RD_TRIG : Reads measured/computed data from the built-in RAM disk.
• LD_TRG1-3 : Reads setup data from the built-in RAM disk.
DC100
• DATA_WR : Writes the data for one scan (one data/channel) retained at the

generation of an event.  To execute this, it is necessary to set LOGIC to the writing
period.

• TRIG : Generates a trigger to start writing.  To execute this, it is necessary to set
TRIG to WRITE TRIG.

• START : Opens a file and starts the writing operation.  It is the same function as the
START key on the operation panel.

• PAUSE : In the case of edge action, writing is suspended at the generation of an
event.  In the case of level action, by setting the alarm, remote, relay or internal switch
to the event, writing is suspended at the detection of an event and resumes at the
resetting of the event (see the following figure).  Setting the timer, match time or
manual function key to the event repeats suspension and resumption of data writing
at the generation of each event.

• CP_FDD : All files in the built-in RAM disk are copied on a floppy disk.  Whether to
cancel files after copying or not depends on the setting in the MEM SET of the SET
UP menu.  Copying after a conversion to ASCII format cannot be done.

• CP_SCS0 to CP_SCS7 :
All files in the built-in RAM disk are copied on a MO, ZIP or PD.  Whether to cancel
files after copying or not depends on the setting in the MEM SET of the SET UP
menu.  Copying after a conversion to ASCII format cannot be done.
Displayed only on models with the C/5 option.  SCS0 to SCS7 represent the SCSI ID
numbers.  Check the ID numbers of SCSI devices that are connected, because ID
numbers are displayed even if there are no devices connected to them.

FLAG (only for Math option models; DC style no. 7+, DA100/DR style no 8 or higher)
• F01 to 16 : Set the flag number (F01 to F16) to 1.  F01 to F16 are normally 0.  Flags

can be placed in computing equations to hold the computed result using a certain
event as a trigger, or reset to 0.

FLOPY
• LD_TRG1-3 : Reads setup data from the floppy disk.
SCSI0 to SCSI7 (for DC100 with /C5 option only)
• LD_TRG1 to 3 : Read setup data from the SCSI device (MO, ZIP or PD).

SCSI0 to SCSI7 represent the SCSI ID numbers.  Check the ID numbers of SCSI
devices that are connected, because ID numbers are displayed even if there are no
devices connected to them.

REPORT (available if the instrument is equipped with the REPORT function.)
• START (Edge action) : Starts making up a report.
• STOP (Edge action) : Stops making up a report.

(No Start/Stop for Level action)
Basic Setup  for hourly, daily, or monthly report function must be ON.

• REPORT (Level action) : Starts/stops making up a report.

Note
If, in the SETUP mode, the report function is set to OFF for all data items, you cannot select

the action item REPORT.
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Groups Setting
Make Group settings for DR group trend recording or for group computation statistics, in
the setting screen on the right side of the Event/Action setting screen.
See an example below to enter the channel number.
Example: To make channels 001, 003, 005, 006, 007, and 008 a group, enter
“001,003,005-008.”

Setting Timers and Summer/Winter Time
The Timer function can be used to trigger a number of event/action functions.  It can also
set the time interval between digital printouts of analog values, or between logging
printouts.

Timer tab

Set Summer/Winter time

Select type of Timer

Summer/Winter Time
If your hardware device is equipped with the /L1 option it is possible to let the hardware
automatically change its date and time to summer or winter time when appropriate.  If
you specify Summer Time the time will be adjusted to one hour later when the specified
date and time is reached.  If you specify Winter Time, the time will be adjusted to one
hour earlier when the specified date and time is reached.
Make sure the Summer/Winter Time option is activated in the System Configuration
setting screen.

Note
• Don’t set time zones using the Windows system autoexec.bat (Place the REM command

before commands like TZ=GMTO for autoexec.bat).  To set time zones select the required

time zone in the Windows OS Date/Time Properties setting screen (Start Menu > Settings >

Control Panel > Date/Time), and check the “Automatically adjust clock for daylight saving

changes” checkbox.

• In the Windows OS Date/Time Properties setting screen (Start Menu > Settings > Control

Panel > Date/Time) always make sure to check the “Automatically adjust clock for daylight

saving changes” checkbox, even if you do not wish to use daylight saving changes for DAQ

32 software.  If you don’t check the setting, errors may occur for the DARWIN Daylight Saving

Time function.
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Printing Settings (DR Only)
The following print setting can be made for DRs:
• Recording Mode (Trend or Logging)
• Trend Printing interval (Fixed or Automatic)
• Chart speed
• Chart speed 2
• Header
• Title
• List Format

Title settings

Choose list 
printing items

Header settings

Recording
interval

Chartspeed 2 
settings

Chart speed settings

Printing tab

Recording 
modes

Recording Mode Settings
The following types of recording mode can be selected.  The default is TREND.
• LOGGING (LOGGING MODE); measurement values will be printed out as digital

values.
• TREND (ANALOG TREND MODE); measurement values will be recorded as analog

trends (dot recording) and printed out as digital values.
• Selecting the recording interval

This setting can only be done for the TREND mode, and its default setting is AUTO.
FIX : Recording takes place at intervals equal to the measurement period (scan
interval).  However, if the measuring period is 0.5 or 1 second, the recording interval is
fixed to 2 seconds.  The measured data during the excess period is ignored.
AUTO : recording takes place at intervals automatically decided by measurement
interval and chart speed.

Chart Speed Settings
Chart Speed 1 (CHART)
This setting specifies the chart speed of ordinary trend recordings.  The setting ranges
from 1 to 1500mm/h, in 1 mm steps.  The default setting is 100mm/h.
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Logging Recording
• Normal : Depends on the (SETUP) Recording Format settings for the Recording

interval in digital printing/logging. It can be set to Single or Multiple:
Single- Interval for timer one.
Multiple- Intervals selected from 6 kinds of timers.

• When an event occurs : Interval set as Chart Speed 2.

Entering a Header
HEADER LINE No. : One header can consist of up to five lines.
LINE 1 to 5 : The header contents can be entered here using up to 80 alphanumerics for
each line, and thus up to 400 characters for the entire header.  The default setting is all
spaces.  To print the header press the Print button on the DR and select HEADER
START from the menu.

Entering a Title
One title can be set, using up to 32 alphanumerics.  Set the Title printing pitch to 600
mm, 1500 mm or set it OFF, in the (SETUP) Recording Format setting screen.

Setting the List Format
The List Format (LIST FMT) setting specifies which setting information will be printed out
in case of list printouts.

Setting Messages (DC100, DR only)
Messages can be printed out on the occurrence of an alarm, instantly using the FUNC
menu, or as an event/action setting.

Message tab

Set the message using maximum 16 alphanumericals or the symbols :, #, %, &, ( ), *, +,
-, ., and /.
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Setting the Writing Operation (DC100 Only)

Writing operation tab
Trigger ON/OFF

RAM overwriting 
interval

Way to use the 
built-in RAM disk

Writing data length

Writing operation setting
Trigger generated writing

File name setting

File information

Pretrigger setting

Sampling period

Report data file info

Periodic file creation interval
Select the file type

Writing Operation Setting (WRITE MODE)
Select the writing operation of the measured/computed data from the following:
• None: Displayed only when the /M3 option is installed.  Use this mode when saving

only report data or periodic files.  The entire built-in RAM disk is used for saving these
files. If there are files saved on the built-in RAM disk, you cannot change the
operation from None to Single or Repeat or visa versa.

• Single: Data for only one file are written and then the writing operation is terminated.
• Repeat: After writing data for one file is completed, the next file is created and writing

starts. When the built-in RAM disk becomes full, the writing operation is terminated.
However, if the WRITE MEMORY setting is DIV, when the built-in RAM disk becomes
full, the file with the oldest date and time is deleted and new data items can also be
continued to be written by setting FILE ROTATE to ON in the SETUP (Basic) mode.

Use of Trigger (WRITE TRIG)
Writing can be set to be started when an event (trigger) is generated.
• Trigger: Writing starts at the generation of an event (trigger) using the event/action

function (trigger mode).
• Free: Writing starts when the Start key is pressed.

Note
If data are written using TRIG, the saving operation is also required to start using the START

key or through the event/action function.

Selection of Writing Data (WRITE DATA)
Select the data to be written from the following:
• All: All measured/computed data are written.
• Alarm: Measured/computed data in all channels are written only when an alarm is

generated.
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Setting of File Name (WRITE NAME)
Select the specifying method of a file name from the following:
• Set :Freely set by the user (up to 5 characters). Characters that can be used for file

names are only those that can be selected from the display; no blanks allowed.  All
letters will automatically be capitalized.

• Date :Automatically set based on the date.

Writing Period
• The period in which data are written can be selected from the following:
• INTVL: The same as the measuring period.  Measured/computed data are saved

without thinning-out.
• 1, 2, 3, 4, 5 , 6, 10, 12, 15 , 20 , 30 seconds, or, 1, 2, 3, 4, 5, 10, 30, or 60 minutes:

Writing is done with the set period.
However, only those values which are multiples of the measuring period can be
selected.

• LOGIC: Only effective if event/action is set to action DATA_WR.  Every time an event
is generated, the data item for 1 scan (1 for each channel) is written.

• When the measuring period is changed, the writing period will not equal the
measuring period or its integral multiples, and is subsequently adjusted to equate with
the measuring period.

Built-in RAM Disk Usage (WRITE MEMORY)
• Select the built-in RAM disk usage from the following:

•  LENGTH: Determines file capacity by specifying the number of data items per ch.
•  DIV2, DIV4, DIV8, or DIV16: Use the RAM disk by dividing the disk area into 2, 4, 8
or 16 parts.  If the memory capacity is 4 MB, 2 cannot be used.

• If a file is saved in the built-in RAM disk, the usage of the built-in RAM disk cannot be
changed.  For this purpose, initialize the RAM disk or change the setting after deleting
all the files.  In that case, necessary files must be saved on a floppy disk.

Writing Data Length (WRITE LENGTH)
• If WRITE MEMORY is set to LENGTH, set the number of data items to be written per

channel, selecting from the following: 10, 20, 30, 40, 50, 100, 200, 300, 400, 500, 1k,
2k, 3k, 4k, 5k, 10k, 20k, 30k, 40k, 50k, or 100k

• However, a data length exceeding a file size of 1 MB cannot be selected depending
on the number of channels.

Note
When using the computation channel, do not write measured/computed data in an application

where the measurement interval is shorter than 0.5 sec, the writing interval is set to INTVL, or

the data length is shorter than 50, if:

• the writing action is in the REPEAT mode.

• writing starts using the event/action mode.

Pretrigger (WRITE PRETRIG)
• If WRITE TRIG is set to TRIGGER, the data before the trigger (event) generation can

be saved in part of the set file.  Setting is done as a percentage of the file capacity in
10% increments.

• If a pretrigger is used (except 0%), it is necessary to set the writing start trigger
(WR_TRIG) to the action in the event/action function.
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Setting A/D Converter Integration Time, Filter,  Scan Interval, and Filter of
Retransmission Output

Select a SETUP topic Setup tabSelect A/D converter time

Filter ON/OFF Measurement scan interval Set the time constant for the filter(only DA/DC)

A/D Converter Integration Time
Select the A/D converter integration time for each unit.   Select it from the following:
• Auto: the frequency of 50/60 Hz is automatically switched corresponding to the power

frequency of this instrument.  Note that Auto does not function for the standalone DC
power supply model or for extended types using a DC power supply subunit.

• 50 Hz: the integration time is set to 20 ms (50 Hz).
• 60 Hz: the integration time is set to 16.7 ms (60 Hz).
• 100 ms: the integration time is set to 100 ms (10 Hz)
• The default setting is AUTO.  However, if the instrument is a standalone DC power

supply model, the default setting is 20 ms (50 Hz).

Filter
Set the filter to reduce normal mode noise, ON or OFF.

Scan Interval
• The duration of time (one scan) in which the measurement of all channels is carried

out, is called the scan interval.
• This interval can be set to any value from 0.5 second to 60 seconds.  The shortest is

40 ch/500 ms for the standalone model, or 300 ch/500 ms for the expandable model
(varies with the shortest measurement period of the input module).

Filter of Retransmission Output
Set the time constant for the filter of the retransmission output.  The number entered
corresponds to the time constant as follows:

Number 0 1 2 3 4 5 6 7 8 9

Time constant (ms) 4 12 28 60 125 250 500 950 1750 3000
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Setting Alarm Interval, Hysteresis, and Alarm Display Hold

Select a SETUP topic SETUP tab

Alarm display hold
(only DC100/DR)

RH alarm interval

RL alarm interval

Hysteresis setting

Alarm Interval
For high/low limit on rate-of-change alarms, variation is measured over a preset interval.

Hysteresis
Set the width between the value of alarm occurrence and its release.  Hysteresis values
can be set in the 0-1% percentage range of the span.  The hysteresis setting is used for
high and low limit alarms.

Alarm Display Hold (DC100, and DR only)
For DC100, and DR select whether to hold the alarm indicator after the alarm is
released, or not.

Setting Relay and Internal Switch Actions

Select a SETUP topic SETUP tabRelay AND/ORReflashing Alarm

Relay hold

Relay (De-)
Energizing

Reflashing Alarm Setting
When several alarms share the same alarm output relay, you can select this setting
which results in a short de-operation of the relay when a second alarm occurs.

Relay AND/OR
Select how the internal switches/alarm output relays will be operated, when a group of
alarms share the same internal switch or alarm output relay.
AND: will be operated when all alarms are occurring;
OR: will be operated when at least one alarm is occurring.
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Relay (De-)Energizing
Select alarm output relays to be energized or de-energized on alarm occurrence.
Copy Relay (De-)Energizing  settings by clicking the number of the settings you want to
copy to other channels.  The display color changes.  Click the copy button in lower left
corner of the setting screen.  Click the first channel you want to copy the settings to, and
drag the mouse pointer down to the last channel the settings should be copied to.  The
display color of the selected channels changes.  Click the Paste button, to copy the
selected settings to the selected channels.

Relay Hold Setting
Select whether to Hold, or Not Hold, the operating status of operated internal switches or
alarm output relays.  This setting applies to both the internal switches and the alarm
output relays.

DO External Relay Setting (DA100 only)
For DA100 you may also use the Command DO to set Relays externally (with a PC) ON
or OFF.  The relay is set from the Base unit to each complete module.  If the relays set
here are alarm output relays, then normal alarm output relays in the same  will be set
OFF.

Setting Burn-out, RJC, and (for DR Only) Recording Colors

Select a SETUP topic SETUP tab

Copy Paste

Burn-out setting Select RJC

Recording color
(for DR only).
Click a color to
display the color
dialog box.

Copying Settings
Copy below settings to other channels using the “Copy” and “Paste” buttons.

Burn-out
Set the recording position for each channel when burn-out occurs.

Reference Junction Compensation (RJC)
Set either the internal (INT) or the external (EXT) compensation for each channel in the
RJC Type setting space.
Voltage to be externally compensated: set in the range of -20000 to 20000 mV.
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Recording Colors (for DR only)
Set the colors used for DR trend recording.

Report Settings

Select a SETUP topic Setup tab

Copy button Paste button Sort button

Report type

Report Starting Time
Report Print ON/OFF

Report Math 
channel settings

Report Time and Format
Set hourly, daily and monthly types of report making, OFF or ON.  It is possible to set
hourly, daily and monthly report all ON at the same time.
File Formats
The format of the report file is available in either the standard (ON1) or enhanced (ON2)
format.  Hourly reports can have the standard format only.
• Standard format (ON, ON1): Outputs the Math results on a report-channel basis.
• Enhanced format (ON2):

Daily reports: Math results configured on a report-channel basis plus hourly
information on the Math results given at each preset time.
Monthly reports: Math results configured on a report-channel basis plus daily
information on given simultaneously with the preset time for making each report

Report Printing ON/OFF (only for DR)
Set whether the report should appear on print (ON) or not (OFF).

Report Starting Time
Set the Starting Time in the format day of month : time.  Define the day of month field
within a 01-28 range and the time field within a 00-23 range.
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Report Channels and Types of computing
There are sixty report channels, from R01 to R60. Assign measurement or computation
channels.
Select one of the Types of computing below:
INST: Instantaneous value at the time of making report
AVE: Average, maximum and minimum over the computing period
SUM: Sum and cumulative sum over the computing period

Sum : The total sum over an hour for hourly reports, the sum over a day for daily
reports or the sum over a month for monthly reports.  The instrument resets this
value each time it makes any of these reports.
Cumulative sum : The total sum up to the preset time to make a report in the
case of hourly reports or the sum up to a preset time of the day to make a report
in the case of daily reports.  The instrument resets this value at each preset time
or at each preset time of the day for report making.  The instrument does not
perform cumulative summation for monthly reports.

Unit of Summation (Sum Unit)
Input data items like flow rates, that have a unit in /sec, /min, /hour or /day, give Math
results that differ from their actual values when simply summed.  This occurs because
the unit of such a data item differs from that of the measurement interval.
In such cases, take the output after having converted the Sum Unit so it matches that of
the input data item applied.

Unit of Input (Preset Unit) Conversion Formula
INTVL (no conversion) ∑ (measured data values)
/sec ∑ (measured data values) × measurement interval
/min ∑ (measured data values) × measurement interval/60
/hour ∑ (measured data values) × measurement interval/3600
/day ∑ (measured data values) × measurement interval/86400

Copying settings
Channel No., Type, and Sum Unit settings can be copied to other channels using the
“Copy” and “Paste” buttons.

Sorting the channel order
It is possible to automatically sort report channels following each other up from a report
base channel.
For example, if Report channel R03 is object for channel 005, report channels R04 and
up, will automatically become object for channels 006, 007, 008, ...etc.
To sort the channels, click the report channel from which up you want channels to be
sorted and drag it down.  Click sort to start sorting.
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Setting (TLOG) Math Setup, Temperature Unit, and (DC100 only) SCSI ID Number

Displaying/recording in case of computation error
Used to determine whether +OVER or -OVER be displayed/saved in case of
computation error.

Time axis scale for TLOG.SUM
For TLOG.SUM of time series, data is added at each measurement interval.  However, in
the case of an input having unit of /s, /min or /h like flow rate, the computation result will
differ from the actual value, if addition of data is carried out.  In this case, setting TLOG
TIME SCALE according to the unit of the input will cause the data measured at
measurement intervals to be processed according to the unit of the input.

Process of abnormal data during TLOG or CLOG (TLOG CH ERROR)
Used to select the process method for abnormal data obtained during TLOG or CLOG.
• ERROR: Abnormal data processed as a computation error.
• SKIP: Abnormal data ignored and computation is continued.

Process of overflow data during TLOG or CLOG (TLOG CH OVER)
Used to select the process method for overflow data obtained during TLOG or CLOG.
• ERROR: Overflow data processed as a computation error.
• SKIP: Overflow data ignored and computation is continued.
• LIMIT: Overflow data treated as the next data for computation.

Processing of the results of TLOG.PSUM computation for pulse input
• OVER: If the result of a separate calculation of TLOG.PSUM (XXXX) exceeds

99999999, the instrument goes into an overflow.
• ROTATE: If the result of a separate calculation of TLOG.PSUM (XXXX) exceeds

99999999, the instrument resets the value subsequent to 99999999 to 0 and
continues computing.  For example, if the measured data subsequent to 99999999
which has been reached is 3, the computed result becomes 2 by counting 0, 1 and 2.
The process is effective only when a pulse input module is installed.  This setting
cannot be made for a DR standalone type

Temperature Unit (for /D2.. deg F Display only)
If your DARWIN hardware is equipped with the /D2 option it is possible to change the
Temperature Unit (C/F) for TC and RTD.
Make sure to activate the Temperature option in the System Configuration setting
screen, by checking the Temperature Unit Switch (/D2).
Note, that as soon as you select Celsius or Fahrenheit the SET (Regular) Settings will all
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be initialized. Therefore, make sure to switch the Temperature Unit before changing any
SET (Regular) settings.

SCSI ID Number (for DC100 only)
Set the ID so that it does not overlap with other SCSI devices connected to the DC100.
The default value is seven.

Setting FUNC Key, and SET Key Operations (for DC100, and DR only)

The below explanation is for the FUNC key.  Set key setting works the same.
Select the menu to be displayed by pressing the FUNC key whether in the FUNC menu
or the FUNC3 menu.
The FUNC menu is displayed by pressing the FUNC key at a touch and the FUNC3
menu is displayed by pressing the FUNC key for about 3 seconds continuously.
Select one of the following three options using the radio buttons:
1 FUNC: displayed in the FUNC menu.
2 FUNC3: displayed in the FUNC3 menu.
3 OFF: not displayed in either menu.

Setting the Recording Format (DR only)
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Channel number or Tag display
Select to print or display measured values using channel number labels or tag names.
• Select either Channel or Tag.  Note that the channel number will be printed/displayed

regardless of selection, if no Tag setting is made (or all spaces).

Number of Tag printing characters
Select 7, 8, 9, 10, 11, 12, 13, 14, 15 or 16.
• The default setting is 7.
• If the selected number of printing characters is less than the actually entered Tag,

only the number of characters selected here will be printed.

Dot-printing Recording System
Select it from the following systems.  The default setting is NORMAL.  To practically
record it, the RECORD must be turned on.  Channels to be recorded are those selected
to be ON in “Setting the Channels to be Recorded, Dot Recording” on page 6-2.
Normal:
• To record all object channels.
Alarm 1:
• To record only the channels with on-going alarm.
• Recording continues even if the alarm is released.
Alarm 2:
• To record only the channels with on-going alarm.
• Recording stops when the alarm is released.
Group:
• To record the channels which are set into a group only.
• Recorded only if “GR TREND” is set in the event/action function.

Printing when chart speed is changed (SPEED CHANGE PR)
When the chart speed is changed in dot-recording, select whether to print with the
changed chart speed or not.
• OFF: does not print.
• ON: prints.

Printing recording start/stop time mark (ON/OFF MARK PR)
In dot recording, select whether the record-start/stop time is printed or not.
• OFF: not printed.
• ON: printed..

Number of columns for digital printing (DIGITAL PR CLMN)
Select the amount of channels to be printed in one horizontal line.
• Select 1, 2, 3, or 4 columns.
• If Tag has been selected in selecting the channel number/Tag, this is limited to 3

columns.  If Tag is set to 16 characters, the Tag entry is limited to two columns.
• As for DR130, Select 1or 2 columns.  If Tag is set to 8 characters, the Tag entry is

limited to one column.

Channel number printing pitch (CHANNEL PITCH)
For dot recording, select the number of millimeters for the channel number printing
interval.  When Tag has been selected in channel number/Tag selection, the Tag
corresponding to the channel number is printed.
• OFF: not printed.

Title printing pitch (TITLE PITCH)
For dot recording, select the title printing interval in millimeters.
• OFF: not printed.
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• 600 mm: printed every 600 mm.
• 1500 mm: printed every 1500 mm.

Scale check mark printing (SCALE TIC PR)
For dot recording, a tic mark indicating the scale mark positions can be printed.
• OFF: no mark printing.
• ON: printing the tic mark.

Horizontal or vertical printing (LOG FORMAT)
In logging mode, select either horizontal or vertical printing of the channel number/Tag.
• Horizontal: horizontal printout
• Vertical: vertical printout

Recording Interval in Digital Printing/ Logging Mode (LOG INTERVAL)
Select to record channel numbers/Tags and measured values at one interval or at a
selected interval for each channel using the 6 timers.
SINGLE:
• Digital print: The interval is determined by the chart speed and the number of columns

to be printed.
• Logging mode: interval for timer No. 1.
MULTIPLE: intervals selected for each channel from 6 kinds of timers for either Digital
printing or the Logging mode.

Memory-related Settings (DC100 only)

Select the SETUP topic Setup tab

 Alarm when the 
remaining file capacity 
to write to RAM becomes 
below specified time.

Copy lock settings

Set to overwrite files 
with same name

Deleting oldest files
 when RAM is ful

File deletion when 
copying a file

Time before file-end-alarm (FILE ALARM)
• This outputs a file alarm from a relay when the remaining file capacity becomes below

the one corresponding to the specified time while the measured/computed data are
being written in the built-in RAM disk.  Select the remaining time from the following:
0h : Outputs an alarm when file has been created (file is closed).
1h, 2h, 3h, 4h, or 5h: Outputs an alarm when the remaining time reaches the specified
time.

Overwriting of files with the same name (FILE OVERWRITE)
• When measured/computed data are written, if there is a file with the same name in the

built-in RAM disk, set whether to overwrite the file or not.
ON : Overwrites the file.
OFF : Stops writing.
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Deleting oldest files when RAM is full (FILE ROTATE)
• If saving with the division method and the saving operation is REPEAT, and if memory

becomes full and so there is no file creation capacity, the saving operation is
continued by deleting the file with the oldest date and time.
ON : Continues saving operation by deleting a file.
OFF : Terminates the saving operation.

File deletion when copying a file (FILE COPY & DELETE)
• Set whether a file in the copying source is to be deleted or not when copying a

measured/computed data file to a floppy disk.
ON : Delete.
OFF : Do not delete.

ASCII-converted copying is not supported.

Copy-lock to floppy disk
Select whether to use the lock function not for copying measured/computed data to a
floppy disk.
OFF:  No use. Password not needed,
ON: Use.  Set a password.
Copy lock doesn’t work for ASCII-conversion copying.
Copy-lock password
A password is needed if copy locking is used.  Enter four numbers.

Setting Key lock, Display Update Interval,  Ch/Tag Display Indication (DC100/DR only)

SETUP tabSelect the SETUP topic

Keylock usage 
setting

Keylock setting
per key

Password for 
keylock

Display update

Channel or tag
indication

Key Lock
Selection of Use or Nonuse of Key Lock
Selection for key lock function to (in)activate setting keys on your DC100 or DR.
• Non-use: DC100 or DR keys can be used.
• Use: DC100 or DR keys will be inactive when pressed.  Even if key lock is

executed, the power switch, DISP/MODE key operation and cursor key operation
remain effective.  Some keys can be selected to be locked or free.  Selectable keys
are: the Start key, the Stop key, the Clock key, the FUNC key, the FD COPY key , and
the M.FUNC key.  Click Free to activate them, Lock to lock them.

Setting Password
After activating the keylock it is possible to (in)validate the keylock using the FUNC Key
(depending on the settings in the FUNC menu).  To use the FUNC option it is necessary
to enter a password in the range of 0 to 9999.
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Display Update Interval
Select the display update interval when the operation display mode is set to Auto. Select
2, 3, 4, or 5 seconds.

Indication for Display
Select whether to have Channel Number or Tag indication on the DC100/DR display.
Note that the channel number will be printed/displayed regardless of selection, if no Tag
setting is made (or all spaces).

Subunit and Module Configuration
It is possible to attach or remove subunits and modules, or to change module types
using DAQLOGGER Hardware configurator.

Procedure
1. Open the setting window of the DARWIN of which the module configuration is to be

changed, and select “Module Configuration” from the “System” menu of the
“DAQLOGGER Hardware Configurator” window.  The “Module Configuration” dialog
box opens.

Adding and removing subunits
2. To add a subunit click an empty subunit placing area and click “OK” when asked “Add

Unit?.”
3. To remove a unit click right side of the module (reading DS600/DS400) and click “OK”

when asked “Delete Unit?.”
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Adding and Removing Modules
4. To add a module, click the module space on a subunit.  The Module Selection pull-

down box opens. Select the desired module, and click “OK.”  The selected module will
get displayed.

5. To remove a module, again click the module you want to remove, and in the Module
Selection pull-down box that appears, select “NONE.”

Note
• If a unit or module gets removed, all the settings related to it, will also be reset.

• All subunits will be appear as DS660s.  When adding modules, apply a maximum of 4 DS400

modules, or 6 DS600 modules.

6. Set the subunits and modules for the object recorder.
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.
Changing DARWIN system configuration

If necessary, change the system configuration such as the presence or absence of
options to match the DARWIN that is to be configured.
Changing the system configuration initializes the settings of the SET mode and SETUP
mode.  Perform changes in the system configuration first.
The changes in options are reflected in the “Recorder List” window.

Procedure
1. Open the setting window of the DARWIN of which the system configuration is to be

changed, and select “System Configuration” from the “System” menu of the
“DAQLOGGER Hardware Configurator” window.  The “System Configuration” dialog
box opens.

2. Set the style number, memory capacity, and options to match the DARWIN.
3. When you finish setting the parameters, click “OK.”  The setup parameters are applied

to the setup items in the tab panel.
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7.8 Setting CX Series

The Hardware Configurator can be used to transmit and receive the setup data, change
the setup data, and create new setup data for CX style number S1.
If you change the system configuration and create new settings, first perform the
“Changing CX System Configuration” on page 7-78.

Loading Setup Data from the CX
Before performing the following procedure, please make sure that the communication
method and parameters are correct.  (For details, see section 2.6 “Setting
Communications and Connected Recorder Models.”)

2. The [Recieve Data] dialog box opens.

1. Click the Recieve button or 
    [Recieve Setting] on the [Comm.] menu.

3. Click the [OK] button to recieve the setup data.

Recieve

Note
Do not load measured data when entering program control function settings on the CX, or

when a medium is being accessed.  Doing so will cause a communications error.
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Changing System Configuration

3. The [System Configuration]
dialog box opens.

2. Choose [System] 
- [System Configuration]

1. Click a number to display the setting screen.

You can enter the following settings in this dialog box.

Type
Select either CX2000 or CX1000.

Channel
Select the number of channels of the CX.  The CX1000 is fixed at 6 channels.
Select either 10 or 20 channels for the CX2000.

LOOP
Select the number of loops.
CX1000: [0LOOP], [2LOOP]
CX2000: [0LOOP], [2LOOP], [4LOOP], [6LOOP]
Select the CX style number.  The default is Style1.
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Math Function
Select whether or not to enable the math functions.

Serial
Select the serial communications mode from [OFF], [RS-232], or [RS-422A/485].

Media
Select the external storage media from [FDD], [ATA], or [ZIP].

Alarm Relay
Select the type of alarm relay from [NONE], [4p+With Fail/Mem.  End], [6p], or [External
Loop] (only for CX2000).  If you select 2LOOP for the CX1000, the Alarm Relay is
automatically set to NONE.

Options
The options include the following.
• Green Series Comm

Select whether communication options are installed and an external environmental
monitoring system.  This option can only be selected when [Serial] is set to [RS-232]
or [RS-422A/485].

• Ladder Comm
Select whether a ladder communication option is installed.  This option can only be
selected when [Serial] is set to [RS-232] or [RS-422A/485].
Also, this option is not available if 0LOOP is selected.

Remote
Select whether a remote option.  This option is installed can only be selected when
[Alarm Relay] is set to [4p+With fail/Mem.  End] or [6p].

Program
Select [None], [Program Num#:4], or [Program Num#:30].

When you change the system configuration and click the [OK] button, the “System
configuration has been changed.  The input configuration and data will be initialized.
Continue?” message appears.  Click the [OK] button to initialize the data.
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Control Function Basic Settings
Make the basic settings of control function.
To do so, click the [Setup] tab then select the settings you wish to enter from the list that
appears on the left of the screen.  Or, you can select the items by choosing [Control
Settings] - [Setup Mode].

Control Action

PID Number
Set between 1 and 8. If the number is changed, the program pattern for the program
control option will be initialized.

Control Interval
Set to [250ms], [500ms], or [1s].
However, when [A/D Integrate] under [Scan Interval/Memory] is set to [100ms], you can
only select [1s].

Zone PID
Turn ON or OFF.

Restart Mode
Set to [Continue], [Manual], or [Auto].
With the program control option, the choices are [Continue], [Manual], or [Reset].

Initial PID
Set to [Temp] or [Press].

6/4LOOP Select (only for CX2000)
Set to 6 or 4 loops.
This selection is only available when the [LOOP] setting in the [System Configuration]
dialog box is set to [6LOOP].

Auto Tuning
Turn ON or OFF.
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Internal Loop
For each loop there are Control Setting and Burn-out/Tuning items.

LOOP
Select the loop number (CX1000: 1 and 2, CX2000: 1 to 6) to which the settings apply.
Only the loops for which system settings were entered appear in the list.

[Control Setting] Tab
Contains the basic settings for internal loops.

• Control Action
Control Mode
Select the control mode from [Basic], [Cascade], or [PVSwitching].  For a loop with no
control, select [OFF].  Selecting [Cascade], because of a common setting between
two loops of a control output terminal block, when you set loop 1 to cascade, loop 2
can also automatically be set to cascade, for example.

Method
Select the switching conditions of two measurement inputs from [TCRange], [PVHigh],
or [Signal].  You can only make this selection when [Control Mode] is set to
[PVSwitching].

Program Control (with the Program Control Option)
Turn program control ON or OFF.  This setting applies to both loops of a single control
output terminal block.

PID Control Mode
Select the PID control mode from [Follow-Up] or [Fixed-point].  You cannot make this
selection when [Control mode] is [OFF] for a loop.
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• AUX
Remote Setting
When performing measurements by remote, select [Remote].  When [Control Mode] is
set to [Cascade], it is not possible to set [Remote] for secondary measurement loop
numbers.

Alarm Mode
Select from the following whether you want the alarm to be inactive.

ALWAYS:
Alarm is always active.

STOP:
Alarm inactive when operation is stopped.

STOP/MAN:
Alarm is inactive in manual operation mode or when operation is stopped.

• Output Process
When [Control Mode] is set to [Cascade], the output process settings are not
available.

Control Output
Select the type of control output from the following:
• Relay

• Voltage-pulse
• Current-output
• On/Off-control

Cycle Time
With a PID proportional to time, set the cycle time (control output cycle) between [1]s
and [1000]s.

Analog-output Type
For the current output, select the output current range from the following:
• [4-20mA], [0-20mA], [20-4mA], and [20-0mA].

Contact Input

Module Setting
Select the terminal blocks where you want to register contact inputs from [CTRL3-4] for a
CX2000 with 4 loops or more, [CTRL5-6] for a CX2000 with 6 loops or more, or
[EXTDIO] for a CX2000 with External DIO selected for Alarm Relay.
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Contact
For each contact input number, select the type of contact input from the following.  For
details about the contact input settings, refer to the CX User’s Manual (IM 04L31A01-
01E or IM 04L31A01-03E).

• ControlStopAll
• ControlStartAll
• ControlStart/Stop (CX1000: 1 to 2, CX2000: 1 to 6)
• Remote/Local (CX1000: 1 to 2, CX2000: 1 to 6)
• Auto/Man (CX1000: 1 to 2, CX2000: 1 to 6) <- not selectable in cascade control
• Cascade (1-2, 3-4) <- selectable only in cascade control (3-4 is only for CX2000)
• Auto1-2 or 3-4 <- selectable only in cascade control (3-4 is only for CX2000)
• Man1-2 or 3-4 <- selectable only in cascade control (3-4 is only for CX2000)
• SPNumber0 to 3 bit (enter by selecting one of the options under SP Number set).
• PVSwitching (CX1000: 1 to 2, CX2000: 1 to 6) <- selectable only in loop control with

PV switching
• Memory Start/Stop
• Trigger
• Alarm ACK
• Time Adjust
• Math Start/Stop
• Math Reset
• Manual Sample
• Panel1 Load to Panel3 Load
• Message1 to 8
• Snapshot

SP Number Set
Select the SP number set to switch to when registering contact inputs.

SP No.  Selection Source
When specifying input contacts of SP No. settings, select the loop number of the SP
Number set to be switched.  Activate or deactivate each loop number (CX1000: LOOP1
and LOOP2, CX2000: LOOP1 to LOOP6).

Pattern Number Selection
(When [Program Control] for [Internal Loop] is ON)
With program control, you can select the range of pattern numbers when switching
program patterns through contact input.  The pattern numbers are entered in binary
according to the number of relays required as shown in the following chart.

Pattern No. No. of Relays Assigned Relay(s)

1 1 (1 bit) DI001
1–3 2 (2 bits) DI001, DI002
1–7 3 (3 bits) DI001–DI003
1–15 4 (4 bits) DI001–DI004
1–30 5 (5 bits) DI001–DI005

These are automatically registered under contact inputs according to the selected range
of program pattern numbers.  [1–15] and [1–30] are active only if the number of program
patterns is 30 (/PG2).
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Control Relay

Module Setting
Select the terminal blocks where you want to register contact inputs from [CTRL1-2],
[CTRL3-4], [CTRL5-6], or [EXTDIO].  [CTRL3-4], [CTRL5-6], and [EXTDIO] are available
only for the CX2000.

FAIL
Activates the output of a relay contact signal (FAIL signal) if a fault occurs in the CX
CPU.  When it is [ON] (default: [OFF]), contact output number [DO001] of control output
terminal block 1 is automatically assigned to [De_energize/Nonhold].

Self Diagnosis
Activates the output of a relay contact signal in the event of input burnout, an A/D
converter fault, or reference contact compensation failure.  When it is [ON] (default:
[OFF]), contact output number [DO002] of control output terminal block 1 is automatically
assigned to [De_energize/Nonhold].

Relay (Action/Behavior)
Set the contact output relay operating mode to [De_energize/Hold], [De_energize/
Nonhold], [Energize/Hold], or [Energize/Nonhold].
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[Burnout/Tuning] Tab

• Input Process
Burnout
For the measurement input to each loop, select the burnout direction (open-circuit
detection) from [OFF], [UP], or [DOWN].  The [No.2] setting is valid when [Control
Mode] is set to [PVSwitching], and the [Remote] setting is valid when remote input is
used as measurement input.  This setting is invalid for measurement inputs other than
thermocouple and unified signals.

RJC (Type, Volt (uV))
This is the reference contact compensation setting for a thermocouple input.  Set for
the measurement input of each loop.  The [No.2] setting is valid when [Control Mode]
is set to [PVSwitching], and the [Remote] setting is valid when remote input is used as
measurement input.  This setting is invalid for measurement inputs other than
thermocouple and unified signals.
Select from [Internal] and [External] for [Type].
When [External] is selected, set [Volt (uV)] between -20000 and 20000 uV.

Tuning Setting
Switch tuning ON or OFF.
Select [ON] for the parameters that you want to display in the tuning window, and
[OFF] for other parameters.

ID
Select the ID of the item from the following.
SP (target set point), A1 (alarm 1 setting), A2 (alarm 2 setting), A3 (alarm 3 setting),
A4 (alarm 4 setting), P (proportional range), I (integration time), D (differentiation
time), OH (upper output limit), OL (lower output limit), MR (manual reset), H
(hysteresis), DR (control action direction), and PO (preset output).

Name
Specify the name of the item using a maximum of 6 characters.
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External Loop
For each loop there are Basic Setting, External Loop Setting, Parameter Address
Setting, and Tuning Setting items.
[Basic Setting] Tab

• Control Action
Comm.  On/Off
Select to turn the external loop function (the loop controller communications function
which allows the CX to communicate with loop controllers) ON or OFF.
If you select OFF, all settings below will be deactivated.

Modbus address
Enter the Modbus address of the environment used in external loop control.

Connecting Model
Select the type of connected UT series controler.  Select [Other] when connecting to
an adjustor other than a UT series instrument.
The following settings vary depending on the selected instrument.

[External Loop Setting] Tab

• Control Action
Loop Select
Select the loop from [Loop1] or [Loop2].
This item appears when [Connecting Model] in [Basic Setting] is set to a model
capable of two-loop control, such as the UT550.
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Tag
Specify a tag using a maximum of 8 characters.

Tag Comment
Specify a tag comment using a maximum of 8 alphanumeric characters.

PV/SP/OUT
Set the decimal place and units of PV, SP, and OUT.

Control Span
Set the control span between the upper and lower limits.

Control Mode
Select the control mode from the following (The available control modes differ
depending on the connected instrument.):
[SingleLoopControl], [CascadePrimaryLoop], [CascadeSecondaryLoop],
[CascadeControl], [ControlBackUp], PVSwitching], [PVAutoSelector], or
[PVHoldFunction].

Control Output
Select the type of control output from the following:
[Relay], [Voltage-pulse], [Current-output], and [On/Off-control]

Alarm
Select the type of alarm from the following:

[OFF], [PV-High(Energ)], [PV-Low(Energ)], [Deviation-High(Energ)], [Deviation-
Low(Energ)], [Deviation-High(Deenerg)], [Deviation-Low(Deenerg)], [Deviation-
H&L(Energ)], [Dev-within-H&L(Energ)], [PV-High(Deenerg)], [PV-Low(Deenerg)], [PV-
High(Energ/Standby)], [PV-Low(Energ/Standby)], [Dev-High(Energ/Standby)], [Dev-
Low(Energ/Standby)], [Dev-High(Deenerg/Standby)], [Dev-Low(Deenerg/Standby)],
[Dev-H&L(Energ/Standby)], [Dev-w-H&L(Energ/Standby)], [PV-High(Deenerg/
Standby)], [PV-Low(Deenerg/Standby)], [Timer-upward(h:m)], [Timer-downward(h:m)],
[Timer-upward(m:s)], [Timer-downward(m:s)], [Sensor-grounding], [Problem-
diagnostic], [FAIL-output], [SP-High], [SP-Low], [Output-High], [Output-Low], [Header-
burnout1], and [Header-burnout2].

[Parameter Address Setting] Tab

Select the parameter address settings from the following ranges.
30001 to 39999, 300001 to 365535, 40001 to 49999, 400001 to 465535.
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[Tuning Setting] Tab

• Tuning Setting (External)
Tuning item ON/OFF
Select [On] for the parameters that you want to display in the tuning window, and [Off]
for other parameters.

ID
Select the ID of the item from the following:
SP (target set point), A1 (alarm 1 setting), A2 (alarm 2 setting), A3 (alarm 3 setting),
A4 (alarm 4 setting: cannot select with UT320, UT350, or UT420), P (proportional
range), I (integration time), D (differentiation time), OH (upper output limit), OL (lower
output limit), MR (manual reset), H (hysteresis), DR (control action direction), PO
(preset output), and ETC (others).

Note
When [Connecting Model] in the [Basic Setting] tab of [External Loop] is set to [Other], you

can only select [ETC].

Name
Specify the name of the item using a maximum of 6 characters.

Register
Set the register address in the following ranges.
30001 to 339999, 300001 to 365535, 40001 to 49999, and 400001 to 465535.

Span (Point)
Set the parameter decimal point position in the range of 0 to 4.

Span (L)
Set the lower control span value between -30000 to 30000.

Span (U)
Set the upper control span value between -30000 to 30000.
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Control Function General Settings
Make settings for the internal loop control functions, using the [Control Loop] tab and
[Control Group] on the [Setting] tab.  You can also enter these settings by choosing
[Control Setting] - [SETUP [Regular] Setting] - [Control Loop], or [Control Settings] -
[SETUP [Regular] Setting] - [Control Group].
On the [Control Loop] tab, click the button (LOOP01, LOOP02, ...) of each loop number
that you want to set, and then make the settings for that loop.  The label of the selected
loop number button is red.  Select each item (Control Input, PID/Alarm, Operation
Related, Linearizer, and Control Function) with the option buttons.

Control Input
The control input settings vary depending on the [Control Mode] setting selected in
[Setup] - [Internal Loop].  You can make settings for the inputs [PV1], [PV2], [Remote],
and [PVrange].  They appear in the following situations.

Basic

Cascade 

PVSwitching

Odd loops
Even loops
Odd loops
Even loops
Odd loops
Even loops

 PV1 PV1 Remote PVrange

*

* With 6 loops, and 6/4LOOP Select set to 6 loops.

Remote appears if the Setup tab’s Internal Loop > Remote setting is set to Remote.

The settings displayed depend on the input type, [PV 1], [PV2], [Remote], and [PVrange],
but the settings are the same.

Select the loop number

SCALE/1-5V (PV1, PV2, Remote)
Select the channel measurement mode from [Temp], [Scale], or [1-5V].

Mode (PV1, PV2, Remote)
Select the channel input mode from [VOLT], [TC], or [RTD].  When [SCALE/1.5V] is set
to [1.5V], [Mode] is set to [VOLT].
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Range/Type (PV1, PV2, Remote)
Select the voltage range, thermocouple, and resistive temperature detector type.

VOLT: 20mV, 60mV, 200mV, 2V, 6V, 20V, or 50V
TC: TypeK, TypeJ, TypeT, TypeB, TypeS, TypeR, TypeN, TypeE, TypeL, TypeU,

TypeW, PLATINEL, PR40-20, or WRe3-25
RTD: JPt100 or Pt100

When [SCALE/1.5V] is set to [1.5V], [Range/Type] is set to [6V].

Span (PV1, PV2, Remote)
Specify the measurement span in EU.

Scale (PV1, PV2, Remote)
Specify the scale between –30000 and 30000.  However, this is only valid when [SCALE/
1-5V] is set to [Scale].

Unit (PV1, PV2, Remote)
Specify the units.
Use a maximum of 6 characters.

Sqrt (PV1, PV2, Remote)
Select or clear the check box to turn the square root function ON or OFF.
When it is on, set [Low Cut] between 0.0 and 5.0.

Bias (PV1, Remote)
Select the check box to turn the bias ON.
When it is ON, specify a EU (–100 to 100%) value.

Filter (PV1, Remote)
Select the check box to use a filter.
When it is ON, set between 1 and 120.

Ratio setting (Remote)
Turn ON when applying the designated ratio to remote measurement input.
When it is ON, set between 0.001 and 9.999.

PV Range (PV Range)
Enter the maximum value, minimum value, decimal place, and units.
Set the max. and min. values between –30000 and 30000 such that max. > min., and
max. - min. = 30000.

PV Switching (PV Range)
Set within the input range.  When setting Method to T/C Range in the Control Setting tab
within the Setup tab’s internal loop item, or when setting Method to PVHigh, only the
upper limit is set.  If you set Method to Signal, the PV Input Switching setting is not
available.
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PID/Alarm

• Alarm
Specify an alarm for each loop.

Type
Select the type of alarm from the following:
[PV-High], [PV-Low], [Deviation-High], [Deviation-Low], [Deviation-H&L], [Dev-within-
H&L], [SP-High], [SP-Low], [Output-High], and [Output-Low].

Standby
Activate or deactivate standby.
For details about the alarms that can be turned on or off, refer to the CX User’s
Manual (IM 04L31A01-01E or IM 04L31A01-03E).

Relay
Select the type of relay (DO001 to DO006, R0001 to R0012).
R0001 to R0002 can only be set on a CX2000 with the control extension DIO.

Hysteresis
Specify the alarm hysteresis in EUS (0.0 to 10.0%).

• PID Parameters
Specify the PID parameters for each loop.

Target setpoint
Specify the target setpoint in EU (0.0 to 100.0%).
Set between the target setpoint’s upper and lower limits.

Alarm value (1 to 4)
Set the alarm value.  (The setting depends on the type of alarm.)
PV and SP alarms EU (0 to 100%)
Deviation-High and Deviation-Low alarms EUS (–100 to 100%)
Deviation alarms EUS (0 to 100%)
Output alarms –5.0 to 105.0%

Proportional band (P)
Specify between 0.1 and 999.9%.

Integral Time(I)
Specify between 0 and 6000s.

Derivative Time(D)
Specify between 0 and 6000s.
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Lower Limit
Set the output lower limit between –5.0 and 105.0%.

Upper Limit
Set the output upper limit between –5.0 and 105.0%.

Shutdown
Turn the shutdown function ON or OFF.

Manual Reset
Set the manual reset between –5.0 and 105.0%.

Relay Hysteresis (Value)
Set the relay hysteresis in EUS (0.0 to 100.0%).

Relay Hysteresis (Point)
Select the Hysteresis operating point when using ON/OFF control from [Mid], [Lower
Limit], or [Upper Limit].

Preset Out
Select from –5.0 to 105.0% to be used when operation is stopped.

Reverse/Direct
Select reverse/direct switching from [Direct] or [Reverse].

Note
[Relay Hysteresis (Value)] and [Relay Hysteresis (Point)] appear in PID Parameters when

[Control Output] is set to [On/Off-control] on the [Internal Loop] tab of the [Setup] tab.  In that

case, [PID], [Output Limit], [Shutdown], and [Manual Reset] are not shown.

Operation Related

• Operation Related
Make the internal loop control operation related settings.

Suppressing Function
Select [OFF] or [Overshoot].

Ramp-rate Time Unit
Set the ramp-rate time units.

SP Ramp-down-rate
Set between 1 digit and EUS (100%).
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SP Ramp-up-rate
Set between 1 digit and EUS (100%).

Tag
Specify a tag.
Use a maximum of 8 characters.

Tag Comment
Specify a comment for the tag.
Use a maximum of 8 characters.

• Zone PID
Specify the internal loop control zone PID.
The zone PID setting appears when [Zone PID] is [ON] in [Setup] - [Control Action].

Reference Point(displayed when the PID number is 3 or higher)
Specify the reference point with the measurement input span EU (0.0 to 100.0%).
The number of points depends on the number of PID.  ([PID Number]: 2.) Therefore, it
is not displayed when the PID number is 2 or less.
The value of each point is such that 1≤2≤...≤6 is set.

Switching Hysteresis
Specify the switching hysteresis value with the measurement input span EUS (0.0 to
10.0%).

Reference Deviation
Turn the reference deviation on or off, and specify the value with the measurement
input span one-digit EUS (100.0%).  With style number S1 (system setting), it is not
displayed if the PID number is 1.  With style # S2, it is not displayed when the PID
number is 2 or less.

Linearize

Mode
Select the linearize mode from [OFF], [Biasing], or [Approximation].

Input
Enter the linearize input value.  (The value depends on the linearize mode.)
Biasing: Set with the measurement input span EU (–5.0 to 105.0%).
Approximation: Set with the measurement input span EU (–5.0 to 105.0%).

You must set between 2 and 11 points total.
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Output
Enter the linearize output value.  (The value depends on the linearize mode.)

Biasing: Set with measurement input span EUS (–100.0 to 100.0%).
Approximation: Set with measurement input span EU (–5.0 to 105.0%).

Note
• With linearize bias, set so that input + output is EU(–5–105%).

• Starting from the third point, if you set a value smaller than the previous value, all settings

after that point become disabled.

Control Function Settings

SP Tracking
Turn the target setpoint tracking ON or OFF.

PV Tracking
Turn the measurement value tracking ON or OFF.

Target Setpoint Limiter
Specify the measurement input range in the EU (0.0 to 100.0%) range.

Output Velocity Lim
Select or clear the check box to turn the output velocity limiter ON or OFF, and specify a
value between 0.1 and 100.0. This is unavailable for style number S2 if you set [Control
Output] to [On/Off control] in the [Setup] tab for [Internal Loop].

Anti-reset Windup
Select the anti-reset windup from [Auto] or [Manual]. This is unavailable for style number
S2 if you set [Control Output] to [On/Off control] in the [Setup] tab for [Internal Loop].

Dev Band
Set the deviation band of the anti-reset windup between 50.0 and 200.0%.
This setting is only valid when the [Anti-reset Windup] is set to [Manual].
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Control Groups
Set the groups to which control functions apply.

From the [Setting] tab, select [Control Group].

Group Name
Enter a group name using a maximum of 16 characters.

KIND
Select the loops and measurement channels you want to assign to a Group.  For the
CX1000, you can select 1–2 internal loops and 1–4 external loops.  For the CX2000, you
can select 1–6 internal loops, and 1–16 external loops.
Group1 consists of up to 4 types on the CX1000, or up to 6 types on the CX2000
corresponding to the control loops and measurement channels.

PV Event Hysteresis
This is unavailable for style number S2 if you set [Program Control] to [On] in the [Setup]
tab for [Internal Loop].

From the [Setting] tab, select [PV Event].
The setting is available when Program in the System Configuration dialog box is set to
Program Num: 4 or Program Num: 30, and Program Control on the Internal Loop page of
the Setup screen is set to ON.  The available setting range is 0.0 to 10.0%.
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Control Channel Settings (Internal/External)
The following settings apply to the internal and external loops’ SP, PV, and OUT
measurement displays.
To enter control channel settings, click the [Control(Int)] tab.  Or, you can select the
items by choosing [Control Setting] - [SET [Basic] Setting] - [Control Channels (Internal)].

Tag
Enter a tag of using maximum of 16 characters.
You can enter a tag to be displayed on the screen instead of the channel number.
Select whether the channel name or tag is displayed in the [Setup] tab.  By selecting
[Tag] in [Aux] of the [Setup] tab, you can select the tag No./tag comment or tag in the
Data Monitor or Data Viewer.

Zone
You can select the range on the CX’s screen where each channel waveform is
displayed.
Set the lower and upper limits as percentages on the scale displayed.
The zone setting conditions are as follows:
• Setting range: 0 to 100%

Lower limit < Upper limit
• Difference between upper and lower limits: at least 5%

Graph
Div
Select the number of bar graph divisions from 4 to 12, or C10.
When selecting [C10], the scale of the trend display is divided in 10 major divisions,
numbered at the [0], [30], [50], [70], and [100]% marks.

Bar graph
Select the bar graph reference point.  When the bar graph is displayed vertically,
[Center] is invalid, even if selected.  During the data check it is changed back to
[Normal].

Scale
When the scale is displayed in the trend display, select the scale display position.
For details, refer to the CX User’s Manual (IM 04L31A01-01E or IM 04L31A01-03E).
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Partial
Expand(%)
The boundary value is displayed as a percentage along the width of the display, between
1 and 99%.

Boundary
The setting conditions depend on the internal control channel and external control
channel as follows:
• Internal contorol channel

PV Switching: PV Range L < boundary value < PV Range U
With Single Control or Cascade Control, when the Scale/1-5 V setting under Control
Input on the Control Loop tab is set to Scale or 1-5 V: scale minimum value <
boundary value < scale maximum value

• External contorol channel
span L < boundary value < span U
However, when external loop is off, the partial expansion/reduction is also off.

Note
• The partial expansion/reduction settings are valid when [Partial] is set to [Use] in [Aux] of

the [Setup] tab.

• For the external control channel, set a boundary within the span determined by the internal

span –50–1050 and the specified decimal point.   Normally there is one decimal place, so

it can be set to –5.0% < boundary < 105.0%.

Color
For each channel you can choose from 16 colors.
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Program Control Related Setup Operations
Turn ON/OFF Program Control
Program control can be turned ON and OFF using the internal loop setting of the control
function basic settings.
Click the Setup tab then select [Internal Loop] from the list that appears on the left of the
screen.  Or, you can select the items by choosing Control Settings > Setup[Basic] Setting
> Internal Loop.

Select the loop number Click this tab
Program control ON/OFF (every 2 loops)

Note
You must first turn ON program control to carry out the program control related settings

below.
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Initial Program Patterns
You can set the default program patterns by clicking the [Program pattern] tab, then
selecting [Default setting].  Settings cannot be entered when the number of segments is
0.  Add segments using [Segment setting].

Set the start code
Available when segments have been inserted or added under [Segment setting].  
Set the start setpoint
Available when segments have been inserted or added under [Segment setting].

Copy the settings (Default setting/Segment setting)
Paste copied pattern settings (Default setting/Segment setting)

Select the pattern number
Pattern Default setting
Pattern name, Setting method, Start setpoint, Start code

Enter a pattern name setting
Segment setting
Setpoint, PV Event, Time Event, Repeat

Event output setting
AUX setting
Automatic message, program display position

Click this tab

Segment and 
event totals
(cannot be set here)
The number of 
segments and 
events used with 
this pattern.   
(cannot be set here)

Set the segment 
setting method

Zone number

Wait setting
Available when 
segments have 
been inserted or 
added under 
[Segment setting].  

Wait time setting

Pattern number
Select the number of the desired pattern from [1] to [30] ([1] to [4] for models with /PG1
option).

Pattern name
Enter the pattern name using up to 16 alphanumeric characters.

Segment setting method
Select segment time setting method or segment time ramp grade setting method.  If you
change this setting, the program pattern setting corresponding to the pattern number is
initialized.

Start target setpoint
Set the start SP, a starting condition, in the range of [EU (0.0% to 100.0%)] (initial value
is 0%) of the measurement span.  Only the loops that are set as follows are displayed:
[Setup]  tab > [Internal Loop] > [Program control] to [On] During cascade control, even-
numbered loops within the same terminal block are not displayed.
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Start code
Select the operation start condition from the following.  However, only the possible loop
conditions are displayed.
Starting target setpoint start, PV1 to PV 6 ramp-prioritized PV start, time-prioritized ramp
start (not displayed for segment time ramp setting method)

Wait time
Set the wait time in [hh:mm:ss] format (selectable range: [00:00:00] to [99:59:59]) for all
the available zones.  The setting applies to the same zones in each loop.  Wait time is no
available if the wait zones of all loops are set to OFF.

Wait action setting
Set the wait zones for 6 (number of loops) × 5 (number of zones) (CX1000: 2 (number of
loops) × 5 (number of zones))in the range of [EUS (0.0 to 100.0%)] of the measurement
span. When specifying, you must first turn the wait action ON in the [Segment setting]
tab.

Program Patern Setting(Segment setting)
Program Pattern Settings (Segment Setting)
Set a program pattern for each segment, by clicking the [Program pattern] tab, then
selecting [Segment settings].

Select the pattern number
Select the segment number

Initialize the program pattern (initializes the segment setting only)
Segment setting

Insert a segment before the selected segment
Add a segment behind the last segment

Delete the selected segment
Expand/reduce the selected segment along the time axis

Display the time axis per the segment time ratio
Display program patterns together

Split-display the program pattern at each loop
Turns the set point display ON/OFF

Select current loop (activates the 
target value of the selected loop)

PV event display

Drag the bar 
to change the 
display area

Maximum value 
for target setpoints

Program pattern 
display

Time event 
display

Segment number

Target setpoint for 
selected segment 

Duration of segment
Start value for selected segment 

Minimum value for target setpoints

Drag the bar 
to change the 
display area
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Select the Segment
Click the [Segment No.] arrow to select the desired segment in the program pattern
display screen.

Select Setpoints
Enter a program pattern for each segment.

Click this tab

Loop number

Start setpoint 
(specified under 
[Default setting])

Select Ramp/Soak

Enter target setpoints

Enter the segment duration
Ramp-Rate Time Units
Slope
Segment PID group number
Segment shift action
Wait time
Wait zone number

• Ramp/Soak select
Select the type of segment to be specified ([Ramp] or [Soak]).

• Target setpoint (ramp segment only)
Set the final SP of the ramp segment in the range of “EU (0.0% to 100.0%)” (initial
value is 0%) of the measurement span. Only the loops that are set as follows are
available: [Setup]  tab> [Internal Loop] > [Control mode] to a mode other than [Off]
and [Program control] to [On] During cascade control, even-numbered loops within the
same terminal block are not displayed.

• Segment time
Set the segment time in the range of [0:00:01] to [99:59:59] (0 hour 0 min 1 s to 99
hour 59 min 59 s).  This item is available at all times during segment time setting
method and only when soak is selected during segment time ramp setting method.

• Ramp-rate time unit
Set the ramp-rate time unit for ramps to [Hour] or [Minute].  This item is available only
during segment ramp setting method.

• Ramp
Set the ramp per unit time in the range of “1 digit to EUS (100%) of the measurement
span.”  The measurement span and decimal point position of the selectable range
vary depending on the smallest numbered loop to be specified.  This item is available
only during ramp in the segment ramp setting method.

• Segment PID group No.
Select the segment PID group number [1] to [8].  This item is not displayed when zone
PID is selected.  Only the PID group numbers that can be specified through [Setup]
tab > [Control action] > [PID number] are displayed.

• Segment shift action
Set the segment shifting action to [Continue], [Hold] (hold after end of segment),
[Local] (local mode after completing the last segment), or [Reset] (reset mode after
completing the last segment).

Note
When creating the program pattern, data is created so that the segment set to [Local] or

[Reset] is the last segment of program control.
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• Wait action
Set the wait action type to [Shift] or [Within].  To disable the wait action, select [Off].

• Wait zone number
Select the wait zone number from [1] to [5].  This item is available only when [Wait
action] is set to [Shift] or [Within].

PV Event
Set the PV Event.

Click this tab PV event display

• Loop
Set the target loop number [1] to [6] of the PV event (only selectable loop numbers).
Up to 16 events can be assigned.  Select [Off] (initial setting) for the number of the
loops to which the event is not to be assigned.

• Type
Select the type of PV event from the following.
PV high-limit, PV low-limit, deviation high-limit, deviation low-limit, deviation high & low
limit, deviation within high & low limits, SP high-limit, SP low-limit , output high-limit ,
and output low-limit

• Value
Set the value in the following range according to the type of PV event.
PV/SP event: EU (0.0 to 100.0%) of the measurement span
Deviation high-limit event/low-limit event: EUS (–100.0 to 100.0%) of the
measurement span
Deviation high & low limit/within high & low limits: EUS (0.0 to 100.0%) of the
measurement span
Output event: –5% to 105% of output (% indication only for output events)

PV event display
A bar showing that the PV event was set is displayed in the upper part of the program
pattern screen display screen.
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Time Event
Set the Time Event.

Time even display

Click this tab

• On1/On2/On3/Off
Set the ON/OFF setting type of each event (16 events) from the following.  Select [Off]
for events that are not to be assigned.  Select [Off] (initial setting) for the number of
the loops to which the event is not to be assigned.
On1: Use On time and Off time
On2: Use On time only
On3: Use Off time only

• On-time/Off-time
Set the ON-time/OFF-time of the time event in “hh:mm:ss” format.  The selectable
range is “00:00:00 to 99:59:59.”  Set On-time ≤ Off-time.

Repeat
Set the repeat action.
The repeat start segment, repeat end segment, and repeat frequency is displayed in the
program display screen.

Repeat action

Repeat frequency

Repeat start segment

Click this tab

Repeat end segment

Segment number

Start segment for repeat
Number of 
repetitions

End segment 
for repeat
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• Repeat action
Select the repeat function from [Off], [On], and [Repeat].

• Repeat frequency
Set the number of repetitions when the repeat function is turned ON in the range of [1]
to [999].

• Repeat start segment/Repeat end segment
Set the repeat start segment number and the repeat end segment number when the
repeat function is turned ON or when repeating in the range of “1 to 99.”  However,
the maximum value is the maximum segment number set for the pattern. The
selectable range for the maximum value is
Set repeat start segment ≤ repeat end segment.

Event Output Setting(PV event-relay output/Time event-relay
output/Program pattern end signal)

Turn OFF/ON the relay output
Select the number of the relay output terminal

Relay output action (settings cannot be entered here)

Relay Output
Turn OFF/ON the relay output.

Number
Select the number of the relay output terminal from the following.
DO001 to 006, DO101 to 106, DO201 to 206, RO001 to 012 (on models with the
expansion DIO terminal block)

Action
Displays the relay output action (Energized/Nonhold) per the [Control Relay] settings on
the [Setup] tab.
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AUX (Automatic Message, Display Position)
Turn message display ON/OFF, and set the loop display position on the CX.

Message displays on the CX trend display screen

Display position when loop display on the CX is partitioned
Tag display (settings cannot be entered here)

Tag comment display (settings cannot be entered here)

On/Off
If you select [On] (initial setting), a message is automatically written on the trend display
when program control is started and when program control is stopped as shown in the
figure below.  If you do not wish to write messages, select [Off].  The message when
starting program operation is “PROGRAM RUN”; the message when stopping the
program operation is “PROGRAM RESET.”

Position
On the program selection display and program control display, the specified patterns and
PV waveforms can be displayed in the same display frame (full display) as well as
display data by dividing the display position per loop (split display).  When using split
display, select the display position number from [1] to [6] for each loop.  Applicable loops
are those set to [Control] > [#1 Control action, Input setting] > [Control mode] to a mode
other than [Off] and [Program control] to [On] During cascade control, even-numbered
loops within the same terminal block are not available.
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Basic Measurement Function Basic Settings
To enter measurement function basic settings, click the [Setup] tab.  Or, you can select
the items by choosing [Setting] - [SETUP [Basic] Setting] - [Setting].

Alarm/Relay/Remote
2. Click here. (Or choose the [Setting] menu - [SETUP [Basic] Setting] - [Setting].)

1. Select this tab.

Select the controlled item.

Select between 
1 and 15.

Copy/Paste the 
selected range.

Alarm/Relay
Select the alarm format.  The selected items are blue.

• Reflash
Set whether to use the alarm relay output reflash.

• Relay AND
Set the range of relays (from the first alarm relay) using the AND logic gate.  All other
relays are set to the OR logic gate.  If [NONE] is selected, all relays use the OR logic
gate.

• Relay Action
Select whether the alarm output relay should be [Energize] or [De-Energize] when an
alarm occurs.

• Alarm Relay Behavior
Select the output relay when returning from an alarm to the normal state of operation
(when the alarm is released).  This applies to all alarm output relays.  If the measuring
alarm output option is not active, this setting is invalid.
Unhold (Default): When the alarm is released, the output relay stays off.
Hold: The output relay stays on until an Alarm ACK operation is

performed.

• Alarm Indicator
Select the alarm indicator when returning from an alarm to the normal state of
operation.
Unhold (Default): The alarm display ends when the alarm is released.
Hold: The alarm display stays on until an Alarm ACK operation

performed.
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• Rate of Change Increase
Select the number of data samples that determines the interval of the rate of change
of an upper limit alarm between [1] and [15].

• Rate of Change Decrease
Select the number of data samples that determines the interval of the rate of change
of an lower limit alarm between [1] and [15].

• Alarm Hysteresis
Set the alarm hysteresis to [ON] or [OFF].  When it is [ON], the hysteresis is set to
0.5% of the scale or the measurement span.

Remote (Option)
You can assign items to be controlled by the eight remote control terminals.  This is
possible, if the measurement remote input is available.  For details, refer to the CX
User’s Manual (IM 04L31A01-01E or IM 04L31A01-03E).
Select a remote number, and then click the [Copy] button.  This copies the setting of that
remote number.  When you want to paste the copied setting, select the remote number
where you want to paste the setting, and then click the [Paste] button.

Scan Interval/Memory

Set these parameters when the data type is [EVENT & DISP] or [EVENT].

Click here. (Or choose the [Setting] menu - [SETUP [Basic] Setting] - [Setting].)

Select the channels that 
you want to sample.

A/D Integrate
Select from [Auto], [50 Hz], [60 Hz], and [100 ms].  The [Auto] setting automatically
detects the CX power supply frequency, and switches the integration time.

Scan Interval
Select [1s] or [2s].
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Memory Sample (save method of measured/computed data)
• Save

Select the save method of internal memory data to an external storage media from
[Auto] or [Manual].
Manual: Inserting the external storage media into the drive and closing the cover

displays the “Save confirmation” message, allowing data to be saved.  When
the operation is complete, remove the external storage media from the drive,
so that the next set of data save operation can be performed.  You can
select whether to save all of the data from internal memory or only to update
the data still not saved to an external storage media.

Auto: If an external storage media is always in the drive, data is saved
automatically at a preset interval.

• Data
Select the data to be written to internal memory from the following: [DISPLAY]
(displayed data only), [EVENT & DISP] (event data and displayed data), or [EVENT]
(event data only).

• Event Data Sampling Rate
Select the interval at which event data is saved from the following: [1s], [2s], [5s],
[10s], [30s], [60s], [120s], [300s], or [600s].

• Event Data Sampling Mode
Select [Free], [Trigger] or [Rotate].

• Block
When the data type is [EVENT], select 1, 2, 4, 8, or 16.

When the data type is [EVENT & DISP], select 1, 2, or 4.

• Data Length
Set the interval corresponding to the amount of data (data length) that can be written
as a block of the event data storage region.  The data length that can be set depends
on the event data sampling rate.  It also depends on the block setting and number of
Meas and Math channels.

• Pre-Trigger Length
If 0 is selected, the event file entirely consists of data after the trigger.  If 100 is
selected, the event file entirely consists of data before the trigger.

• Manual Trigger
When applying triggers with keys, select [ON].

• External Trigger
When applying trigger signals by remote input, select [ON].

• Alarm Trigger
When applying alarms as triggers, select [ON].

• Sampling
Select the channels to be saved to the memory.
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7.8 Setting CX Series

Memory Timeup
When the [Save] is set to [Auto] in [Memory Save], specify the date and time of the save
operation.

• Timeup type
Select the type of save interval from [Hour], [Day], [Week], or [Month].  When you are
not using this function, select [OFF].

• Day of the week/Date
When [Timeup type] is [Week], select a day.
When [Timeup type] is [Month], specify the date, between 1 and 28.  It is not possible
to specify dates 29 to 31.

• Time (hour)
When [Day], [Week], or [Month] is selected as [Timeup type], specify the time of the
save operation.  When [Timeup type] is [Hour], this setting is invalid.  Specify between
[00] and [23].

Channel (Setting the Burnout and RJC)
Click here. (Or choose the [Setting] menu - [SETUP [Basic] Setting] - [Setting].)

Set to the positive side (100%).
Set to the negative side (0%).

Set the reference junction compensation 
to [Internal] or [External].

Burnout
Set the burnout operation.  For details, refer to the CX User’s Manual (IM 04L31A01-01E
or IM 04L31A01-03E).

RJC Volt (uV)
Thermocouple input basic contact compensation setting.  For details, refer to the CX
User’s Manual (IM 04L31A01-01E or IM 04L31A01-03E).
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Copying and Pasting Setup Data
You can copy the setup data of one channel or more to other channels.  Use the
following procedure to copy and paste.

1. Click the source channel number that you want to copy.  To select many
channels, click the first source channel, then drag over all the channels that you
want to copy.

2. Click the [Copy] button at the bottom of the window.
3. Click the destination channel number.  To select many channels, click the first

destination channel, then drag over all the channels where you want to paste.
4. Click the [Paste] button at the bottom of the window.

You can also copy and paste specific channel items.
After selecting the copy source in step 1, click the [Copy Details] button to display the
[Setup Channel Copy Details] dialog box.
Select the items that you want to copy.

Key Lock/Login
Click here. (Or choose the [Setting] menu - [SETUP [Basic] Setting] - [Setting].)

Select when using a login, auto logout, and user ID.
Turn ON when using a login.

Key Lock Setting
• Key Lock

When using the key lock function, select whether or not to activate the key lock
function (lock or free).  For details, refer to the CX User’s Manual (IM 04L31A01-01E
or IM 04L31A01-03E).

• Password
Enter the password used to release the key lock using up to six characters.  [???] is
displayed after the password is entered.

Login Setting
• Use Login

When you use the login, auto-logout, or user ID, select the appropriate items.

• Auto Logout
Selected: if idle for ten minutes, logs out automatically.
Clear: need to perform the logout operation to log out.
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• User ID
Specify whether you want to use a user ID when logging in.  When selected, you
can specify user ID.

User Setting List
• User name

Use up to 16 characters for the user name.

• User ID
Up to 4 characters can be entered for the User ID.  [???] is displayed after the
password is entered.

• Password
Up to 6 characters can be entered for the password.  [???] is displayed after the
password is entered.

• Setup
Select whether to allow setting changes in the setup mode for the user.

Note
• If there is a duplicate [User Name] turned ON, the user with the larger user number is

turned OFF.

• If [Setup] of all users that are turned ON is set to [Disable], the [Setup] of the user with the

smallest number is set to [Enable].

Timer (Option)
Click here. (Or choose the [Setting] menu - [SETUP [Basic] Setting] - [Setting].)

Select one

Reset computation when a timeout occurs.
Save the data to the TLOG file when a timeout occurs.

Select the timeout interval.
Time out with the specified 
time as the reference.

Time out every time the specified time elapses.

You can set three types of timers to be used in the statistical computation.  You can save
the data to a TLOG file or reset the computation when the specified timeout interval
elapses.  This function is available only if the Computation function is installed.
For details about the types of timers and various settings, refer to the CX User’s Manual
(IM 04L31A01-01E or IM 04L31A01-03E).
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Report (Creating Hourly/Daily/Weekly/Monthly Reports, Setting
Available when the Computation Function Option is Active.)

Set the date and 
time at which to 
create the report.

Click here. (Or choose the [Setting] menu - [SETUP [Basic] Setting] - [Setting].)

Enable (ON) or disable (OFF) the report channel settings.
Select the channel to figure on report.

Type
Select the type of report.  For details, refer to the CX User’s Manual (IM 04L31A01-01E
or IM 04L31A01-03E).

Time
Specify the time for the report production time.  For details, refer to the CX User’s
Manual (IM 04L31A01-01E or IM 04L31A01-03E).

Report Channel
There are 12 report channels for CX1000 and 30 report channels for CX2000.
The check boxes on the right of the report channels are used to select what report to
produce.  Clear ([OFF]) the reports you do not want to produce.

RefCh
Selects the report reference channel.  For details, refer to the CX User’s Manual
(IM 04L31A01-01E or IM 04L31A01-03E).

Sum Scale
Select whether to convert the results of the TLOG.SUM computation channels to a
specified time unitary value.  Select [Off], [Sec], [Min], [Hour], [Day].  This function is
available only if the Computation function is installed.
For details, refer to the CX User’s Manual (IM 04L31A01-01E or IM 04L31A01-03E).

7.8 Setting CX Series
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Copying and Pasting Setup Data
You can copy the setup data of one channel or more to other channels.  Use the
following procedure to copy and paste.

1. Click the source channel number that you want to copy.  To select many
channels, click the first source channel, then drag over all the channels that you
want to copy.

2. Click the [Copy] button at the bottom of the window.
3. Click the destination channel number.  To select many channels, click the first

destination channel, then drag over all the channels where you want to paste.
4. Click the [Paste] button at the bottom of the window.

You can also copy and paste specific channel items.
After selecting the copy source in step 1, click the [Copy Details] button to display the
[Report Copy Details] dialog box.
Select the items that you want to copy.

Tag, Memory Alarm Time, Displayed Language, and Partial
Expanded Display Settings

Click either one. (Or choose the [Setting] menu - [SETUP [Basic] Setting] - [Setting].)

Tag/Channel
Select whether to use the tag name or channel number as the measurement/
computation channel label (See “Selecting the Characters Used to Identify Channels” on
page 4-11).
If you select tag name, you can select the label display from tag and channel.

Memory Alarm
Free internal memory is monitored, and the memory end can be programmed to activate
some period of time before the memory is completely full.  This time period is called the
memory alarm time.

Language
Select the language ([English] or [Japanese]) to be used on the CX’s display.

Partial
If set to [Not], the partial expanded display settings of the Meas, Math, and Control tabs
are void.

7.8 Setting CX Series
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Temperature Unit
Set the temperature unit from [C](Celsius) or [F](Fahrenheit).

1. Click here. (Or choose the [Setting] menu - [SETUP [Basic] Setting] - [Comm].)

Time Zone
Set the difference in time from the GMT.
For example, with Japanese time this is normally +9:00.

1. Click here. (Or choose the [Setting] menu - [SETUP [Basic] Setting] - [Comm].)

7.8 Setting CX Series
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Measurement Channels Settings
To enter measurement channel settings, click the [Meas] tab.  Or, you can select the
items by choosing [Setting] - [SET [Regular] Setting] - [Meas Channels].

Click this tab.
Double-click to set the channel.

Difference computation
Scale

Square root

Select the input mode.
Select the range/type.

Select the alarm type.

Select the relay number.

Select sampling count.

Turn ON/OFF the partial 
expanded display.

Set the value to the minimum value possible.

Set the value to the 
maximum value possible.

Select the reference for the difference 
computation.

Specify the 
span.

Specify a scale. Specify the unit of the scale.

Specify the alarm value.

Specify a tag name.
Specify a delay period.

Specify a display zone.
Select the graph settings.

Select the channel 
display color.

Initialize

Initialize

Set the value to the minimum value possible.
Set the value to the maximum value possible.

Turn OFF all at once.
Copy the settings of the first channel in the selected range to all other channels.

Select all at once.

Turn ON/OFF all at once.

7.8 Setting CX Series
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Input Type (Mode and Range/Type)
Select from the pull-down list.

Mode Relevant Settings

VOLT (voltage) Range, span L, and span U
TC (thermocouple) Type, span L, and span U
RTD (resistance temperature detector) Type, span L, and span U
DI (voltage level/contact input) Range, span L, and span U
SKIP (Measurement/Display OFF) None

Note
• When a value outside the range is entered or when the span L and span U are set to the

same value, they are corrected when the data is checked.

• If SKIP is selected, settings such as Delta/Scale/Sqrt and Range/Type are discarded.

Difference Computation and Reference
Displays the difference between the input and the reference channel.
If difference computation is performed between channels that have different range and
type settings, the decimal place of the result is set to that of the channel computing the
difference.  If the number of decimals of the reference channel is greater than that of the
channel computing the difference, the reference value below the least significant digit of
the channel the difference is rounded down beforehand.

Square Root
Computes and displays the square root of the input.  This setting can be used only when
the input mode is set to VOLT.  As necessary, set the span, scale, and unit.

Display Span
Sets the upper and lower limits (full scale) of the display.
When the span L and span U are set to the same value or when a value outside the
range is entered, they are corrected when the data is checked.

Scale
Scale L, scale U, and Decimal Point
The scale value is displayed by taking the range between scale L and scale U to be the
full scale.  Enter the upper and lower limits to which you want to convert the raw values.
Include the decimal point.
When the scale L and scale U values are set to the same value or when a value outside
the range is entered, they are corrected when the data is checked.

Unit
Enter the unit using up to six characters.

7.8 Setting CX Series
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Alarm
Four alarms (Alarm 1 to 4) can be specified on each channel.

Type
Select H, L, h (dH), l (dL), R (RH), r(RL) T, or t.  T or t is selectable when the style
number is greater than or equal to 2.  The selectable alarms vary depending on the input
mode and computation type.  For details, see section 7.2 of the CX User’s Manual (IM
04L31A01-01E or IM 04L31A01-03E).

Value
Alarm is generated using the specified value as the boundary.  The selectable range of
alarm values varies depending on the input mode and range.

Relay
To output relays, select the output relay number.  Otherwise, select [NONE].

Alarm Delay
An alarm is generated when the measured value stays above or below the specified
value for the specified length of time.

Moving Average
To use the moving average, select the sampling count (2 to 16).

Tag
Use up to 16 characters to specify a tag.
You can select tags instead of channel number to be displayed on the screen.
The [Setup] screen is used to select whether to display channel names or tag names on
the screen.
If tag is selected in [Tag/Channel] of [Aux] on the [Setup] tab.  You can select tag No.,
tag comment, or tag in the Data Monitor or Data Viewer.

Zone
You can select the range of the screen in which the waveform of each channel is
displayed.
Specify positions (%) on the display scale for the upper and lower limits.
The conditions for setting the zones are as follows:
• Range: 0% to 100%

The lower limit must be less than the upper limit
• The difference between the lower and upper limits must be at least 5%.

Graph
Divisions
Select the number of bar graph divisions.

Bar graph
Select the reference position of the bar graph.  Selecting [Center] when the bar graph is
vertical produces no effect.
It is set back to [Normal] when the data is checked.

Scale
When using scale display on the trend screen, select the scale display position.
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Partial
Expand (%)
Set the boundary for the partial expanded display.  The range is 1 to 99%.

Boundary
The conditions used to set the boundary vary depending on the measurement and
computation channels as follows:
• Measurement channel

When SCALE and SQRT are not used: Span L < boundary < span U
When SCALE and SQRT are used: Scale L < boundary < scale U

• Computation channel
Span L < boundary < span U
For details, refer to the CX User’s Manual (IM  04L31A01-01E or IM 04L31A01-03E).

Note
The partial expansion settings take effect when the partial expansion function is set to [Use]

in the [Aux] section of the [Setup] tab.

Display Color
You can select the display color of each channel from 16 colors.

Copying and Pasting Setup Data
You can copy the setup data of one channel or more to other channels.  Use the
following procedure to copy and paste.

1. Click the source channel number that you want to copy.  To select many
channels, click the first source channel, then drag over all the channels that you
want to copy.

2. Click the [Copy] button at the bottom of the window.
3. Click the destination channel number.  To select many channels, click the first

destination channel, then drag over all the channels where you want to paste.
4. Click the [Paste] button at the bottom of the window.

You can also copy and paste specific channel items.
After selecting the copy source in step 1, click the [Copy Details] button to display the
[Meas Channel Copy Details] dialog box.
Select the items that you want to copy.

7.8 Setting CX Series
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Setting One Channel at a Time

2. The channel settings 
dialog box opens.

3. Click the tab of the item 
to be set.

4. After setting the 
items, click here.

1. Double-click the 
channel that you want to set.

The items of the [Meas] tab can be set for each channel.  The items set here are the
same as the ones in the [Meas] tab of the Hardware Configurator.  For details, see the
page corresponding to the item.

7.8 Setting CX Series
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Computation Channel Settings
To enter computation channel settings, click the [Math] tab.  Or, you can choose [Setting]
- [SET [Regular] Setting] - [Math Functions].

Double-click to set the channel.
Click this tab.

Set the alarm (section 3.8).

Specify a tag (section 3.8).Enter the alarm period.

Display zone (section 3.8).
Set the graph (section 3.8).

Partial expansion (section 3.8).
Display color (section 3.8).

Turn ON/OFF the computation.

Select the number of decimals.

Specify on expression.

Set the display span (6 characters or less).
Specify the unit.

Specify the constant to be 
used in the expression.

Turn ON/OFF 
all at once.

Copy the settings of the first channel in the selected range to 
all other channels.

Initialize

Copy the settings of the first channel in the selected range to all other channels.

Computation ON/OFF
Select whether to perform computation for each channel.

Expression
Enter an expression using up to 40 characters.  For details about the expression, see the
CX User’s Manual (IM 04L31A01-01E or IM 04L31A01-03E).

Display Span
Set the upper and lower limits of the display.
The range is –9999999 to 99999999.  Set the number of decimals to four digits or less.
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Alarm and Tag
The settings are the same as the measurement channels.  For details, “Measurement
Channels Settings” (page 7-115).

TLOG Computation
Timer
Select one of the timers (1 to 3) set in the setup mode.
The computation interval of TLOG computation is set to the time assigned to the
selected timer.

Sum Scale
Set the sum scale.

Rolling Average
Rolling Average Computation ON/OFF
Select whether to compute the rolling average.

Interval
Select the sampling interval when rolling average is activated.

Times (Number of Samples)
Select the number of samples (number of data points used to compute the rolling
average).

Zone, Graph, Partial, and Color
The settings are the same as the measurement channels.  For details, “Measurement
Channels Settings” (page 7-115).

Constant
You can set constants to be used in the expression.  Up to 12 constants (CX1000) or up
tp 30 constants (CX2000) can be specified.

7.8 Setting CX Series
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Setting One Computation Channel at a Time

2. The channel settings 
dialog box opens.

1. Double-click the channel 
that you want to set.

3. Click the tab of the item to be set.
Click here to enter 
the operator.

4. After setting the items, 
click here.

Set the maximum value.
Set the minimum value.

Copy the first setting.

[Select Operator] dialog box

Operator button

Select the operator type and click the operator button.

The items of the [Math] tab can be set for each channel.  The items set here are the
same as the ones in the [Math] tab of the Hardware Configurator.  For details, see the
page corresponding to the item.

7.8 Setting CX Series
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Copying and Pasting Setup Data
You can copy the setup data of one channel or more to other channels.  Use the
following procedure to copy and paste.

1. Click the source channel number that you want to copy.  To select many
channels, click the first source channel, then drag over all the channels that you
want to copy.

2. Click the [Copy] button at the bottom of the window.
3. Click the destination channel number.  To select many channels, click the first

destination channel, then drag over all the channels where you want to paste.
4. Click the [Paste] button at the bottom of the window.

You can also copy and paste specific channel items.
After selecting the copy source in step 1, click the [Copy Details] button to display the
[Math Channel Copy Details] dialog box.
Select the items that you want to copy.

7.8 Setting CX Series
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Display Settings
To enter display settings, click the [Setting] tab.  Or, you can select the items by
choosing [Setting] - [SET [Regular] Setting] - [Display Setting].

Display

Click this tab.

Select the time per division.
Select the display format.

Key operation exits screen saver.
Key operation or alarm exits screen saver.

The screen saver function 
is activated when there is 
no key operation or alarm 
occurrence for the 
specified interval.

Display Update Interval
You can select the display update interval of the trend display from [1 min/div], [2 min/
div], [5 min/div], [10 min/div], [20 min/div], [30 min/div], [1 h/div], [2 h/div], [4 h/div], or [10
h/div] of the time axis.

Auto Save Interval
The auto save interval can be specified when the [Save] is set to [Auto] and the data
type is set to [DISPLAY] or [EVENT & DISP] in [Scan Interval/Memory] of the [Setup] tab.

Auto Scroll Time
This is the time period used to automatically switch the displayed group.  Select from
[5s], [10s], [20s], [30s], or [1min].
For details about the other settings, refer to the CX User’s Manual (IM 04L31A01-01E or
IM 04L31A01-03E).
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Message/File
Click here. (Or choose the [Setting] menu - [SET [Regular] Setting].)

Specify a message. Copy the message.

Paste as another 
message number.

Specify a comment.
Specify a save 
destination folder.

Message
Use up to 16 characters can be entered for the message.

File Header
Add a comment to the header section of the measurement/computation data file.

Directory Name
Specify the name of the folder where measurement/computation data files are saved.

Note
• Up to eight characters can be entered for the file header and director, name.  AUX, CON,

PRN, NUL, and CLOCK cannot be used.

• If the directory name is not specified, DATA0 (default) is automatically set as the directory

name.

Manual Save
Select whether to save all the data or data that has not been saved during manual save.
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Group/Trip Line
Click here. (Or choose the 
[Setting] menu - [SET [Regular] Setting].)

Click the tab of the group 
to be configured.

Select the channels that you want to 
register in the selected group (blue: ON).

Select the color of 
the trip line.

Specify a group name.

Set the trip line value by 
dragging the slider.

Set the trip line by 
specifying a value.

Turn ON/OFF the trip line display

Group Name
Use up to 16 characters can be entered for the group name.

Channel Configuration
The maximum number of channels that can be assigned to a group is 6 for the CX1000
and 10 for the CX2000.  The assigned channels are listed under [Channel
Configuration].

Trip Line
Up to four trip lines can be set to one group.
With regard to the trip lines set here, the first and second settings (No.1 and No. 2) refer
to the trip lines in Data Monitor and Data Viewer.  If you change them here, they also
change in Data Monitor and Data Viewer.  For details about the other trip line settings,
refer to the CX User’s Manual (IM 04L31A01-01E or IM 04L31A01-03E).
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View Group (only for CX2000)
Click here. (Or choose the [Setting] menu - [SET [Regular] Setting].)

Specify a view group name
Select or drag from the right the type of 
screen to be displayed.

Select the group to be displayed.

Type of screens 
available.

View Groups
Up to four view groups can be registered.

Group Name
Use up to 16 characters can be entered for the group name.  The group name appears
as a submenu of the [4 PANEL] display of the CX2000.

View Kind
The view group consists of four views.  Select the type of screen to display in each view.

Group
Depending on the type of view selected, the group displayed varies.  When selecting a
view from the [Meas] tag, select the group from the measurement groups (Group 1 to
10).  When you selecting a view from the [Control] tag, select the group from the control
groups (Group 1 to 8).

7.8 Setting CX Series
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User Key/Daylight Saving
Click one. (Or choose the [Setting] menu - [SET [Regular] Setting].)

Select the function to be assigned to the User Key.
Set the time at the daylight saving time 
adjustment is to be enabled/disabled.

For details about the User Key settings, refer to the CX User’s Manual (IM 04L31A01-
01E or IM 04L31A01-03E).
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Network Settings
To make network settings, click the [Setup] tab, then select the [Network] from the list on
the left.  It is also possible to select the item in [SETUP [Basic] Setting] on the [Setting]
menu.

TCP/IP Settings
Connect the CX to the Ethernet and, in the dialog box below, enter TCP/IP settings.
Type the same address for [IP Address] as the one of the [Address] box of the [Network
Settings] dialog box.

1. Click here. (Or choose the [Setting] menu - [SETUP [Basic] Setting] - [Comm].)
2. Click this tab

Specify the 
IP address

Enter the timeout value when 
turned ON

Specify these 
addresses when 
using the DNS

Serial Communication Settings
When using serial communications between the CX and other devices, set the
parameters required for serial communications.  In the [Protocol] settings, if [MODBUS
MASTER] is selected, you must to click the [Modbus master] tab and make Modbus
master settings.

Click this tab
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Modbus Master Settings
When using the CX as a Modbus master, enter the Modbus master basic and command
settings.  For details about the settings, refer to the CX Communication Interface User’s
Manual (IM 04L31A01-17E).

Click this tab

FTP Settings
Using the FTP function, measurement/calculation data can be automatically transferred
from the CX to the specified server as files.  The FTP function can be used only with
Ethernet communications.  When using the FTP function, specify the necessary [FTP
Connection] settings in the dialog box below.

2. Click the [Primary] or [Secondary] tab.
1. Click this tab.

Enter file transfer 
destination settings.
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Web Server Settings
When using Ethernet communications, the CX can be set up as a web server.  Set [Web
Server] to [ON], and then set the access certification for the operator page and monitor
page.

Click this tab

E-mail Transmission Settings
When using e-mail transmission, specify [SMTP server name], [Port number],
[Recipient1], etc.  For details about the settings, refer to the CX Communication Interface
User’s Manual (IM 04L31A01-17E).

Click this tab

By clicking the [Alarm], [Scheduled], [System], or [Report] tab, you can make settings
separately for each type of e-mail message.



7-132 IM 04D05C01-62E

7.8 Setting CX Series

Setup Data Adjustment

2. If the data is not consistent, 
the following dialog box opens.

1. Click here. (Or choose the [System] 
menu - [Data Adjustment].)

Click here to display the correction list.

Checks whether the specified setup is consistent with the actual system.  If not, the data
is automatically corrected.
Data is corrected in the following cases:
• When values of items of the Meas/Math tab are outside the specified range.
• When an invalid character string is used.

[Data Adjustment] Dialog Box
If [Data Adjustment] Dialog on the [View] menu is checked, the [Data Adjustment] dialog
box opens when data is not consistent checking data or transmitting data.

Note
Perform the data check before sending the new setup data to the CX.
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7.9 Writing Setting Parameters to the Recorder

When you have finished setting the recorder, write the setting parameters back to the
recorder.

Procedure
1. In the “DAQLOGGER Hardware Configurator” window, select “Communication” then

“Send.”
The “Select Recorders” dialog box appears.

2. Select the recorders to send data to and then click the “Send” button.
• To select all the recorders  Click “Select All.”
• To select individual recorders  In the list, currently connected recorders are

shown in blue. Click the recorder you wish to send data and it turns red.  You can
select more than one recorder.

When the destination recorder to send the settings is set to VR, DX, MV, or CX the
following message is displayed at the time when setup parameters are sent to the VR,
DX, MV, or CX.*

Select “Yes” to transmit the setup parameter to the VR, DX, MV, CX.  When multiple
VRs or DXs, or MVs , or CXs are selected, the following message is displayed when
the setup parameters are sent to the next VR, DX, MV, or CX.
Select “Select All” to send the setup parameters to all selected recorders (VR, DX,
MV, or CX included).
Select “No” to skip sending the data to the particular VR, DX, MV, or CX and go to the
next recorder.  When multiple VRs, DXs, MVs, or CXs are selected, the following
message is displayed when the setup parameters are sent to the next VR, DX, MV, or
CX.
Select “Cancel” to cancel the transmission of the setup parameters to subsequent
recorders including the current VR, DX, MV, or CX.

* For VR recorders, the data memory may be initialized depending on the setup parameters

that are changed.  For details, see the User’s Manual for the VR recorder (IM 4N1A1-01E or

IM 4N2A1-01E).

For DX/MV/CX, the data memory is initialized when the writing method to the internal memory

is changed.  For details, see the User’s Manual for the DX/MV/CX recorder (IM 04L01A01-

01E or IM 04L02A01-01E, IM MV100-01E, IM MV200-01E, IM 04L31A01-01E, IM 04L31A01-

03E).
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3. When the setting parameters have been sent, a “Communication Message” dialog box
appears.
Read the message and click “OK.”

Note
• Communication is not possible of the scanning or the recording is in progress.

• With the VR series, the settings data of “SETUP” cannot be sent to the recorder.

• With the DX/MV/CX series, the settings of network in the “Setup” tab panel cannot be sent to

the recorder, except for the setting of memory data output destination.

• Use the “File Export” function to set both series.

• Before connecting the hardware, check if Module Configuration matches the actual module

construction.

• If a file remains in the internal RAM disk of the DC100, it is not possible to send settings to its

internal RAM disk.  Initialize the internal DC100 RAM disk before sending data to the DC100,

or initialize the DC100 using this software.  In that case, make sure to first copy important

files.

•  If files remain on the DC100 internal RAM disk, when sending data to the DC100 the writing

action does not change automatically to SINGLE or REPEAT, when it was earlier set to

NONE on the DC100, and likewise, not to NONE if it is set to SINGLE or REPEAT on the

DC100.

•  If files remain on the DC100 internal RAM disk, when sending data to the DC100 , the

periodic file type does not change automatically to Meas or Report, when it was earlier set to

NONE on the DC100, and likewise, not to NONE if it is set to Meas or Report on the DC100.

• If data are sent, during computation, reporting, or (for DC only) data writing, those actions will

be canceled.

• If data are sent, during balancing for strain input or (for DR only) data writing to the internal

RAM disk, a communication error will be detected.

• If only altered settings are send event/action, Math, Report, or Memory  Pause, LEVEL

actions, will not be canceled.

• When using Ethernet communication, error detection may take a few minutes.

7.9  Writing Setting Parameters to the Recorder
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7.10 Initializing the Setup Parameters

The setup parameters of the SET mode and SETUP mode are reset using the specified
system configuration or subunit/module configuration (for DARWIN).

Procedure
1. With the “Setting” window of the recorder to be initialized open, select “Initialize” from

the “Setting” menu.
A message confirming the initialization is displayed.  Click “OK.”
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7.11 Handling Setting Data Using a Floppy Disk

Importing Files
The setup parameters on the floppy disk are loaded.

For VR, this function is used because the setup parameters of SETUP mode cannot be
transmitted via communications.  It is also used to edit the settings of VR and DARWIN
that do not have the communication option on the DAQLOGGER Hardware Configurator.
This function can also be used on DX, MV, CX and DARWIN with communication
functions.
DA and µR are not applicable.
The file type and extension are as follows:

.pnl: SET mode of VR series recorders

.pns: SET UP mode of VR series recorders

.pnl: DX/MV series recorders

.pcl: CX series recorders

.pnl: SET mode of DC100/DR130/DR200 recorders

.set: SET UP mode of DC100/DR130/DR200 recorders

For VR, DX, MV, CX

Procedure
1. Load data from the settings file created by the recorder.

For the VR series, in the menu bar of the “DAQLOGGER Hardware Configurator”
window, select “File”- “File Import,” then  “Set Mode” or “Setup Mode.”
For the DX series, in the menu bar of the “DAQLOGGER Hardware Configurator”
window, select “File”- “File Import.”
The “Open File” dialog box appears.

(File names)

2. Select the file to load and click “OK.”
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For DR, DC

Procedure
1. Load data from the settings file created by the recorder.

In the menu bar of the “DAQLOGGER Hardware Configurator” window, select “File”-
“File Import.”  The “Open File” dialog box appears.

(File names)

2.  Checkmark the “Overwrite” (Overwrite function, see below) if you want to overwrite
the file currently being edited, without changing system configurations.

The Overwrite function
If you open a file from the File list without using the Overwrite function, the file will be
opened, clearing the data earlier edited open file, including its system configurations.
If you use the Overwrite function when opening a file from the File list, the file will be
opened, overwriting the data settings edited so far.  System Configurations of the file
edited so far will remain the same.  If overwriting results in system inconsistencies, the
entire file may be impossible to open.

• Caution when loading a SET mode file (.pnl) saved to a DC100/DR internal
floppy disk.
If you open a SET mode file from a DC100/DR floppy disk, system info will not be
included, and therefore it may be impossible to open the data using the overwrite
function.  To prevent this from happening, do the following:
A. Open the SETUP mode file (which belong to the SET mode file to be imported)

without using the Overwrite function.  A dialog box for system configuration
confirmation will appear.

B. Synchronize the system configurations and open the file.

C. Checkmark the “Overwrite” and open the SET (Regular) settings.

7.11  Handling Setting Data Using a Floppy Disk
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3 If you click “Open” the data will be downloaded.  If the setting data which are at that
time being edited aren’t saved yet, you will be asked whether to save them or not.  A
warning will be displayed, if all data can’t be loaded.

Note
When data were acquired with the DC100, a message may appear warning you that some

changes have taken place. In that case, please check if all data have been acquired.

Exporting Files
Save the settings data edited using “DAQLOGGER Hardware Configurator” in a settings
file.
This function is used to configure the recorder with the settings data edited using
“DAQLOGGER Hardware Configurator” via a floppy disk.
The settings that cannot be done via communication are the setup mode setting of the
VR series and the network settings of the DX/MV/CX series.

Procedure
1. For “setup” of the VR series, in the menu bar of the “DAQLOGGER Hardware

Configurator” window, select “File”-“File Export,” then “Set Mode” or “Setup Mode.”
For “setup” of the DX, MV, CX, DR, and DC recorders, in the menu bar of the
“DAQLOGGER Hardware Configurator” window, select “File”-“File Export.”
The “Save As” dialog box opens.
VR, DX, MV, CX

(File names)

7.11  Handling Setting Data Using a Floppy Disk
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DR, DC

(File names)

“Comment” is void.

2. Save the data under a specified file name.  The file extension will be set automatically.
3. Load the file to the recorder by using the recorder’s settings reading function.

7.11  Handling Setting Data Using a Floppy Disk
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7.12 Saving the Settings

Save the settings data.
The settings will be saved under a file name in the following format to the project folder.
For example, the file name will be “Project1.r01” when the project name is “Project1” and
recorder number is “1.”

Procedure
1. In the “DAQLOGGER Hardware Configurator” window, select “File” then “Save” or “All

Save.”
• “Save”:  Saves data of the active settings window.
• “All Save”:  Saves data of all the settings windows which are opened.
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7.13 Printing the Settings

Operations of “Print,” “Print Preview,” and “Set Printer” under the “File” menu of
“DAQLOGGER Hardware Configurator” window are the same as those of Windows’ print
commands.

Procedure

Print Previewing
1. In the “DAQLOGGER Hardware Configurator” window, select “File” then “Print

Preview.”  The “Print Preview” dialog box appears.

Printing
1. In the “DAQLOGGER Hardware Configurator” window, select “File” then “Print.”

The “Select Recorders” dialog box appears.

2. Select the recorders to print, then click “OK.”
• To select all the recorders  Click “Select All.”
• To select individual recorders  In the list, currently connected recorders are

shown in blue. Click the recorder for which you wish to print settings and it turns
red. You can select more than one recorder.

3. Set the print settings and click “OK.”
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7.14 Transmitting Control Commands to the
Recorder

The following control commands can be transmitted to a recorder that can communicate
from the “DAQLOGGER Hardware Configurator” window.
The commands that can be transmitted and their contents vary depending on the series
or model.
• Date and time : All recorders.

Sets the date and time of the recorder to the date and time of the PC.
• Start/Stop recording : All recorders except VR and DA.

Starts/Stops the recording operation (writing to the recorder memory or recording to
the chart).

• Start/Stop computation : All recorders (with the computation function)
Starts/Stops computations on recorders with the computation function.

• Initialize memory : VR, DX, MV, CX and DC.
Initializes the data memory of the recorder.

• Select display : All recorders except DA.
Specifies the display screen of the recorder.

• Reconstruct : DA, DR200 ( expandable models), and DC.
When using DARWIN for the first time or when the system, connected units, or
modules are changed, the system must be reconfigured.  You cannot reconfigure on
DR standalone models (DR130/DR231/DR241).

Procedure
1. In the “DAQLOGGER Hardware Configurator” window, select “Hardware Controls”

from the “Communication” menu.
The “Set Controls and Select Recorders” dialog box opens.

2. Select the recorders to send commands to.
• To select all the recorders  Click “Select All.”
• To select individual recorders  In the list, recorders that are currently connected

are shown in blue.  Click the recorder you wish to send commands to and it turns
red.  You can select more than one recorder.

3. From the command item list in the left part, click the control command to display its
settings dialog box.
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4. Set for the control command.
Date and time

Start/stop recording

Start/stop computation

Initialize memory

Select display

7.14  Transmitting Control Commands to the Recorder
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 “Display” command differs from recorder models as follows.
VR200 S2 µR1000/µR1800

DX100/MV100/CX1000 DX200/DX200C/MV200/CX2000

DR130/DR200 DC100

With “Display” command, note the following.

Note
• With models other than VR206 and VR106, sending any non-standard display will cause an

error.

• When manual display is selected with the µR series, you can select channels which do not

exist in the connected recorder.  However, selecting nonexisting channels and sending

commands will cause a communication error.

• As for DR and DC, no communication error results, even if the display command that is not

applicable to the connected recorder is sent.

• With CX series instruments, if you enter settings related to program operation in “Mode” on

models with the /PG1 or /PG2 option prior to transmission, an error will occur.

7.14  Transmitting Control Commands to the Recorder
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7.14  Transmitting Control Commands to the Recorder

Reconstruct
For DA, DR200 ( expandable models), and DC only.

5. When you have finished setting commands, press the “Send” button.
When the commands have been sent, a “Communication Message” dialog box
appears.

6. Read the message and click “OK.”
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7.15 Starting/Stopping the DARWIN Report
Function and Executing Balancing

On DARWIN, you can start or stop the report function and executing balancing of strain
input.

Starting/Stopping the DARWIN Report Function
This is valid on DARWIN with the report function.

Procedure
1. In the “Recorder List” window, click the “Number” cell of the recorder on which to start

or stop the report function to display the “Settings” window.
2. Select “Action” - “Report” from the “Communication” menu.  The report function of the

corresponding recorder starts or stops every time the menu command is selected.

Executing Balancing on Darwin
This is valid on DARWIN with strain input.

Procedure
1. In the “Recorder List” window, click the “Number” cell of the recorder on which to

execute balancing of strain input to display the “Settings” window.
2. Select “Action” - “Balance” from the “Communication” menu.  Balancing is executed

on the corresponding recorder every time the menu command is selected.
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8.1 Starting the Remote Monitor/Connecting to the
Server

Remote Monitor receives data from the server (host) on the network and displays the
data in the following six types of monitor screens: alarm, trend, color graph, numeric,
meter, and circular.  The monitor server must be running on the server side.
For a description on how to use each monitor, see section 8.2.

Starting the Remote Monitor
Procedure

1. From the Start menu, select “Programs” - “DAQLOGGER Client” - “Remote Monitor.”
The Remote Monitor program starts and the Remote Monitor window appears.

Connecting to the Server
Procedure

Making a new connection
1. Select “File” - “New” from the menu bar.  A trend monitor window appears.
2. Click “Connect/Disconnect” on the toolbar or select “Connect” from the “File” menu.

The “Connect Setting” dialog box opens.

Chapter 8 Using DAQLOGGER Client Package
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3. Click each item box and enter the value.
Server Host: The name of the server.
Port No.: The port number to use.  This value must match that of the server.  The
default value is 50280.
System No.: You do not need to set this value.  It is fixed to 0.
Step: Specify the interval at which to receive the data from the server in terms of data
points (the server transfers scan data).  The default step value is 1.
For example, if the scan interval is 2 s and the step is set to 5, the remote monitor
receives data at 2 x 5 = 10 s intervals.

4. Click “Connect” to connect to the server.  Data are displayed on the monitor window.
Clicking “OK” confirms the settings and closes the dialog box.  Connection is not yet
made to the server.
Clicking “Cancel” discards the settings and closes the dialog box.

Note
• The monitor server must be running on the server side for the remote monitor to connect to it.

• Depending on the line condition, the connection may be disconnected.  In that case,

reconnect to the host.

• To use the Remote Monitor, a Ethernet card must be installed in the PC and the TCP/IP

protocol installed.

• If you selected “OK”, you can click “Connect/Disconnect” on the toolbar or select “File” -

“Connect” to connect to the server.

Saving the connection settings
1. Select “Save” from the “File” menu.  The new connection settings are saved.  The file

name is “Server Host”.rmt.
Or, select “Save As” from the “File” menu.  The “Save As” dialog box opens.  Specify
the destination directory and file name and click “Save.”  The new connection settings
are saved.  The file extension is “.rmt.”

Note
When the connection settings are saved, the display conditions (see section 8.2) are also

saved.

8.1  Starting the Remote Monitor/Connecting to the Servers
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Connect to a server by opening the connection settings file
1. Select “Open” from the “File” menu.  The “Open” dialog box opens.

2. Select a file and click “Open.”  The dialog box closes and the “Trend” monitor window
is displayed.

3. Click “Connect/Disconnect” on the toolbar or select “Connect” from the “File” menu.  A
connection is made to the server, and data are displayed on the monitor window.

Connecting to another server
1. Select “New” or “Open” from the “File” menu and carry out the steps described in

“Making a new connection” or “Connect to a server by opening the connection
settings file” described before.

Note
You can connect up to 16 servers.

Pausing/Resuming the Monitor
Pauses the updating of the display in the monitor window.  The data continue to be
retrieved while the monitor is paused.  Therefore, when the monitor is resumed, the data
retrieved while the monitor was the pause are also displayed.

Procedure
1. Click the monitor window you wish to pause so that it is displayed in front.
2. Click “Pause” on the toolbar or select “Pause” from the “File” menu.

Note
Only the monitor of the selected connection settings is paused.

3. To resume the monitor, click “Pause” again or select “Pause” from the “File” menu.

8.1  Starting the Remote Monitor/Connecting to the Server
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Disconnecting from the Server/Closing the Connection Settings
Procedure

Disconnecting from the server
1. Click the monitor window you wish to disconnect so that it is displayed in front.
2. Click “Connect/Disconnect” on the toolbar or select “Disconnect” from the “File” menu.

A confirmation dialog box appears.  Click “OK.”  The communication with the server is
disconnected.

Note
Only the communication corresponding to the connection settings that is used by the selected

monitor window is disconnected.

Closing the Connection Settings
You can carry out this operation after disconnecting from the server.  Closing the
connection settings closes all monitor windows that were opened using those connection
settings.
1. Click the monitor window that is using the connection settings so that it is displayed in

front.
2. Select “Close” from the “File” menu.  All monitor windows that were opened using the

connection settings are closed.

Terminating the Remote Monitor
Procedure

1. Select “Exit” from the “File” menu.  You can also click the close button that is located
at the right end of the title bar of the remote monitor window.  The remote monitor
window closes.

Note
Terminate the remote monitor after disconnecting all connections to the server.

8.1  Starting the Remote Monitor/Connecting to the Server
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8.2 Monitoring the Data

Displaying the Monitor Window
The monitor window is displayed within the remote monitor window.  The contents of the
menu bar of the remote monitor vary depending on the selected monitor window.  The
toolbar displays all the tool buttons.  However, only the buttons related to the selected
monitor window can be used.

Procedure
1. Click the appropriate monitor window from the “Alarm Monitor,” “Trend Monitor,”

“Color Graph Monitor,” “Numeric Monitor,” “Meter Monitor,” and “Circular Monitor” or
select the monitor from the “Window” menu.  The monitor window is displayed.

Note
• The number of monitor windows that can be opened for a single connection is as follows:

“Alarm Monitor”: 1

“Trend Monitor”: Up to 4

“Color Graph Monitor”: Up to 4

“Numeric Monitor”: Up to 4

“Meter Monitor”: Up to 4

“Circular Monitor”: Up to 4

However, opening multiple windows degrades the performance of the PC.

• To arrange the monitor windows, select “Cascade” or “Tile” from the “Window” menu.

Selecting the monitor display format 
(from the left: alarm, trend, color graph, numeric, meter, and circular)

Display version informationMonitor windowGeneral display settings

Pause the monitor
Connect/Disconnect communications
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Alarm Monitor
For the operation procedure, see the sections indicated below.
• “Alarm Monitor” in section 3.3.
• “Displaying cursor’s values with the Alarm Log display” in section 3.4.
However, you cannot check the alarms (Note in page 3-17).
Overview display
Displays the alarm conditions by groups.

Switching between overview and log Display cursor’s values
Switching between Tag Name and Tag Number

Turn ON/OFF the link

The alarm condition within the group is indicated using the following four patterns.
• Green lamp: Of the tags that are registered in the group, no alarm is occurring 

among the tags of which the waveform display is turned ON.  Or, not a single 
alarm is specified in any of the tags.

• Red lamp: Of the tags that are registered in the group, an alarms is occurring 
in one of the tags of which the waveform display is turned ON.

• Green lamp and a blinking yellow ring: Currently no alarm is occurring, but 
there is an unconfirmed alarm.

• Red lamp and a blinking yellow ring: Currently an alarm is occurring, and there 
is an unconfirmed alarm.

Log display
Displays a list of the type, the time of occurrence and release, and the tags of the alarms
that occurred in the past.  Up to 100 incidents can be displayed.

Alarm level (L1, L2, L3, and L4)
Alarm type characterAlarm type icon

Occurrence/Release

Time of alarm occurrence/release
Alarm condition icon (red: occurrence, green: release)

8.2  Monitoring the Data



8-7IM 04D05C01-62E

 U
sin

g
 D

A
Q

L
O

G
G

E
R

 C
lien

t P
ackag

e

8

Alarm type icons

Delay upper limit alarm (Red) Delay lower limit alarm (Blue)

Difference upper limit alarm (Red) Difference lower limit alarm (Blue)

Rate-of-change alarm (+) (Red) Rate-of-change alarm (-) (Blue)

PV high-limit (Red)
Deviation high-limit
SP low-limit
Output high-limit

PV low-limit (Blue)
Deviation low-limit
SP low-limit
Output low-limit

Other alarmDeviation high-limit alarm Deviation high & low limit alarm

Alarm abbreviations are given as follows:
H: PV high-limit alarm
PVH: PV high-limit alarm (high-limit alarm for PV values of the CX control channels)
DVH: Deviation high-limit alarm (only CX)
SPH: SP high-limit alarm (only CX)
OTH: Output high-limit alarm (only CX)

L: PV low-limit alarm
PVL: PV low-limit alarm (low-limit alarm for PV values of the CX control channels)
DVL: Deviation low-limit alarm (only CX)
SPL: SP low-limit alarm (only CX)
OTL: Output high-limit alarm (only CX)

dH: Difference upper limit alarm
dL: Difference lower limit alarm
RH: Upper limit on rate-of-change alarm
RL: Lower limit on rate-of-change alarm
tH: Delay upper limit alarm
tL: Delay lower limit alarm
DVO: Deviation high & low limit alarm (only CX)
DVI: Deviation within high & low limit alarm (only CX)
ETC: Other alarms (only CX)

8.2  Monitoring the Data
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Trend Monitor
For the operating procedure, see “Changes Common to Monitor Windows” and “Trend
Monitor” in section 3.3, “Changing the Display Settings of Monitor Windows.”
For operations using the cursor, see section 3.4, “Using the Cursors.”
For details on general display settings, see “Setting the Display Conditions” in this
section (page 8-13).
However, the following operations are different.
Switching tag number/name display
1. To display tag numbers, select “Tag No.” or “Channel No.” from the “View” menu or

click “Tag No.” or “Channel No.” on the toolbar.
To display tag names, select “Tag Comment” from the “View” menu or click “Tag
Comment” on the toolbar.

Turn ON/OFF 
waveform display

Select the displayed group

Turn ON/OFF the link

Turn ON/OFF the alarm indication

Switch tag number/tag name

Zoom in or out of the time axis
Waveform display zone

Waveform display limit (clip)
Cursor value display button

Display version information

Current waveform 
mark
Zone bar

Zone display area

Adjust the grid 
brightness

Group alarm condition Alarm indication
Absolute or relative time

Zoom factor Show/Hide condition of the zone 
display area

Drag this bar to adjust the width of 
the waveform display area

Adjust the 
brightness of the 
waveform display 
area

8.2  Monitoring the Data
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Color Graph Monitor
For the operating procedure, see “Color Graph Monitor” in section 3.3, “Changing the
Display Settings of Monitor Windows.”
For operations using the cursor, see section 3.4, “Using the Cursors.”
For details on general display settings, see “Setting the Display Conditions” in this
section (page 8-13).

Zoom factor 

Select the displayed group

Switch tag number/tag name
Zoom in or out of the time axis

Display cursor value
Waveform display color

Tag number/tag name

Color of the color graph
Displays by using the 50 different colors that are assigned 
between the minimum and maximum values of the scale. 
In the following order: 
blue (minimum), light blue, green, yellow, and red (maximum). 

Absolute or relative timeGroup alarm condition

8.2  Monitoring the Data
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Numeric Monitor
For details on general display settings, see “Setting the Display Conditions” in this
section (page 8-13).

Group alarm condition

Select the 
displayed group

Turn ON/OFF the alarm indication
Switch tag number/tag name

Alarm indication (from the left: level 1, 2, 3, and 4)

Waveform 
display color

Tag number/tag name

Bar display of the retrieved data

Meter Monitor
For details on general display settings, see “Setting the Display Conditions” in this
section (page 8-13).

Select the displayed group

Turn ON/OFF the link

Turn ON/OFF the alarm indication
Switch tag number/tag name

Alarm indication (from the left: level 1, 2, 3, and 4)

Tag number
/tag name

Alarm point

Group alarm 
condition

Numerical display 
of the current value

Bar meter Analog meter Thermometer

8.2  Monitoring the Data
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Circular Monitor
Displays the data over an hour to four weeks on a circular graph.  On the circular graph,
the radius corresponds to the Y-axis of the trend display and the circumference
corresponds to the time axis.

Select the displayed group
Connect/Disconnect the monitor

Pause the monitor
Turn ON/OFF the link 

Turn ON/OFF the alarm display
Set general display settings

Select tag number/tag name display
The red bar blinks when an alarm occurs

Mark the current 
waveform
Zone display area

Turn ON/OFF circular 
display

Date
Cursor

Absolute or 
relative time

Move the waveform 
display position (scroll bar)

Alarm display
Displayed time per cycle

Brightness adjustment 
knob of the waveform 
display area

Grid brightness 
adjustment knob

Show/Hide zone 
display area

Zoom in or zoom out of the time axis
Set the Y-axis

Display the cursor’s value

Waveform label
(Select tag No. 
or tag name)

The following operations can be carried out:
• Use display zones (user zone, edit zone, full zone, slide zone, auto zone, multiple-axis

zone).
• Show/Hide alarms.
• Switch Tag No. display/Tag Name display.
• Select the thickness of the waveform display lines.
• Set the time axis to absolute time or relative time display.
• Adjust the brightness of the waveform display area and grid.
• Show/Hide alarms.
• Use cursors.
The operating procedure is the same as that of the trend monitor except for “Setting the
Time Axis,” “Setting the Y-Axis,” and “Alarm Indication” described on the next page.  In
addition, you cannot drag & drop the trip line on the circular monitor (page 3-15).  To
change the position of the trip line, change the value in the “General Display Settings”
dialog box.
For the operating procedure, see “Changes Common to Monitor Windows” and
“Trend Monitor” in section 3.3.
For details on general display settings, see “Setting the display conditions” in this
section (page 8-13).
For operations using the cursor, see section 3.4, “Using the Cursors.”

8.2  Monitoring the Data
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Procedure
Setting the Time Axis
• Selecting the displayed time

1. Click the “Time-Axis” menu.

2. Select the displayed time per cycle. 

Note
The number of displayed data points for a single waveform is 1800.  The time over which the

measured data can be monitored on the circular screen depends on the scan interval and the

step value (P. 8-1).

Setting the Y-Axis
• Waveform display limit

The circular window displays a limited range of values along the Y-axis that is
specified by the maximum and minimum values under “Scale” in “General Display
Settings.”

Alarm Indication
You can select the position where the alarm will be indicated, inside or outside the
waveform display area of the circular window.
1. Select “View” - “Alarm.”

The alarm will be indicated.

2. Select “View” - “Alarm Inside” or “Alarm Outside”

Alarm Inside Alarm Outside

8.2 Monitoring the Data
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Setting the Display Conditions
Set up to 32 tags per group and register up to 50 groups.
1. Click “General Display Settings” on the toolbar or select “General Display Settings”

from the “File” menu.  The “General Display Settings” dialog box opens.

3. Click the tab of the group to be configured.

Turn ON/OFF waveform display (Blue is ON)
Turn ON/OFF at once

The waveform corresponding to the waveform No. that is clicked becomes active.

Activate the settings and close the dialog box
Assign numbers to the tags in the selected range in ascending order

Register the tag
Show/Hide the Y-axis

Copy the settings of the first tag in the selected range to all other tags
Set the selected range at once

Initialize
Activate the settings

Copy the setup data of the 
active waveform number

Select the items to be copied

Paste the copied setup 
data to the active 
waveform number

Enter the group name
Select normal display or exponential display

Select the type of meter monitor.

Show/Hide the trip line
Enter the trip line

Enter the display position
Enter the display range

Display color

To select normal display or exponential display, carry out the following procedure.  The
operating procedure of other items is the same as the “General Display Settings” dialog
box of the DAQLOGGER.  See section 3.2.

Selecting normal display or exponential display of values
Click the button.  The retrieved data are displayed in exponential form when “E” is
displayed.
Example: Normal display: 200.0, exponential display: 2.000E2

8.2  Monitoring the Data
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Saving the Display Conditions
The display conditions that have been changed are saved when the connection settings
are saved.
See “Saving the connection settings” (page 8-2).

8.2  Monitoring the Data
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8.3 Using the Historical Viewer

The Viewer displays the data that have been recorded by the logging software as a
waveform or values.  You can also view the data that have been created by the report
function.
The Viewer window can display the following data files.

• Data file that has been recorded by the logging software (extension: .mld)
• Report binary file that has been created by the Report Generator (extension: .rbi).

Note
You cannot use the Viewer to load the data file that has been stored to the floppy disk by the

VR, DX, MV, CX, DC, and DR recorders.

The Viewer that is provided in the client package is started from the Start menu of
Windows.  The operating procedure of the Viewer is the same as DAQLOGGER
Historical Viewer.

Starting Historical Viewer
Procedure

1. From the Start menu, select “Programs” - “DAQLOGGER Client” - “Historical Viewer.”
The Viewer starts and the Viewer window appears.

Operating the Historical Viewer
For the operating procedure, see chapter 4.

Note
The following two points differ from the DAQLOGGER Historical Viewer.

• The program can only be started from the Start menu of Windows.

• Data that are being scanned or recorded by the logging software cannot be displayed.



8-16 IM 04D05C01-62E

8.4 Using the File Utility

The File Utility performs four functions, Link, Divide, Convert, and Restructure, on the
data file or report file that the DAQLOGGER creates.

The File Utility that is provided in the client package is started from the Start menu of
Windows.  The operating procedure of the File Utility is the same as the DAQLOGGER
File Utility.

Starting the File Utility
Procedure

1. From the Start menu, select Programs > DAQLOGGER Client > File Utility.  The File
Utility starts.

Operating the File Utility
For the operating procedure, see chapter 5.

Note
The following point differs from the DAQLOGGER File Utility.

• The program can only be started from the Start menu of Windows.
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8.5 Using the Remote Controller

The following remote control operations can be performed via Ethernet.
• Start/stop scan on the logger software.
• Start/stop recording.
• Start/stop the Event Processor.
• Execute events on the Event Processor manually.
To use the remote control functions, you must first enter control server settings on the
DAQLOGGER Manager.

Using the Remote Control Software
Procedure

1. Choose Start > Programs > DAQLOGGER Client > Remote Controller to start the
remote control software.

Closes the remote control software

Connection status
Blue: not connected
Red: connected
When not connected, click to display
the communications settings screen  

2. Press the Communications settings button to display the communications setting
screen.

3. Enter the Host Name, Port No., and Login Password.
Host No.: Specifies the PC used as the remote control server.
Port No.: Specifies the port number set on the remote control server.
Login Password: The password set on the remote control server.

4. Press OK to save the host name and port number.  A maximum of 10 host names and
port numbers can be saved.  The saved host names and port numbers are displayed
in the pull down menu.

5. Press Connect to connect with the specified PC.
6. By pressing a button on the DAQLOGGER Remote Controller, you can operate the

DAQLOGGER running on the connected PC.  If you press the User Even button, the
process set as the user event is executed per the event conditions on the Event
Processor of the connected DAQLOGGER (see page 6-4).
If password protection is activated on the connected DAQLOGGER manager, the
password entry screen appears. Also, an icon indicating that password protection is
active will appear on the screen along with a message. Enter the password for the
manager.
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Chapter 9 Errer Messages and Their Corrective Actions

9.1 Error Messages and Their Corrective Actions

Messages are displayed under some situations when using the DAQLOGGER or
DAQLOGGER Client Package.  The following list shows the meanings of the messages
and explains what to do when they are displayed.

Common

Code Error message What to do

E0002 Insufficient memory. Please exit at once. Terminate other applications and start again or reboot the
OS and start again.

E0003 Cannot open shared memory. Terminate other applications and start again or reboot the
OS and start again.

E0101 Please open from the DAQLOGGER manager. Open it from the DAQLOGGER Manager because it cannot
be opened alone.

E0211 Cannot write to file. Check if the disk capacity is sufficient or if the file system is
normal.

E0212 Cannot read file. Check if the file exists and is supported by the software or if
the file system is normal.

E0213 Cannot open file. Check if the file exists and is supported by the software or if
the file system is normal.

E0401 Communication error. Check if the recorder connected for communication is
powered on and if the cable is properly connected. Also check
the following items according to the communication type.
• For Ethernet

Check if address settings are correct; the TCP/IP protocol
is installed in Windows; the Ethernet card is properly
installed.

• For RS-232 and RS-422-A
Check if the baud rate settings match; the port (COM1 to
COM9) settings match, the address settings are correct
(RS-422-A); the serial port of the PC is active and the
appropriate cable is being used.

E0501 Invalid serial number. Please reinstall the software. Install the software again.

E0602 Cannot execute because of password protection or Cancel password protection or transfer to the Supervisor
operator level restrictions. project then execute again.

E0603 Cannot execute while scanning/recording is in progress. Stop scanning/recording.

Code Warning message What to do

W0601 Cannot save changes because of password protection or —————
operator level restrictions.

W2003 Other applications are still in use. Please close other Terminate the applications in use.
applications first.

Logger Software

Code Error message What to do

E3001 Failed to open data file. Check if the disk capacity is sufficient or if the file system is
normal.

E3002 Failed to write data file. Check if the disk capacity is sufficient or if the file system is
normal.

E3003 Failed to open alarm log. Check if the disk capacity is sufficient, if you are using programs
other than DAQLOGGER, or if the file system is normal.

E3004 Failed to write alarm log. Check if the disk capacity is sufficient, if the alarm log file is
being used by another application, or if the file system is normal.

E3005 Tag is not specified. Please specify tag first. Specify the tag to collect data with the Tag Editor.

E3006 Connection failure for all devices. Use the Software Configurator to check the settings for
communication with recorders.  Also refer to the instructions
for E0401, because the error may be a communication error.
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Code Warning message What to do

W3030 Connection failure for some devices. Use the Software Configurator to check the settings for
communication with recorders.  Also refer to the instructions
for E0401, because the error may be a communication
error.

Viewer

Code Message What to do

M3101 There are no data. ————

M3102 There are no saved tags. ————

Tag Editor

Code Warning message What to do

W3201 No recorder is assigned to this tag number. Assign a recorder to the tag number.
Please assign a recorder to the tag number.

W3202 Settings don’t fit currently connected model. Use the Software Configurator to check the connected
recorder.

W3407 Communication settings are incomplete. Use the Software Configurator to check the communication
settings.

Software Configurator

Code Warning message What to do

W3331 The µR1000 and µR1800 cannot be distinguished Select µR1800 or µR1000 manually.
automatically.  Please select the correct recorder model.

W3332 The recorder model can’t be recognized.  It will be Check the model of the connected recorder.
regarded as not connected.

W3333 The VR100 and VR200 cannot be distinguished Select VR100 or VR200 manually.
automatically.  Please select the correct recorder model.

Code Message What to do

M3361 Model determination was successful. ————

Hardware Configurator

Code Error message What to do

E3401 Failed to send command. Settings don’t fit currently Check the model of the connected recorder.  If computation
connected model or computations may be in progress. processing is in progress, stop the computation then send

command.

E3402 Failed to receive command. Settings don’t fit currently Check the model of the connected recorder.
connected model.

E3403 File is invalid.  Hardware Configuration settings will Check if you have specified a hardware configuration setting file.
return to default.

E3404 Cannot send command while IC memory is in use. Stop the IC memory operation, then send command.

E3405 Data memory is full.  Please delete all data and send again. Clear the data memory, then send data.

E3408 Invalid user name or password. Use the Software Configurator to check the user name and
password.

E3409 Data cannot be send when logged in as User.  Login as Use the Software Configurator to set the login name of
administrator and send again. administrator.
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9.1  Error Messages and Their Corrective Actions

Code Error message What to do

E3410 Some setting could not be sent. Check the model and options of the connected recorder.

E3411 Cannot send command while computations or memory Stop the recorder’s memory sampling or computation
sampling are in progress. processing, then send command.

E3412 This file does not fit settings made with DAQLOGGER Abort loading. Check the contents of the file.
Software Configurator.  Cannot read this file.

E3413 Communication not possible.  Temperature units don't Check the temperature unit.
match.

E3414 Connected to different model. Check the connected device.

E3415 Please change connected hardware to SET mode. Check the connected device.

E3416 Please enter an equation. Set an expression.

E3417 Unknown symbol is entered. Please change equation. Check the setup parameters.

E3418 Invalid channel number is entered.  Please change Check the setup parameters.
equation.

E3419 Incorrect use of parenthesis.  Please change equation. Check the setup parameters.

E3420 Grammatical error.  Please change equation. Check the setup parameters.

E3421 These data were generated by another model. Check the setup parameters.

E3422 Temperature units in file must match software. Check the temperature unit.

E3423 Failed to load data.  Some data initialized. Check the contents of the file.

E3424 Invalid channels are included in the copy source. Check the copy source and copy destination settings.

E3425 Character string is incorrect. Check the setup parameters.

E3426 Invalid channel number. Check the channel number.

E3427 For input range, please keep CH numbers Check the setup parameters.
Left < Right.

E3428 Channel number is already being used! Check the setup parameters.

E3429 Incorrect file name! Check the file name and extension.

E3430 Now Controlling. Can’t store settings. Send the settings after halting control operations on the CX.

Code Warning message What to do

W3431 Memory may be initialized.  Continue sending data? If necessary, save the data in the data memory onto a
medium before sending data.

W3433 This file does not fit settings made with DAQLOGGER Use the Software Configurator to check the model
Software Configurator. Continue? information set.

W3434 This setting is initialized. OK? ————

W3435 System configuration is changed.  Setting is initialized. OK? ————

W3436 Hardware and software configurations don't match. ————
Continue to send?

W3437 Hardware model doesn't match software setting. ————
Continue sending?

W3438 Hardware and Software configurations don't match. ————
Continue sending data?

W3439 Style numbers don't match.  Continue sending? ————

W3440 Hardware and Software options don't match. ————
Continue sending?

W3441 This is a reference channel.  Channels refering to this ————
channel will be changed too!

W3442 Settings of other power module channels will be ————
changed too!

W3443 Some data couldn't be read. ————

W3444 Some existing data were changed. ————

W3445 Writing operation was changed. ————

W3446 Some channels out of the copy range will be changed too!
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Code Warning message What to do

W3447 The digital print settings of some measurement and math ————
channels have been changed.

W3448 The relay settings of some measurement and math ————
channels were set OFF.

W3449 Some Event/Action settings have been changed. ————

W3450 Following the change of temperature unit, SET (Regular) ————
settings have been initialized.

W3451 This file does not fit system settings made with ————
DAQLOGGER Software Configurator. Continue?

W3452 Contains invalid data. Open this setting? ————

W3453 All program pattern configuration will be initialized. ————
Continue?

W3454 This pattern configuration will be initialized.Conutinue? ————

Code Message What to do

M3461 Some channels could not be copied. ————

M3462 Communication was successful. ————

M3463 Communication was cancelled. ————

M3464 Communication was aborted. ————

M3465 Continue to send? ————

M3467 Add Unit? ————

M3468 Delete Unit? ————

M3469 Initial balancing failed. ————

DAQLOGGER Manager

Code Error message What to do

E3503 Password was confirmed incorrectly. Enter the password correctly in the “Password” and
“Confirm” boxes.

E3504 Invalid password. Enter the correct password.

E3505 Cannot exit DAQLOGGER Manager while Stop the scanning operation before quitting the
scanning/recording is in progress. DAQLOGGER Manager.

E3506 Cannot contain any of the following characters: \ / : , Use characters other than \ / : , ; * ? “ < > |.
; * ? “ < > |

E3507 File name is too long. Use a shorter file name.

E3508 Cannot exit DAQLOGGER Manager while Desktop Cancel desktop protection before quitting the DAQLOGGER
protection is active.  Manager.

E3509 Cannot exit DAQLOGGER Manager while Password Cancel password protection before quitting the
protection is active. DAQLOGGER Manager.

E3510 Cannot shut down Windows while DAQLOGGER is Quit the DAQLOGGER Manager before shutting down
being used. Windows.

E3511 Cannot delete project.  At least one supervisor project ———— (You cannot delete the only Supervisor project.)
must remain.

E3512 Cannot delete project.  At least one project without ———— (You cannot delete the only project that uses no
password must remain.  password function.)

E3513 In the same level a project with the same name already ———— (You cannot create a project of the same name
exists. and level.)

E3514 Cannot be terminated while the Event Processor is in Wait for the Event Processor operation to complete and
operation. then terminate the Manager.

E3515 Cannot be executed while the Event Processor is in Wait for the Event Processor operation to complete and
operation. then execute.

9.1  Error Messages and Their Corrective Actions
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Code Message What to do

M3561 Stop Recording? ————

M3562 Save all data before exiting DAQLOGGER software? ————

M3564 Delete project? ————

M3565 Disconnect the recorder? ————

Report Generator

Code Error message What to do

E3601 Please complete report configurations before starting If no output destination has been specified in the report
to report. configuration setting, specify the output destination. If no

computation type has been specified, specify the
computation type(s) of the data to be reported.

Code Error message What to do

E4000 Cannot send command while computations are in process. Check the connected recorder.

E4001 Failed to send command.  Settings don't fit currently Check the connected recorder.
connected model or memory sampling may be in process.

E4002 Cannot send command while reporting are in process. Check the connected recorder.

Event Processor
• Error

Code Error message What to do

E3701 Illegal event processor settings. Check the event settings. This error occurs when no events
are specified, for example.

E3702 Invalid character. Check the character string that you have entered. Commas
“,” cannot be used.

• Message

Code Message What to do

M3761 Delete current event? ————

M3762 Overwrite saved event? ————

M3763 Current event not complete. Check the settings. Check the event settings. Invalid setting such as a missing
required parameter exists.

M3764 Correct a process setting? Changing will cause some of the settings to become invalid.
Check the settings.  For example, when the type of target
file is changed, the input file for the convert process or the
specification of the body of the e-mail message may
become invalid.

M3765 Process setting not complete. Check the execute process settings. Invalid setting such as
a missing required parameter exists.

M3766 Process has successful. ————

M3767 Process failed. ————

M3768 The specified files are not determined now. ————
During test, the files are empty.

9.1  Error Messages and Their Corrective Actions
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File Utility
• Warning

Code Warning message What to do

W3831 Specify input file. Specify the input file.

W3832 Specify input directory. Specify the input directory.

W3833 Specify output file. Specify the output file.

W3834 Specify output directory. Specify the output directory.

W3835 File group not found. For merging or restructuring, specify an input directory that
contains files that can be merged.

W3836 Select file to merge with. For merging and restructuring, select two or more files to be
merged.

W3837 Illegal value. If the division type for dividing or restructuring is set to
“Division Point” and the length is set to “Time,” set the time
correctly. If the division type for dividing or restructuring is
set to “Single Fixed” and the length is set to “Time,” set the
time correctly.

W3838 Action aborted. ————

W3839 File not found. When dividing, specify data file for the input file. When
converting, specify data file or report file for the input file. If
report file is specified for the input file when converting,
specify at least one file format for the output data file. If data
file is specified for the input file, specify at least one file
format for the output data file

W3840 Empty file was not created. ————

Remote Controler
• Error

Code Warning message What to do

E3901 Login failure. Confirm whether the control server is running.  Check
whether the host name, port number, and password are
correct.

• Warning

Code Warning message What to do

W3932 Manager software is working. If any Manager software dialog boxes appear, close them.

Monitor Server
• Error

Code Warning message What to do

E4101 Port No. is already in use. Change the port number.

• Message

Code Warnign message What to do

M4131 Port No. is available after the server run next time. The new port number setting will take effect the next time
you start the instrument.
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